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Welcome to “Getting Started with macOS Tahoe,” a comprehensive guide to Apple’s latest operating system. Whether you are
an experienced Mac user upgrading to macOS Tahoe, or you have used a personal computer but are new to the Mac platform,
this guide will provide you with valuable insights. Covering everything from the fundamentals of your new Mac to managing
multiple users on your device, this resource is designed to help you maximize your experience with macOS.

Throughout this guide, you'll be presented with the features and applications that make up macOS, organized by topic and
accompanied by helpful tips with easy-to-follow practice exercises.

About the Practice Files

In the practice exercises, you'll find references to the practice files included with this course. You'll use these files to practice
adding an image to an email message, customizing your desktop picture, and more. If you're using this guide as part of a
class, the practice files may already be installed on your computer, or you can download the zip file from here.

https://hcsonline.com/images/Apps/Practice.zip

How to get the most out of this guide

Regardless of your familiarity with macQS, if you have used a personal computer, you likely possess sufficient knowledge to
begin using macOS. This guide is designed to assist you in acquiring the remaining skills needed. As you progress through this
guide and spend some time with macOS, you will find yourself proficient in its use and more productive than ever before.

Explore and practice with macOS Tahoe. Enjoy discovering on your own and have fun. That’s what using a Mac is all about.


https://hcsonline.com/images/Apps/Practice.zip
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Getting to know macOS

In macOS, you'll find familiar items; such as menus, icons, windows, and folders. You'll also find
many enhancements that make working with a Mac easier and even more enjoyable.

What You'll Learn

- What is the Finder?

+ What is in the Finder Window?
- The Finder Window's Toolbar

- Manage Your Files

- Stacks

- The Dock

- Quick Look

- Notifications and Widgets

- Tags

- Tabs

- Tile Windows on a Mac

- AirDrop

- Using the Trash

« More Tools in the Finder's Contextual Menu
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What is the Finder?

The Finder is the primary way of seeing, organizing, and managing your files, folders, connected devices and applications in macOS. The Finder is the app that
gives you the ability to navigate through all the files and folders on your Mac. With the Finder, you can browse, search, delete files, folders, and applications.
The Finder is made up of the Menu Bar, the Desktop, Widgets, and the Dock. We will explore the function and location of each of these.

Menu Bar
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The menu bar
1. From the top-left side of your screen, the menu bar is made up of menus beginning with the Apple menu (#), followed by menu items for the active app.
In Finder, your menu bar will show Finder, File, Edit, View, Go, Window and Help on the left side of your display.

2.0n the far right of the menu bar, you have menus for System Status, Spotlight, Control Center, Siri and Date & Time. Some of these menu items can be
turned off in System Settings > Control Center. Additional System Settings can also be given access to the menu bar through Control Center settings.

. System status menus

(S rnder et Ve o W

l— Menu items for the active app
]

Notification Center &
Widgets

The Apple Menu Spotlight
Control Center
Tips
Shortcut Commands

When you look at some of the menus, keyboard shortcuts are referenced. For example, in the File menu, 3N will open New Finder Window
(38 is the Command Key). You can reference the Appendix for a list of keyboard shortcuts.

Selecting Modifier Keys
When you click a menu, you can make different commands appear when you press and hold modifier keys, such as the Shift key (<*), the Control key (™), or the
Option key ().
Lost Mouse Pointer
On a busy desktop of Finder windows and open documents, your pointer can get lost in the shuffle. Shake your pointer a few times to
briefly enlarge your pointer so it stands out on your screen. You can turn off/on the “"Shake mouse pointer to locate” feature using System Settings >
Accessibility > Display.
Practice
Looking at the Menu Bar:
1. Click on the Finder menu, your current application menu. Notice that your settings and trash commands are found here.
2.Click on the Apple in the menu bar. Notice the content of the Apple menu and choose About This Mac. This provides you with information about the Mac.
3.Click on each of the items on the left-side of the menu bar (File, Edit, View, Go, Window, and Help.) Notice the commands available under each menu.
4. Click on each of the items on the right side of the menu bar and notice the labels and menus. What you see here may vary depending on how you set up

your Finder settings, System Settings, and applications on your Mac. Using the modifier key, Option (\C), click on Wi-Fi (=) on the menu bar to view the
details of the connection.

Chapter 1 Getting to Know macOS



Getting Started on macOS Tahoe

What is in the Finder Window?

The Finder window usually includes a sidebar, a toolbar, and buttons for resizing your window. There are different views for your window, too. You have icon view,
list view, column view, and gallery view. You will find it handy to use the sidebar in the Finder window as the starting point for browsing the Mac. The sidebar is
organized into categories to make it easy to locate items such as frequently accessed folders, devices connected to your Mac, and Tags for organizing your files
and folders with colors and keywords.
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Use the sidebar

You can use the sidebar at the left of a Finder window for frequently used files or folders. You simply drag a file or folder to the sidebar to give you
quick access. macOS places your Documents folder and other folders in the Finder sidebar to provide easy access to these frequently used folders.
You can customize your sidebar by going to Finder > Settings > Sidebar. Select or deselect what Finder items you want to include in your sidebar. We
will go into more detail in Section 2.

The Recents folder
The "Recents" folder, found in the Finder sidebar, displays your most recently accessed files in chronological order, beginning with Today, followed by
Previous 7 Days, Previous 30 Days, and so forth. In list view, users can review details such as file type, size, and last opened date.

Gallery View

In Gallery View, you see large thumbnails of your files. To the right of the thumbnail, the Preview pane displays information about the file, called
metadata. Different kinds of files have different metadata. For example, a photo might have “Exposure time’, and a movie might have "Audio channels”
Choose View > Show Preview Options to change the information that the Preview pane displays for the type of file you've selected. At the bottom of
the Preview pane are tools called Quick Actions. These tools vary depending on the type of file selected. For example, when you select a graphic, you
may Rotate Left (03") or use Markup (®). When applicable, you can click More (®), then choose a command from the menu, or choose Customize,
which opens the Extensions settings.

Practice
Looking at the sidebar:
1. The sidebar is similar to an alias. You can change the content of the sidebar through the Finder > Settings. Click on the Sidebar tab or by
dragging folders on or off the sidebar. You can remove a folder or file from the sidebar by using the control-click or right-click for a shortcut menu
(also called a contextual menu) and select remove from sidebar.

2. Notice the Sidebar is comprised of four sections: Favorites, iCloud (provided you are signed in with an Apple Account), Locations and Tags.

A. The first section, Favorites, has Airdrop, Recents, and some more frequently used folders such as Applications, Desktop, Documents, and
Downloads.

B. The second section, iCloud, allows you access files and folders from your iCloud account. You'll learn more about iCloud later in the guide.

C. The third section, Locations, displays several items by default, if they are connected, including hard disks, external disks, computers that offer
Screen Sharing and File Sharing services on your local network, and servers that your Mac is currently connected to. You can choose Finder
> Settings, then click Sidebar, then select Hard disks to display your startup disk. By default, the “Hard disks" item displays a dash instead
of a check mark; this indicates that the Finder sidebar displays all internal hard disks except for the startup disk by default. If iCloud Drive is
turned on, your Desktop and Documents will be located here.

D. The fourth section, Tags has 9 choices and an All Tags item. Use Tags to categorize your files. When you click a tag in the sidebar, the Finder
window displays all your files that have that tag.

3. Position the pointer over a section heading until Hide (™) appears. Click Hide () to Hide the section. Position the pointer over the hidden
section heading until Show (>) appears. Click Show () to Show the section.



The Finder Window's Toolbar
The Finder window toolbar can be customized. The standard toolbar comes with Back/Forward, View (Icon View [88], List View [:=], Column View [(IT)], and
), Share ((h), Tags (), Action (®), and Search (Q).
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Hide/Show the Toolbar

To hide the toolbar go to the menu, View > Hide Toolbar. If you want the toolbar back, choose View > Show Toolbar. Hiding the toolbar also hides the sidebar,
and moves the status bar from the bottom to the top of the window.

Use the Action button to perform a variety of tasks
With the Action button (©) in the Finder window toolbar, you can move an item to the Trash, compress a folder, get information about a file, rename a file, or
even create a new folder with just a click. Finder changes your options depending on the item you have selected.

Enhanced icon view

In Gallery View, you can thumb through a multi-page document or watch a QuickTime movie right in the Finder.

Iltem Arrangement button
In any view, you can organize the window by clicking the item arrangement button and choosing one of the ways to group items.

Share Button

The Finder in macOS includes a Share button ((1), so you can share files using Mail, Messages, AirDrop, Notes, and more.

Customize the Toolbar

You can customize the toolbar to make your life easier.

1.0n the Menu bar, click View and select Customize Toolbar.
2.Drag Quick Look (<®) to the Toolbar.

3.Click Done.

4. Select afile from the Practice Lessons macOS folder and click Quick Look.

5. Confirm a preview of the file appears.
6.0n the Menu bar, click View and select Customize Toolbar.
7.Drag the search bar all the way to the left.

8.Click Done.

9. Confirm Search bar is located to the left of the other tools in the Toolbar.
10.0n the Menu bar, click View and select Customize Toolbar.

11. Drag the default set into the toolbar to put it back to it's original appearance.

10 Chapter1 Getting to Know macOS
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Window Name View
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1. Click on each of the View buttons and notice how the view changes between Icon, List, Column and Gallery Views.
2. Click Action (©) and notice your menu choices. This is a short-cut for frequent actions you might need to use in Finder.

3. You will need to access your practice files. Go to Practice Lessons macOS folder. Click Action (&) then look at the commands available in the Action menu. Click
somewhere outside the Action menu to make the Action menu disappear without choosing any command. Click the Sample Document in your Practice Lessons

macOS > Chapter 1 folder. Look at the Action (@) content again. Notice some of the menu items have changed.
4. Click on the Arrange (5%2) and notice your menu choices. This is a short cut for Arrange for the View menu in the menu bar.

5. Click on Tags (). This is where you can assign Tags for organizing your files.

E¢ New Folder
@ Open
Open With

@ Move to Trash

@ Get Info

7/ Rename

[ Compress “Toolbar Action Menu.png”
Duplicate
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® Copy
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6. Enter "system set” in the Search field and see what happens. Double-click on System Settings when you see it listed in the Window.
7.Select afile and click on the Share (h) to see the different sharing services available.

Add/Remove a file or an app to the Toolbar
1.0pen a new Finder Window or press Command (&) - N.

2.Click Applications from the sidebar.

3.Locate Books.

4 Press and hold the Command Key (38).

5. Drag Books to the toolbar and drop it into the toolbar.

6. Confirm the Books App is in the toolbar.

7.0pen a new Finder Window and confirm the Books App appears in the toolbar.
8. Press and hold the Command Key (88).

9.Drag Books away from the toolbar and let go.

10. Confirm Books has been removed from the toolbar.

i
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Manage Your Files

The desktop is a good place to temporarily store files you plan to organize later. macOS creates a Home folder for each user with pre-organized folders for
different kinds of files including your Documents Folder. The Documents Folder is the preferred place for you to store your files for quick and easy access in
the future. If you find that you need to organize your files better, it's easy to create more folders within your Documents folder.
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Only you have access to the folders in your home folder

With the exception of the Public folder, only you have access to the contents of the default folders in your home folder. To prevent your files from being
accessed by other users of the computer, store your files in one of the default folders in your home folder. The Public and Sites folders have been designed
for sharing files with others.

What is the Desktop Folder used for?
The Desktop Folder contains items stored on your desktop. These items are not duplicated; your Desktop and the Desktop Folder are just two ways to access
the same items.

Sort files
The Arrange button (22) in the Finder toolbar lets you change the item arrangement, making it easier to find what you're looking for. Sort files by name, kind,

application, date last opened, date added, date modified, date created, size, or Tags with Arrange (£22).

Smart folder
Smart folders automatically gather files by type and subject matter. Smart folders are updated as you change, add, and remove files on your Mac.

Practice
Go to the Documents Folder by following these steps:
1.In the Finder, select Documents from the Sidebar.

2.Click File and choose New Folder (> -3 - N) or from the Action Menu, select New Folder.

3.Name the new folder “Projects.”

4. Drag Sample Document from your Practice Lessons macOS folder to the Projects folder you just created.
5. Click the Desktop icon (&) in the Sidebar to open the Desktop window.

6.Drag Sample image from your Practice Lessons macOS folder to the Desktop window. Notice how the file appears both on the desktop and in the
Desktop folder in the Finder window.

Chapter 1 Getting to Know macOS
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Stacks

You can use Stacks on the desktop to keep files neatly organized in groups. Whenever you save a file to the desktop, it's grouped by kind, date or Finder
Stacks, helping to keep your desktop clean. The Dock comes with a Downloads stack where you can easily access items you download from the internet,
receive as attachments, or files accepted through AirDrop.
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Turn on Stacks for the Desktop
Click on the Desktop, then choose View > Use Stacks or Control-click the Desktop, then choose Use Stacks.

Browse files in a Stack
Swipe left or right on the stack using two fingers on the trackpad or use one finger on a Magic Mouse to browse through the files in a stack. You can open the
top file in a stack by double-clicking it.

Change how Stacks are grouped
Click the Desktop, choose View > Group Stacks By, then choose an option, such as Date Added.

Change how Stacks look
Click the desktop, choose View > Show View Options. You can make icons bigger, change the spacing between icons, move icon labels to the side, or show
more information, such as how many files are in a stack.

Scroll through your Stacks on your Dock
Stacks are scrollable in grid view, so you can easily view all items in the stack.

Navigate folders in Stacks on your Dock
You can open folders in a stack to see all the files inside. Quickly return to previous folders by clicking Return Path (<) in the upper left of the stack.

Practice
View your different Stacks
1. Add some files, such as PDFs, web archives, text files and images, to your Desktop.

2. Notice how the files are grouped into stacks.
3.Click on a stack to expand it. Examine the files in the stack. Close the stack by clicking Collapse ( v ) of the stack.

Customize the view of your Stack in the Dock
1. Press and hold the Control key and click on the “Downloads” Stack in your Dock.

2.Select Grid.

3.Press and hold down the Control Key.

4. Select Kind.

5. Notice your Downloads stack is sorted in a Grid and by Kind.

6. Command-click on the Downloads folder in the dock and notice that Finder opens a window to show you the contents of the Downloads folder.

13



The Dock

The Dock is the row of icons that appear at the bottom of your screen when you first log into your Mac. These icons are shortcuts to your favorite apps. Just
click on one of the icons on your Dock and that icon will launch the app. Your Dock can be used to quickly access apps, documents, and folders. By default,
the Dock includes your recent apps, Downloads folder, and the Trash.
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Drag to Open

You can open a file by dragging it over the app in the Dock. For example, to open a document you created in Pages, drag it over the Pages icon in the Dock.
If you've got a file you want to open with a particular program you can actually just use the Dock. Simply drag the file from the Desktop or Finder Window to
the compatible app on the Dock and let go. For example, you have a JPEG file and want to open it with Safari rather than Preview, just drag the JPEG to the

Safari icon on the Dock and let go. It will launch the App and open the document.

You can use this trick to instantly create a new Mail message with the file as an attachment or to add music tracks to your Music library.

Hand Off

If you are working on your iOS or iPadOS device and want to continue working on your Mac, Handoff apps will appear in the recent app section of

the Dock. macOS will talk to your iOS device and let you continue working from your Mac. You'll also be able to trigger the Handoff by going to the
Command (38) + Tab switcher.

,

What each icon \n.‘ Opened App Notification
. A black dot underneath the icon, indicates the An icon with a red badge is used as a way to notify you
means on the Dock | app is opened. to open the app to view what new data came in. For
example, the red badge with the number 68, indicates

there are 68 new messages in Apple Mail.

Handoff = Minimized App
"' This icon indicates the same app on your =~ This icon appears to the right of the current apps. This
device is being used and is ready to hand off Indlicates an app window is minimized to the Dock. Click

< > to your Mac. — a on it to bring back the window

L

Practice
Practice using the Dock by following these steps:
1.In the Finder, click Go and choose Applications.

2.In the Applications folder, double-click the TextEdit icon to open TextEdit.

3. Click another icon in the Dock to open a second application. You'll have two apps and Finder open.

4. Notice how the opened apps have indicators below their icons in the Dock.

5. Switch between these open apps by clicking their icons in the Dock

6. Click and hold on the TextEdit icon in the Dock to view more options. Choose New Document and see what happens.

14 Chapter 1 Getting to Know macOS




Quick Look

Getting Started on macOS Tahoe

Quick Look allows you to quickly glance at the contents of a file without opening the file with an application. Quick Look works with nearly every file on your
system, including images, text files, PDF documents, movies, Keynote presentations, Mail attachments, Microsoft Word and Excel files. Flip through multi-page
documents or preview movies. You can use Quick Look in Finder, Mail, Time Machine and any third party applications that support Quick Look.
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The most common way of accessing Quick Look is to select the file and hit the space bar on your keyboard. You can also access Quick Look from a

contextual menu. You select a file and control-click it and choose Quick Look [File Name].

View and edit files in Quick Look

Quick Look offers a fast, full-size preview of nearly any kind of file without opening the file. Just press the Space bar and use the editing tools to rotate photos,
trim audio and video clips, and use Markup to crop photos and annotate images or PDFs. You can use Quick Look for items in Finder windows, on your

desktop, in emails and messages, and other places.

Practice
View multiple documents with Quick Look slide show

1. Select the images in the Sample Images folder in your Practice Lessons macOS folder by clicking on one image and then use the keyboard shortcut,

Command (38) + A, to select all the images in the folder.
2.Hold down the Option key and tap the Space Bar. Notice how the files are viewable in a slide show.

3.Go to Practice PDFs.

4. Click Icon view (88) and you can view the documents in thumbnails.

5.Select a PDF and hit the space bar.

6. Scroll through the pages you want to view from the thumbnails on the right.

5. Click Exit (@) to exit out of Quick Look.
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Notifications and Widgets

To access your Notifications and Widgets, click on the date and time on the top-right corner. Use Notification Center whenever you want to see all your
notifications in one place. Widgets can show you current information from your favorite apps, such as Calendar, at a glance. Click edit to add and customize
widgets so you can keep tabs on your schedule, favorite devices, the weather, top headlines, and more right from the desktop.

i New York Discuss about Blueprints
Widgets on bl (N ow Yor _ Invitation From Richard Goon
Desktop a | 3 2 ° 7 November 17, 2025 at 8:00AM
2346678 80 Orville Dr, Bohermia, New York, You can access

o 0@ e UIaED your Notifications

161718 19 20 21 22 ! ;
23 24 25 26 27 28 20 < e and Widgets by
30 Freeze warning macOS Tahoe Update clicking the Date
I wanted to share a quick update on the .
latest operating-system releases from Apple and time on the
and what they mean for your organization.... menu bar

Richard Goon
O Discuss about Blueprints
Meeting about Jamf Blueprints
Photos will appear here when they are
finishod processing

180 s O ECOQD@® "y AW B

Alert Notifications

Alerts, such as software updates, appear in the upper-right corner of the screen and remain there until you click Close. To go to the app, click Show.
Respond to phone calls or FaceTime calls

Click Accept or Decline.

Reply to Messages in Notification
To reply to a Notification Message or email while in another application, hover your cursor over the notification and a Reply button will appear for you to start
typing your response.

Practice
Add and Customize Widgets to Notification Center
1. Open Notification and Widgets in the Menu Bar (click on the Date and Time).

2. At the bottom of Notification Center, click Edit Widgets.

3.In the widget browser, enter world clock in the search field.

4. Confirm you have two results: World Clock - Small and World Clock - Medium.
5. Use your pointer to hover over World Clock - Small (four clocks in a square).
6.Click Add (@).

7.Confirm the widget has been added to the list on the right-hand side. To change the new widget's location in Notification Center, drag it up or down. If
you decide you don't want the new widget, click Remove (O).

8. Right-click on the World Clock Widget and select Edit "World Clock". Confirm the list of cities for their respective time zones.
9. Click on Cupertino. In the search field enter New York. Select New York.

10. Drag Paris to the top.

11. Click Done when you are finished customizing the widget.

12. Click on World Clock to open the Clock App. Notice how the first clock is Paris, France and then New York.
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Remove Widgets from Notification Center
1. Open Notification and Widgets in the menu bar (click on the Date and Time).

2.Control-click the widget you want to remove, then select Remove Widget from the shortcut menu. You can also move the pointer over the widget you
want to remove, press and hold the Option key, then click Remove (©).

Add Widgets to the Desktop
1.0On your Mac, Control-click the wallpaper, then select Edit Widgets.

2.In the widget browser, locate Clock.
3.Click on the Clock widget to add the widget to the Desktop.
4.Move the Clock widget on the Desktop.

Add iPhone Widgets
1. Open System Settings.

2.Click Desktop & Dock.
3.Go to Widgets.
4.Enable Use iPhone widgets.

Remove Widgets from the Desktop

1.0On your Mac, Control-click the wallpaper, then select Edit Widgets.
2.Click Remove () on the widget you want to remove.
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Tags

Tags is a way of filtering and finding files and folders. Tags can be added to documents, even those stored in iCloud. You can assign a tag to a file by
Control-clicking on a file and select the tag(s) you want to assign. The Finder sidebar has a list of your tags. Tags are named as colors, by default,
but can be renamed to something more relevant to you.
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You can assign Tags when you save a document. Along with the name for your document and the location to which to save it, Tags can be added before
clicking the Save button by clicking the Tags field and choosing the appropriate tag.

Tags in iCloud

Tags iniCloud is particularly useful for documents stored in different iCloud libraries. For instance, you might have a Numbers spreadsheet, a Pages document
and a Keynote presentation all for a particular project. By assigning a tag for that project, all of these documents can be assigned the project tag to group them
together in that project. This makes it easier to find all the resources for a given project and view them all in a single Finder window.

Filter by Tags

Any document can have more than one tag assigned to it. For example, if you have telephone bills for both home and work iPhones, you can assign all of them
with the tag “Bills" Then tag all of the home iPhone bills with “Personal” and the work iPhone bills with “Work". To find all of your work iPhone Bills, you can
search for the Tags “Bills" and "Work". This would then not list your personal iPhone bills.

Tip
Use keyboard shortcuts to tag files quickly
Select a file, then use Control-1 through Control-7 to add (or remove) a tag. Control-0 (zero) removes all Tags from a file.

Practice
Tag Your Documents
1.Go to your Practice Lessons macOS > Practice PDFs folder.

2.Select the four PDFs.

3.Go to the Action menu (@) in your Finder Window toolbar and select the Purple Tag.

3. Notice that all four of these files now have a purple dot to the right of them.

4.Go to your Sidebar Tags and click All Tags.

5.Notice that these four documents can be seen here as well.

6. Go back to your Practice Files > Practice PDFs folder and control-click on the third PDF with the purple dot.
7.Select Tags from the Contextual menu.

8. You will see a flashing cursor to the right of Purple. Tap your Delete key.

9. Click outside the Tags menu and notice that this file is no longer tagged Purple.
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Finder supports tabs (on by default), similar to major web browsers, allowing users to cut the Finder window clutter when navigating through numerous
directories. Tabs are a much more convenient way to manage Finder windows. Command (38) + T opens a new Finder tab, just like Safari, or you can select

New Tab in the File menu.

NOVEMBER New York
MTWTES 5,]0
2@a5 67 8
1 11213 14
<
Clear
H:58° L:48°

@ Recents
(=9 shared
Favorites

A Applications
[ Desktop

[ Documents
@© Downloads
Locations

& iCloud Drive
&} jappleseed
& Macintosh HD

@ Airbrop

Merge Multiple Finder Window into Multiple Tabs

< > Chapter1

Recents

&=0

Documents —Lo.

Northen Lights
. Phoenix.jpg

JPEG image - 192 KB.

Information
Created
Modified
Last opened
o

Rotate Left

Show More.

March 27, 2023 at 7:38PM
March 27, 2023 at 7:38PM
March 27, 2023 at 7:38PM
1366x2048

e

Markup More.

Click Add (+)

to add a new
Tab in the Finder
Window.

When you're on your Mac and have a bunch of windows open, simply navigate up to the Window menu and select Merge All Windows. All the open windows
will become tabs in one single Finder window, decreasing clutter instantly.

Separate a Tab to create a new Finder Window

Click the desired Tab and drag it out of the Finder Window to create it's own window.

Navigate tabs with your keyboard

Click a tab. You can also press Control-Tab or Control-Shift-Tab to go to the next or previous tab.

Close Tabs

- Close a tab: Move the pointer over a tab, then click the Close (&J).
- Close all tabs: Move the pointer over the tab you want to keep open, then Option-click Close ().

Practice
Open Tabs in the Finder Window
1.Launch a Finder window.

2. From the Menu bar, click on File and choose New Tab or use the keyboard shortcut, Command (&8)-T.
3.Repeat Step 2 to add another Tab to the window or click Add (+) to the right of the tab to add.
4. Click and drag the tab to reorder the tabs within the window
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Tile Windows on a Mac
Window Tiling helps arrange open windows in the Finder into a layout that suits you. There are many ways to access this feature such as Dragging a window
to the edge of the screen or just a click of the maximize Button.
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For PC Switchers
Window Tiling has been available since Windows 7. If you have worked with Window Tiling in Windows, this should be very familiar to you.

Practice
Tile a window by dragging the window to the edge of the screen
1. Drag a window to an edge of the screen (top, left, right or any corner of the screen.)
2. Release the window when the highlighted area appears. The window snaps into position when the pointer reaches the edge of the screen.
Tile a window with the Option Key
1. Press and hold the Option key.
2.Drag the window toward the area you want to place it in.
3. Release the window when it's in the highlighted area.
Tile a window from the menu
1. Make sure the window you want to tile is active.
2.Choose Window in the menu bar, then do one of the following:
- Tile the active window: Hold the pointer over Move & Resize, then choose a layout below Halves or Quarters.
- Tile multiple windows: Hold the pointer over Move & Resize, then choose a layout below Arrange. Press the Option key to see additional layouts below
Arrange.
- Center the active window on the desktop: Choose Center.
- Fill the desktop with the active window: Choose Fill.

B Minimize ®M
- Tile full screen: Hold the pointer over Full Screen Tile, then choose an option. 5 Zoom
Tile a window using the Maximize button b o
1.Hold the pointer over the green button in the upper-left corner of the active window. —
2.If you want to see additional layouts, press the Option key. @ Full Soreen Tile > Bt
& nove Window from Set (& (s
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X . . . . @ Move to John's iPad & Bottom
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- Tile multiple windows: Click a layout below Fill & Arrange. Stow Progress Window b
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. . . . N . . ow Next Tal AN & Bottom Left
- Center the active window: Press the Option key, then click the centered tile icon below Fill & Arrange.  § e o i B
- Fill the desktop with the active window: Click the fill desktop icon below Fill & Arrange. & AN —
8 Bring All to Front Left & Right faeX 1]
. O AirDrop [ Right & Left OO
Tip ) A B v O Practice Lessons maco$ oD & Botiom aoed
Where do | change the settings for Window Tiling? Z:::::m i
The settings for window tiling are located in System Settings > Desktop & Dock > Windows. T
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AirDrop

You can send and receive files over the air on your Mac as well as iOS and iPadOS devices using AirDrop. No Wi-Fi network is required, but your Wi-Fi and
Bluetooth have to be turned on. Mac users need to select AirDrop in their sidebar, and “Allow me to be discovered by" needs to be “Contacts” or “Everyone.”
Anyone within 30 feet that also has AirDrop selected will show up in your AirDrop window. To share a file, simply drag a file and drop it on the icon for the
computer or iOS device you want to share with. The person will need to accept the file and then the fully encrypted file transfers directly to that person’s
Downloads folder.
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Contacts Only
If AirDrop on the receiving device is set up to receive items from contacts only, make sure that both devices are signed in to iCloud. Also make sure that the
email address or phone number associated with your Apple Account is in the Contacts app of the receiving device.

The Contacts Only option is available on devices with iOS 10, iPadOS, macOS 10.12, or later. If your device has an earlier software version, select the Everyone
option to receive items by AirDrop.

New in macOS 26.2

macOS Tahoe version 26.2 introduces a new feature that allows temporary AirDrop access using a secure, shareable code. This enhancement lets users
send files to people who aren't in their contacts without enabling “Everyone” for AirDrop. In iOS 26.2, the system generates a one-time code that creates a
secure, temporary connection lasting up to 30 days between two devices.

This feature is especially useful when sharing files with someone you've just met, such as while traveling, without compromising your privacy or permanently
adding them to your contacts. It offers a quick, secure, and convenient way to share files while keeping your device's visibility controlled.

AirDrop Code Required

Practice
Transfer a file to another computer (To do this exercise, you will need to work with a partner on another computer.)
1.Open a second Finder window and go to your Practice Lessons macOS folder.

2.Locate Airdrop.jpg.
3. Drag Airdrop.jpg to the window with Airdrop selected and drop the file on to one of the computers that show in Airdrop.
4. Click Send.

5.1f you are the recipient of an Airdrop file, a pop up window will appear on your screen and you have the option to Accept and Open or Accept. If you share
a photo, you will have the option to Open in Photos. Click Accept and Save.

6.Go to your Downloads folder and check for the new file that was just sent to you.
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Using the Trash

Eventually, you may find that you have files and/or folders you no longer want. For example, if you downloaded an installer file for a new application and have
installed the application, you no longer need the installer file. To save space on you hard disk, you can delete the installer file by moving the file to the trash and
emptying the trash. Files are stored in the Trash until you empty the Trash. If you decide that you actually do need the file, before you empty the trash, simply
drag the file out of the Trash.
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Why | can’t empty the Trash?
A couple of reasons why the trash can't be emptied: the file may be locked or it may have still been open when you added the file to the Trash.

Use the keyboard to quickly delete a file
Hold down the Command (6) key while pressing the Delete key to send a selected file to the Trash. This can be faster than dragging files to the Trash.

Move to Trash
Instead of drag and drop an item to the trash you can Control-click on an item and select Move to Trash.

Empty Trash automatically.
You can turn on Empty Trash automatically to save space automatically by erasing items in the Trash for more than 30 days. Go to System Settings >
General > About > Storage Settings > Empty Trash Automatically. Click Turn On.

For PC switchers

The Trash on your Mac is the same as the Recycle Bin on your PC. However, deleting items from an external device such as a thumb drive works a little
differently on your Mac. When you delete an item from an external device, it is moved to the Trash, but does not create more space on the external device until
you empty the Trash with your external device connected to your Mac.

Practice
Practice using the Trash by following these steps:
1.Go to your Practice Lessons macOS folder.

2.Copy the "File for Trash” file to your Desktop.
3.Drag the file to the Trash icon in the Dock.
4. From the Finder menu, choose Empty Trash or use the contextual menu on the Trash icon in your dock to empty the trash..
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More Tools in the Finder's Contextual Menu
Control-click on a Mac is similar to right-click on a Windows computer. It's how you open shortcut or contextual menus on a Mac. In the Finder, from Quick

Actions there are some hidden tools such as Rename, Remove Background, or open a file with another app.

@ Open
Open With >

@ Move to Trash

® Open
Always Open With

@ Move to Trash
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et destion i ® Markup Quick Actions > D Rotate Right
et Desktop Picture ® Marku|
B Create PDF Set Desktop Picture °

@ Convert Image O Create PDF

@ Convert Image

& Remove Background Control-Option-Click will give you other options

B Remove Background

Customize...
Customize...

Batch Renaming
In the Finder, you can rename multiple items.
1. Select the items to be renamed. Control-click on the group.
2.Select Rename from the menu.
3.Inthe menu below Rename Finder Items, select your goal on how to rename the files:
- Replace text: Enter the text you want to remove in the Find field, then enter the text you want to add in the "Replace with" field.
- Add text: Enter the text you want to add in the field, then choose to add the text before or after the current name.
- Format: Choose a name format for the files, then choose to put the index, counter, or date before or after the name. Enter a name in the Custom Format
field, then enter the number you want to start with.
4. Click Rename.

Quick Actions
The Quick Actions menu has many tools to edit your graphics and documents. When selecting a document such as a PDF, you can markup the PDF. When
selecting a graphic such as a JPEG or PNG you can:

- Rotate: Rotate the graphic left, press the Option key to rotate right

- Create PDF: Export the graphic as a PDF

- Convert Image: Export the file to a PNG, JPEG or HEIF

+ Remove Background
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Review

Below is a list of terms from this chapter. See how many you know. The page numbers for each of these terms are listed for your

reference.
Finder Page 8
Finder Window Page 9
Toolbar Page
10-11
Dock Page 14
Notifications and Widgets Page
16-17
Stacks Page 13
Quick Look Page 15
Tags Page 18
AirDrop Page 21
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Customizing your macOS

Perhaps you like a desktop that changes or one that is a solid color. Maybe you prefer to
work without your dock always visible on your screen. You may like different apps in your
dock than other users. You have a choice of languages, colors, pictures, icons, printers,
Finder layout, toolbars, views and more. macOS gives you the ability to customize many
aspects of your Finder experience.

What You'll Learn

- Changing How Files and Folders Appear in Finder
- Customize the Finder to Meet Your Needs

- Customize the Desktop & Dock to Match Your Style
- Adding Items to the Menu Bar

- Customize Your Notifications

- Customize the Menu Bar

- Configuring System Settings for Your Mac

- Change Your Display

- Change Your Wallpaper

- Configuring Your Screen Saver

- Working with Multiple Languages

- Setting Up a Printer

- macOS System Settings - A Complete List




Changing How Files and Folders Appear in the Finder

In macOS, you can customize how Finder windows look and behave to match the way you work. Open the View menu and select Show View Options to
adjust settings based on whether you're using Icon, List, Column, or Gallery view. You can apply these settings to just one Finder window or set them as the
default for all windows. To make your folders stand out and easier to find, Control-click a folder, choose Customize Folder, then add a color, symbol, or even an
emoji. Finder also lets you preview digital files, merge folders, and quickly create new folders, all designed to help you stay organized with less effort.
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More info

Go to View > Show View Options, select the checkbox for Show item info. Notice how PNG or JPEG files have extra information such as resolution size.
Folders will show how many items the folder contains.

Keep both files

When you attempt to add a file to a folder that contains a file of the same name, the Finder now offers to keep both files, appending the word “copy” to the
name of the new file.

Bigger Type

Go to View > Show View Options, click the menu for Text size and select a bigger text size such as 14 points.

Practice

Preview your digital photos in the Finder
1. Select the images in the Sample Images folder in your Practice Lessons macOS folder.
2.Select icon view in your Toolbar.

° Chapter 2

Always open in icon view

3.Go to the Finder Menu bar > View > Show View Options. Group By:  None 3
4. Select the "Show icon preview" option and then set the Icon size to the maximum size. SortBy:  None °
i i i i Icon size: X Have the

5. Notice how easily you can now preview the images. I s 6ax64 ) L e
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1.Open or create a folder and add files to the folder. bottom
Text size: 12 <

2. Set the folder to icon view. Label posiion: |

3.Go to the Finder Menu bar > View > Show View Options. Ootom  Right B

4. Under Background, select the radio button for Picture. Show item info

Show icon preview

5.Drag animage to it and confirm the graphic appears as a background for the window.
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. @ Bun to Disc. the appearance Use as Defaults

6. Confirm the changes you see on the folder. ecceeee pf

<o
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Customizing the Finder to Meet Your Needs

Because the Finder is an application, you can configure its settings by choosing Settings in the Finder application menu. For example, you can set the Finder
to control which icons appear on the desktop or in the Sidebar of Finder windows. You can also use Finder Settings to control whether folders open in a new
window or in Tabs in the same window.
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Practice
Make changes to what is displayed on the Desktop and in the Sidebar by following these steps:
1. With a Finder window open, select Settings from the Finder menu.

2.In the Finder settings window that appears, click General, and then select the “Hard disks" checkbox. Notice how the hard disk appears on the Desktop.
3. Click the General icon in the toolbar, and then deselect the “"Hard disks" checkbox. Notice how the hard disk disappears from the desktop.

4. While still in Settings, click on the Sidebar to customize your Sidebar. Select Pictures. Open a new Finder window and the Pictures folder appears
on the Sidebar.

5.Go to your Practice Lessons macOS Folder and drag the folder to your Sidebar. Notice what happens. The folder can only be placed in the Favorites
section of the Sidebar.

6. To remove any item from the Sidebar, you can do the following:

- Drag the folder off until a ® appears in the lower-right of icon and release.
- Hold down the Command (8) key and drag the item to the Desktop.
- Control-click to get a shortcut menu and select Remove from Sidebar.

Make changes to the appearance and behavior of Finder
1. Make sure the Finder is the application you are in by checking the Menu bar to see if Finder is in the top left-hand corner. If Finder is not there, click on
the background, your Desktop or the little smiley-faced icon on the left side of the bottom of your screen on your Dock.

2. A Finder window will have opened if you clicked on the smiley face . You can also open a Finder window by going to the Finder Menu > File > New
Finder Window (3£-N).

3.Click Finder and select Settings.

4.Click through each of the Tabs in Finder settings to become familiar with your options for Finder.
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Customizing the Desktop & Dock to Match Your Style

You can find the perfect balance between quickly and easily finding applications and having the most efficient use of your desktop space by customizing the
Dock. The Dock automatically adjusts its size to accommodate new items as they're added. If you need more room on your desktop, you can hide the Dock
and the Menu Bar when you're not using them.
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Show/Hide items on Desktop and/or Stage manager
You may choose to hide or show items on your Desktop and/or when you have Stage Manager turned on. If this option is turned off, items on the desktop are
hidden. Click the desktop to show the items when you want to access them.
Widgets
You may choose to hide or show Widgets on your Desktop and/or when you have Stage Manager turned on. If this option is turned off, widgets on
the desktop are hidden. Click the desktop to show the Widgets when you want to access them. You may choose a style for your widgets also.
Select one of the following:
- Automatically - This will automatically switch between monochrome and full color.
- Always: This will always show widgets in monochrome.
- Never: This will always show widgets in full color.

Windows
You may enable or disable Window tiling when you drag to the left or right edge of the screen or go to full screen when you drag a window to the Menu Bar.
You may even enable margins on each tiled windows.

Customize the Dock from the Dock
If you right-click your mouse/trackpad on the separator bar in the Dock or hold down the Control key while clicking the separator bar in the Dock, you can
quickly customize the Dock or go to Dock Settings. .

Add/Remove Items on the Dock

If you want to add an application to the Dock, drag an app from the Application folder to the Dock. If you want to add a file or folder to the Dock, just drag its
icon from any Finder window (or the desktop) and drop it towards the right of the separator on the Dock. To remove an item in the dock, click and drag an
app upwards and away from the dock and let go. The app will still be found in your Applications Folder. Remember the Dock is just a collection of aliases or
pointers to your most frequently used Apps.

Practice
Customize the Dock by following these steps:
1. From the Apple menu, select System Settings, and then click Desktop and Dock.

2.Inthe window that appears in the Dock section, use the Size slider to make the Dock smaller or larger.

3.In Magnification, move the slider from off towards the right. Adjust the amount of magnification you want.

4.Move your pointer over the icons in the Dock. Notice how the icons below your pointer expand when the pointer is over them.
5.In the "Position on screen” section, select Right. Notice how the Dock appears on the right side of the screen.

6. Select Bottom to return the Dock to the bottom of the screen, and then use the slider to turn off Magnification.
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Customizing Notifications

You can customize the behavior of your notifications for your apps through System Settings > Notifications. Customizations can include turning notifications
on or off, whether to use Banners, Sounds or Alerts, having alerts on your lock screen, items to show in your Notification Center, using a Badge app icon,
playing a sound for notifications, and how to sort Notifications in the Notification Center.
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Alert Style
Choose a style for your notifications to appear:
- None: Notifications don't appear on the screen.
- Banners: Notifications appear on the screen and disappear after a while.
- Alerts: Notifications stay on the screen until you dismiss them.
Previews
Show a preview in notifications for the app or website. For example, if you receive an email, a preview of the email is shown in the Mail notification.
« Always: Previews are always shown (even in the login window).
« When unlocked: Previews are shown only when you're logged in to your user account.
+ Never: Never show previews.

Stop Notifications
Go to System Settings > Notifications. Select the app you no longer want to receive notifications for. Disable Allow Notifications.

Notifications after Sleep in the Lock Screen
When you wake your Mac from sleep, app notifications you received while it was sleeping are shown on the lock screen.

Practice
Remove and add Notifications for the Calendar App by following these steps:
1. From the Apple Menu, select System Settings.

2. Click on Notifications.

3.Select Calendar from the list of apps.

4. Notice the settings that you get by default in macOS.

5.Click on Calendar and then click on the None icon to turn off Calendar alerts.

6.In the list of checked settings below, click on the check next to “Play sound for notifications” to turn that setting off so you will not be disturbed by sounds
when there are calendar notifications.
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Customize the Menu Bar
The Mac menu bar is the horizontal strip at the top of the screen containing the Apple menu, app menus, status menus, and other icons that allow you to
choose commands, perform tasks, and check the status of your system.
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Hide the Menu Bar

Turn this feature on to provide more space on the display. You can choose to hide it “Always” or “On the Desktop Only” for a cleaner look and to maximize
space. Select “In Full Screen Only” when using an app in full screen. Move the pointer to the top of the screen to show the menu bar when it's hidden. Set it to
never hide for constant access.

Menu Bar Module Options

As you observe, some modules have additional options available. For example, you can choose how Fast User Switching appears in the Menu bar. You can
choose full name, account name or icon.

Allow in the Menu Bar

As you install apps on your Mac computer, some apps may provide menu bar items for extra functionailty. You may show or hide the app menu on the Menu
Bar, i.e. Dropbox or Adobe Creative Cloud.

Practice
Customize Menu Bar
1. From the Apple menu, select System Settings.

2.Click Menu Bar.

3. Scroll down to Menu Bar Controls. Click “Clock Options.”

4.Change some of the settings to see how the clock changes in appearance. Click “Done.”
5. Scroll down to Fast User Switching. Click the checkbox to enable it.

6. From the menu, select Full Name.

7.Notice how your name shows in the Menu bar.

@ -

John
Appleseed

Login Window...

Users & Groups Settings...
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Q [search Controls
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Add or Remove Controls
Click Add Controls to add customize Control Center or click Edit Controls, if you are in Control Center from the Menu Bar. You may do one of the following:
- Add anitem - Drag it from the window into Control Center.
- Remove an item - Drag it out of Control Center.
- Rearrange items - Drag items to reorder them within Control Center.
- Filter items - Click a category in the sidebar to narrow the list of available items.
+ Resize items - Control-click an item in Control Center, then choose a new size.

What Do the Color Dots Mean?
If you are on FaceTime on your Mac, you may notice a green dot next to the Control Center icon. This is called a Privacy Indicators.
- Orange Privacy Indicator (®) means the microphone is in use.
- Green Privacy Indicator (®) means the camera is in use.
+ Purple Privacy Indicator (@) means audio is being recorded.
- Location Privacy Indicator (4 ) means your location is in use.

Only one privacy indicator can be shown. If You have both the microphone and camera in use, only the green dot will appear.

Click to veiw which
Privacy privacy indicator is

being used
&« FaceTime FaceTime

= Camera

VYi-Fi / siri
Higher_- '
Ground / < Location

Practice
Add a Control
1. From the Apple menu, select System Settings.
2.Click Menu Bar.
3. Click Add Controls. Confirm Control Center modules appear.
4.Do one of the following:

Control-click on a
control module to
resize.

- Drag and drop Tile Windows Left & Right to Control Center Size

. CIiclg< on Tile Vr\)/indows Left & Right ang select Add to Control Center . %
5. Control-click on Tile Windows Left & Right and select small Large
6. Confirm the Control is set to small Copy to Menu Bar
7.Click Done. Confirm you are back to the Menu settings. e
8.Scroll down and click Reset Control Center.

9. Click Reset.
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Configuring System Settings for Your Mac

You met System Settings when you learned about customizing your Dock. The Finder and the Dock are not the only parts of your Mac you may want to
customize. You may want to allow Handoff between your Mac and your iOS devices, change your screen saver or desktop appearance, change how your
trackpad or mouse functions, change what the clock looks like, whether or not your windows have scroll bars, or even the alert sounds your Mac makes. All of
these settings are easy to find because they're all located in System Settings. With System Settings, you can customize almost every aspect of your Mac to
work just the way you want it to work.
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Tips

Search for a system setting

If you're not sure exactly what you're looking for, use the built-in search in the top-left corner of System Settings. As you enter text you are looking for, the
number of subjects in the results list will be filtered to match your search term.

PC Switchers
You may notice that System Settings works similarly to the Control Panel on your PC. Like the Control Panel on the PC, System Settings will allow you to
change settings on your computer.

Set up Internet Accounts
The Internet Accounts pane in System Settings gives you a central location to set up and manage all your accounts, including iCloud, Microsoft Exchange,
Google, Yahoo!, AOL and more.

Magic Mouse and Trackpad settings
macOS includes mouse andjor trackpad settings depending on the type of pointer and gesture device you are using. Gestures are now organized by
category, so you can quickly find what you're looking for, and new movies show you how each gesture works.

Scroll direction setting
When you scroll or swipe in macOS, content moves in the same direction as your finger. However, if you want to restore to an earlier operating system scroll
behavior, simply disable Natural scrolling under Point & Click in settings for your mouse or Scroll & Zoom in settings for your trackpad.

Disabling Handoff
If you want to turn off Handoff on your Mac, go to System Settings > General > AirDrop & Handoff. Disable Allow Handoff between this Mac and your iCloud
devices.

Practice
Take a look at System Settings by following these steps:
1. From the Apple menu, select System Settings.

2.In the window that appears, notice all the settings that are available.

3.0n the left column, scroll down and click Keyboard.

4. Notice the settings for Keyboard appear to the right. This is where you can customize how macOS manages your keyboard functions.

5. Click the Search field and start entering “battery” in the field. Notice how the results start appearing by the name of the Settings with descriptions.
6.Under Control Center, click Show battery status in Control Center.

7.Confirm that it takes you to Control Center > Other Modules > Battery.
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Change Your Display

Occasionally, you may find that you want to change your screen resolution. For example, if you do a presentation and need to use a video projector, you may
need to change your screen resolution to match the projector’s resolution. With Mac macOS, you can quickly and easily switch between screen resolutions to
suit any project you're working on.
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What is screen resolution?

Screen resolution is a measurement of how many pixels (dots) you can fit on a screen. The first number in the screen resolution represents the number of
pixels that fit across the screen. The second number represents how many pixels fit down the screen. With higher resolutions, you can fit more or larger
windows on the screen without their overlapping.

Arrange displays
Click Arrange and then drag displays to the desired position. To mirror displays, hold the Option key while dragging them on top of each other. To relocate the
menu bar, drag it to a different display. Arrange appears when you have another display connected.

Connect to another Mac display or iPad wirelessly
Just below the name of the Mac, click Add (+) and select a device to connect wirelessly. Scroll down and click Advanced and Set options for connecting to a

nearby Mac or iPad and conserving energy.

Disconnect from another Mac display or iPad wirelessly
To disconnect from an extended or mirrored display, go to Settings > Display, Click Arrange. Control-click the Display you want to remove. From the menu,
select Disconnect. Click Done.

Night Shift
Night Shift is designed to cut down on the amount of blue light you're exposed to during the evening by shifting the display of a Mac to a more yellow tone.

Practice
Change your screen resolution by following these steps: .
1.From the Apple menu, select System Settings. e
2.Click Displays. ® sonn'sipad
3. Your display is set to Default. Mirror Built-in Liquid Retina Display
4. Select the resolution towards the left. Notice how everything appears larger on screen. r;:':::x::z;"mw
5. Select the resolution towards the right. Notice how everything appears smaller on screen with more space. Hide Sidebar

6. Click Default to set the display back to the way it was. e

Richard Goon iMac
Living Room

Master Bedroom

Display Settings...

When a second display is connected, the
Display Menu appears on the Menu Bar.
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Change Your Wallpaper

Some people prefer to see a single color on their desktop, whereas others like to see a sandy beach. Whatever your preference, you can easily create almost
any look for your wallpaper. macOS comes with several pictures you can use for your desktop background. You can also use any picture in your Pictures folder
or you can create a folder with images or groups of images of your choice. You can set your wallpaper picture to change over time.
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Desktop picture type
- Dynamic: The wallpaper will gradually change the picture's appearance from light to dark throughout the course of the day based on your current
location.
- Automatic: The wallpaper is a Light & Dark Desktop picture and switches from light to dark at sunset, based on your current location.
- Light: The desktop displays a static, light version of the picture.
- Dark: The desktop displays a static, dark version of the picture.

Choose how to display your desktop picture

If you use one or more of your own pictures for your desktop picture, you have a choice of how to display the picture. The default option is “Fill screen.” The
"Fill screen” option crops the picture to fill the entire screen. A similar option is "Stretch to fill screen,” stretches the picture to fill the screen, but it can distort
the image. You also have a choice of Fit to Screen, Center, or Tile.

The desktop picture | want to use hasa “J."
Pictures with a download icon ('), have to be downloaded while connected to the internet. Click Download (¥) to download the picture.

Practice
Change your desktop picture by following these steps:
1. From the Apple menu, select System Settings.

2.Click Wallpaper.

3.Choose from one of the pictures provided by Apple or drag and drop an image onto a display.
4. Select an image. Notice that your desktop picture changes in the background.

5. Scroll to the bottom of the window and click Add Folder.

6. Navigate to the Practice Lessons macOS folder. Select Practice Images and click Choose.
7.Confirm the folder has been added. Select an image.

8.Click Auto-Rotate.

9. Scroll toward the top. Set the Change Picture for Every 5 Seconds.

10. Close all windows and watch your desktop change pictures every 5 seconds.
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Configuring Your Screen Saver

Customizing your Mac with an attractive desktop picture is fun. But what about when you're away from your computer? A screen saver is also a fun way to
personalize your Mac, and it can keep your Mac more secure when you're not working. macOS comes with several built-in screen savers you can customize
to suit your individual taste. You can even use your own digital pictures as a screen saver. If you can't decide which screen saver to use, you can set your Mac
to randomly select one for you.
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Hot Corners

If you don't want to wait for the screen saver to activate on its own, you can configure the screen saver to stop or start when you move the cursor to one or
more corners of the screen. In System Settings > Desktop & Dock, scroll down and click Hot Corners. Set one corner to turn on the screen saver and another
to disable it. Notice that there is a whole list of settings for your corners that can be enabled.

Personalized Screen Savers
You can personalize your screen saver with your own photos by scrolling down to Other and select Photos. Pick a Style from the Style menu. Click on Options
to pick your source of photos and whether you want to shuffle the slide order. You have the option to show on all Spaces as well.

Practice
Create a slideshow screen saver using your own images by following these steps:
1. Copy the images from the practice folder to a folder called Screensaver.

2.Move the screen saver folder to the Pictures folder in your Home folder.
3. From the Apple menu, select System Settings.

4.In the left-column, click Screen Saver. s

)
5. Scroll down to the Other section. T —
6. Select Photos. Colors
7.0n the top of the settings, click Options. Choose Folder...
8.Navigate to the Pictures folder and select Screensaver. i
9. Click OK.

10. You will see your preview of the Slideshow with the images you copied into the Pictures folder. Click on the preview to see it full screen.

Setup a Hot Corner for screen saver

1. From the Apple menu, select Desktop & Dock. ,
2.Scroll down, click Hot Corners. < Start Screen Saver

You can set up a Hot Corner for a screen saver so right before you leave your Mac, you go to a hot corner to activate the Screen Saver. You may set a hot
3.Hold the Option Key down on your keyboard.
4. Click on the top-left menu and select "\_ Start Screen Saver.

corner with a keyboard shortcut to avoid accidental activation when the pointer goes to a corner.
5. Click Done.

6. Hold the Option key down on your keyboard and move the pointer towards the top left. . . a

o

©
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Working with Multiple Languages

Do you speak more than one language? Did you know that macOS does, too? If you're comfortable working in German, French, Russian, or Japanese, you
can quickly and easily switch the language that your Mac uses. In General > Language & Region, you can quickly change your language as well as the tools
you use to input information into your Mac. These language settings are linked to an individual user account, so you can set different languages for each user
on your Mac.
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Add and remove languages from the list
If the language you want to use isn't in the list, click Add (+). In the sheet that appears, you can add additional languages or click Remove (-) to turn off
languages you know you won't need.

Different Language for Login Window
When your Mac has multiple users, everyone sees the language you chose as the primary language in the login window. Choose Apply to Login Window
from the Settings menu (&) below the languages list. If the setting doesn't appear, it means the login window is already set to use the primary language.

Translation Languages
Click Translation Languages to select languages to download to your computer so you can translate when offline. You can process translations on your Mac,
when connected to the internet.

Practice
Change the language your Mac uses
1. From the Apple menu, select System Settings.

2.Click General > Language & Region.
3.Click on Add (+).
4. Select Espafiol (Spanish) from the Menu.

5.When asked if you want to use Spanish as your primary language, Select Use Spanish. Close the window, and you will be asked to restart your computer.
Click Restart Now.

6. You will notice that the language has changed to Spanish when you log in.
7.0pen Calendar by clicking its icon in the Dock. Notice that the menu items now appear in the new language.
8. Quit Calendar by pressing Command (36)-Q.

9. Click System Settings in the dock and select General > Idioma y region, drag English back to the top of the list, close the window and select Reiniciar
ahora to restart your computer. By moving Engligh to the top, it will make It the primary language.

Change the language for an App
1. From the Apple menu, select System Settings.

2.Click General > Language & Region.

3. Scroll down to Applications.

4. Click Add (+), choose an app and a language from the pop-up menus
5. Select Safari.app.

6. Select a language. |.E. Espafiol—Spanish.

7.Click Add.

8. Open Safari and confirm Safari is displayed in Spanish.

Chapter 2 Customizing your macOS
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Setting Up a Printer

Your need to print files might be one of the reasons you are using a Mac. Before you can print from any application, you'll have to connect and configure a
printer. After you add the printer, it's available whenever you're ready to print. Setting up a printer in macOS is easy. macOS automatically recognizes and
configures almost any printer you attach to your computer.
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AirPrint

An Apple Technology that helps you create full-quality printed output without the need to download or install printer drivers. AirPrint is used in macOS by
default and makes adding the most popular printers easy. AirPrint works for Wi-Fi, Ethernet or USB connections for AirPrint-enabled printers. If a printer is
not AirPrint enabled, in most cases, macOS will automatically download the latest printer software. Please refer to this reference article for more details
about AirPrint.

https://support.apple.com/en-us/HT201311

Bonjour Printing

If you don't see your printer in the list of printers, your printer may be not be set up for Bonjour and may need to be connected by IP or as a Windows printer.
For PC switchers

If you used a USB printer with your PC, in most cases you can also use it with your Mac.

Printer Details

Click on a printer from the printer list to open information about the printer such as the model and driver version. If you have a multifunction printer, you have

an option to open the app for the scanner. Click Options and Supplies to see color levels and add-ons. You can enable printer sharing so users on the network
connect to the printer through your Mac. If the printer is no longer needed or available, you can remove the printer from the list.

Practice
Set up a printer on your network by following these steps:
1. From the Apple menu, select System Settings.

2.Click Printers & Scanners.
3.Click Add Printer, Scanner, or Fax.
4. The Add Printer window appears with a list of printers that can be connected by Bonjour.

5. Select your printer from the list. Notice that the printer comes up at the bottom of the window and by default says to use an
Apple service called AirPrint. If the printer is AirPrint-enabled, the printer will be set up this way without the need for additional drivers.
6.Click Add.
Printer Pool
If the printers you use are often busy and you want to print a document as quickly as possible, you can create a printer pool. Your document will automatically
print to the first available printer in the pool.
1.When you go add a printer, hold down the Option key (), click Create Printer Pool.

2.Enter a name for the printer Pool.
3.Select the printers in the list to be included in the printer pool.
4. When you go print, click the printer menu and select the printer pool.
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macOS System Settings - A Complete List

Apple Account
Configure iCloud media purchases and manage family sharing.

Wi-Fi
Connect and configure your Wi-Fi settings.

Bluetooth
Turn Bluetooth on and off, connect to and remove bluetooth devices.

Network
Manage your network access.

Energy Saver/Battery
Customize the energy management settings for your Mac.

VPN
Manage your VPN connections. This will be listed when configured in
Network settings.

General

Configure and manage anything about your Mac. This includes About
your Mac, Software Updates, Storage, AirDrop & Handoff, Login ltems,
Language & Region, Date & Time, Sharing, Time Machine, Transfer or
Reset and Startup Disk.

Accessibility
Customize your Mac in alternative ways if you have difficulties with vision,
hearing, or physical mobility.

Appearance
Customize the look of your Mac.

Menu Bar
Add/remove what appears in Control Center and Menu Bar.

Apple Intelligence & Siri
Turn Siri on or off, customize Siri's settings and how Spotlight works to
help you quickly find things on your computer.

Desktop & Dock
Customize your Desktop, Dock, Shortcuts and Hot Corners.

Displays
Customizes display settings and color. You can set up Night Shift for
better night's sleep.

Spotlight
Spotlight even shows suggestions from the internet, Music, App Store,
movie showtimes, locations nearby and more.

Wallpaper
Change backgrounds of your Desktop. Change and set your screen saver
to appear when you are away from your Mac.

Notifications
Customizes which apps will give you alerts, how your alerts will behave
and appear on your Mac.
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Sound
Customize alerts, output device selection and behavior, input device
selection and behavior.

Focus
Configure settings for when not to be disturbed.

Screen Time
Configure and manage your time on the Mac for you and your family.

Lock Screen
Configure your settings for your lock screen when you are away from
your Mac.

Privacy & Security

Customizes security controls of your Mac including Location Services,
FileVault, Extensions and Profiles. Privacy for apps access to other apps
and services on your Mac.

Touch ID & Password
Configure and set your password and Touch ID for your Mac.

Users & Groups
Create and manage User accounts and Groups.

Internet Accounts
Configure your email and other internet accounts.

Game Center
Enable/Disable Game Center.

iCloud
Manage your iCloud account including storage, photos, sycned
passwords, notes, mail and iCloud+ features.

Wallet and Apple Pay
Configure your Apple Pay with Touch ID to make payments on websites
that support Apple Pay.

Keyboard
Customize your keyboard behavior, spell correction, keyboard shortcuts,
and input sources. You can also set up Dictation from this setting.

Mouse
Customize mouse behavior including scroll direction. This will appear in
the list when a mouse is connected to your Mac.

Trackpad

Customize trackpad response including scrolling, zooming, turning on
silent clicking and gestures. This will appear in the list when a trackpad is
connected to your Mac.

Printers & Scanners
Set up your printers and access scanning.

Airpods

Customize Airpods behavior including Mute & Unmute, answer calls, turn
on/off Spatial audio. This will also show information about your Airpods.
This will appear in the list when Airpods are connected to your Mac.
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Review
Below is a list of terms from this chapter. See how many you know. The page number for each of these terms are listed for your reference.

System Settings Page 28
Control Center Page
30-31

Wallpaper Page 34
Screen Saver Page 35
Hot Corners Page 35
Notifications Page 29
AirPrint Page 37
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Sharing your Mac

macOS is ideal for coworkers, students, or family members who share a computer
because each user can set up an account without worrying that someone else will
change their settings.

What You'll Learn

- Understanding Users

- Guest User Account

- Accessing Your Account Information

- Create a New User

- Manage your Family’s Time with Screen Time
- Switching Between Users

- Configure Your Mac for Special Needs Users
- Using Voice Control

- Understanding File Permissions

Chapter




Understanding Users

In businesses, schools, and households, one computer is sometimes shared by multiple users. Each user may require different settings based on their needs
including work style, privileges allowed based on abilities and responsibilities. Each user may want to keep their files separate. With macOS, all of that is
possible. Every user has their own private Home folder that they are able to customize to meet their needs.

& SystemSettings Edit View Window Help = ® Q 8  Thulans 4:56PM

New York
46°

< eve < > Users&Groups

Search
Battery

Clear
Hi51° Li3e [Dsers

o John Appleseed
(&) General o
Accessiiity @ oS
@ e Jelly Roll Morton
72 Apple Inteligence & Siri Sharing Only
(B Desktop & Dock @ cuestuser — List of Users
€3 oisplays ! created on
3 Menu gar y the Mac. Top
Spotiight -’ user is the one

Wallpaper Croues;

that is logged
£ Dlece o in/currently
D) sound i inuse

@ Focus

Add Group...

Serean Time Auomaticalylog nas ot &

B ook screen Network account server Edit.
(0 prvacy & Socurity

) Touch ID & Password

Types of Users

Administrator: An administrator can add and manage other users, install apps, and change settings. The first user you create when you first set up your
Mac is an administrator. Your Mac can have multiple administrators. You can create new users as Administrators and you can convert standard users to
administrators. Don't set up automatic login for an administrator. If you do, someone could simply restart your Mac and gain access with administrator
privileges. To keep your Mac secure, don't share administrator names and passwords.

Standard: Standard users are set up by an administrator. Standard users can install apps into their own home folder and change their own settings, but can't
add other users or change other users' settings.

Sharing Only: Sharing-only users can access shared files remotely, but can't log in to or change settings on the computer. To give the user permission to
access your shared files or screen, you may need to change settings in the General > Sharing, Screen Sharing, or Remote Management of Sharing settings.

Remember these points about users:
« There are four types of users: Standard, Guest, Sharing Only and Administrator. If your account is the only account on the computer, you're an
administrator.
- The difference between a standard user and an administrator is that administrators can install new applications, add users, and remove users. They also
have access to all System Settings.

« A group allows multiple users to have the same access privileges such as a folder.

Tips

Permission to change

When you make changes in System Settings, a window may pop up asking for administrator credentials. An administrator can unlock these settings by
entering the administrator's password. A Standard user's credentials will not be able to go forward with the changes.

What is the root user?

In macOS, there is a lesser-known type of user known as a system administrator (or root). This user has access to all files, including files in the System
folder and in every user's home folder. To set up the system administrator, you use the Directory Utility application. Setting up a system administrator is not
recommended for most macOS users.
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Guest User Account

macOS Guest User account is a separate user account that you can let trusted people, such as friends or family, use instead of giving them access to your
user account. Every time someone logs in with a guest account they get a clean Desktop and see everything as if the user was just created. When they log
out, any files they created or settings they changed are erased, keeping the account clean and fresh for the next guest user that logs in.
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Remember these points about Guest Users:
- All data will be erased once Guest Account is logged out.
- Guests users can save documents into the Shared folder.
- Guest users can't log in remotely when remote login is turned off in Sharing settings.
- Guest users can't change user or computer settings.

Tips

Allow guest users to connect to shared folders.

If you want guests to be allowed to save or share any documents they create while logged in, check this option on the Guest User in System Settings >
Users & Groups.

The login window has blank fields in the name and password instead of list of users
If your login window shows the list of users, just select the Guest user. If the window shows the name and password fields, enter guest in the Name field and
click Login. The Guest account doesn't include a password, so don't worry about entering one.

Only Safari?
When you log in as a guest on a Mac that has FileVault turned on, you can only use Safari. You won't be able to use any other apps on the Mac.

Practice

Turn On Guest User
1. From the Apple menu, select System Settings.
2.Click Users & Groups.

3.Click Info (®) for Guest User. 4-»

> .
= Corby Slice

Guest User

4.Enable "Allow guests to log in to this computer”.
5. Click OK. Go to the Apple Menu and select Log Out <Your Name>. X8 John Appleseed
6. Click on the list of users to expand the list.

7.Confirm you see the Guest User in the list. Click on Guest User.

8. There are two scenarios that can happen:
a.If Filevault is turned on, it asks you to restart the Mac computer and Safari will automatically open. You will not have access to the anything else.
b.If Filevault if turned off, you will see a Desktop and Dock with just Safari in the Dock.
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Accessing your Account Information

As part of your macOS user account, you have a user name, password, Contact Card and login picture. At some point, you might want to change one or more
of these settings. For example, you might want to replace the generic login picture with a picture of yourself. You can change your password, login picture, and
even access and edit your Contact Card.
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Tips
Give yourself a hint to remember your password
If you type your password incorrectly three times in the login window, your hint appears, giving you a reminder that will help you to log in.

Use your camera to make your login picture
If you have a built-in camera or other compatible digital video camera, you can use it to take a video snapshot to use as your login picture. Click the picture on
your account, and then click Camera. Position yourself in the center of the camera. Click on the camera icon to snap a picture. Click Save to use the picture.

Reset your login password with your Apple Account

If you associated your user account with your Apple Account, you can use your Apple Account to reset your login password. Restart your Mac and at the login
window, click your user account. Click the question mark (®) next to the password field. Click the arrow (@) next to “reset it using your Apple Account.” Enter
your Apple Account and password and follow the prompts.

Practice
Find and edit your personal information by following these steps:
1. From the Apple menu, select System Settings.

2.Click Users & Groups.

3. Notice that your account is listed on top indicating it as the Current User logged in.

4. Click info (®) on your account.

5.To add or change information, such as your address, phone number, or email address, click Open Contacts Card.

6.To change your password, click on Change Password. Enter your current password then enter your new password in the Password and Verify fields. To give
yourself a hint in case you forget your password, type the hint in the Password Hint field. Click on Change Password when done.

7.To change the picture associated with your account, click the picture. Select a different picture or create one. Click Save.
8.To add a personalized picture instead of a macOS picture, click on Photos.

9.In the images window that appears, locate the picture you want and click on the picture. Click Save.

10. Log out of your user. Confirm the new picture for your account.
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Create a New User

If you are going to share your Mac with others on a regular basis and not just temporarily, like with a Guest User, you'll need to create other user accounts. In
the Users & Groups settings, you can access and change your own information. As an Administrator, you can also create new user accounts. You control who
has access to your Mac and keep your files separate and private from others by setting up additional users.
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Tip

If you can't create a new user

When you are in the Users & Groups settings, you have access to only your own account information. You're unable to create or edit other user accounts
unless you have the credentials of an administrator on your Mac.

Create additional administrator users
Administrators can install applications and change System Settings, as well as create and delete other users. If you want a new user to be able to administer
the computer, select the "Administrator” option from the menu.

Create a Group
Groups allow multiple users to have the same access privileges. You control a group's access to your shared folders by setting access permissions in the File
Sharing options in Sharing settings. After you create a group, click the group and click the radio button to enable the account for the group.

Delete an account
Click on an account you want to delete. On the bottom-left, click Delete Account. You have a choice to save the home folder as a disk image, leave the home
folder intact or delete it.

Practice
Add a new user
1. From the Apple menu, select System Settings.

2.Scroll down and select Users & Groups.
3.Click Add User.

4. Enter your admin credentials if necessary.
5. Enter Warren Peace for the Full Name.

6. Click in the password field. Notice how macOS fills in the account name for you. You may change the account name if you want to. Enter Apple321! for
the password.

7.Click the Verify field and enter the same password. Click Create User.
8. Confirm you have a standard user called Warren Peace.

9. Click Add Group.

10.Enter Shared for name. Click Create Group.

11.Click info (®) on the Group.

12.Enable Warren Peace and your user to be added to the Group.
13.Click OK.
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Manage your Family's Time with Screen Time

Screen Time informs you on how you spend time in apps and on websites. It provides tools you can use to control the amount of time spent on any activity for
you and your users/children. For each user/child, you can set up individual, age-appropriate limits and restrictions. You have the option to use a passcode so
standard users can't change the settings.
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Tips

Limit certain apps and websites

If you find yourself going on Social Media too many times during the course of the day, you can set a limit in App Limits for Social Networking. You can do this
for Games as well.

Practice
Use Screen Time to limit how many hours per day to use Apple Mail.
1. Open System Settings and click Screen Time.

2.Click App Limits and enable it.

3.In the search field, enter mail.

4. Select the checkbox for Mail.

5. Select Everyday and set it for 4 hours.
6. Click Done.

View App Usage for other devices
1. Open System Settings and click Screen Time.

2.Click App & Website Activity.
3. Select a device from the All Devices menu on the top-right, i.e. John's iPad.
4. Click on Time to sort which app that device spends the most time on.
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Focus.

7.Click on Set Limit (%). This will open a window to set a time limit for social media.
8. Set the time for 3h Om.
9. Click Done.

Select another device's usage from the Device menu in the top-right.

View Notifications to see which apps set off your Notifications
1. Open System Settings and click Screen Time.

2.Click Notifications.
3. See which app show the most Notifications for All Devices.
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Setup Content and Privacy Restrictions on a Family Member
1. Go to Family Sharing: Log in to your account, then make sure you're signed in with your Apple Account.

2.0pen System Settings and click Screen Time.

3.1f you're a member of a Family Sharing group, click the family member menu, then select a family member.

4.Enable Screen Time. Click Content & Privacy.

5.Enable Content & Privacy. To restrict web content, click Content Restrictions.

6.From the menu, Access to Web Content, select Allowed Websites Only. Click Customize.

7.Confirm there are some allowed websites such as Apple and Disney. Click Add (+) to add some allowed websites. Click Done.
8.To restrict movies, TV shows, and app purchases, click Store Restrictions, then select options.

9.To restrict apps, click App Restrictions, then select options.

10. To lock certain settings, click Preference Restrictions, then select options.

Manage Screen time for a Family member from another Mac
1. Go to Family Sharing: Log in to your account, then make sure you're signed in with your Apple Account.

2.0pen System Settings and click Screen Time.
3.1f you're a member of a Family Sharing group, click the family member menu, then select a family member.
4.Enable Screen Time (if it's not already enabled). Click App Limits.
5. Enable App Limits. Click Add Limit. You can include any combination of apps, categories, or websites in each limit you create.
6.In the "Create a new app limit" window, select the checkbox next to each of the apps, categories, or websites that you want to include in the limit.
- Search for an app, category, or website: Type a name in the search field. The list updates as you type.
- See the apps in a category: Click the disclosure triangle next to the category.
- Limit all apps in a category: Select the checkbox next to the category in the list.
- Limit all apps and categories: Select the checkbox next to the category All Apps & Categories in the list.
- Limit an individual app: Select the checkbox next to the app in the list.

- Limit a website: Click the disclosure triangle next to the category Websites. If the website has been visited, it'll appear in the list below the Website
category, and you can select the checkbox next to it. If the website isn't in the list, click the Add Website (below the website list), then type the URL
for the website.

7.0n the bottom, set time limit, i.e. 2h 30m.
8.Click Done.
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Switching Between Users

When working with your Mac, have you found that others frequently want to use it “just for a moment"? With macOS, you can let other users log in to their
accounts without having to close what you're working on. In macQOS, switching between users without logging out is known as “fast user switching" Fast user
switching is easy to set up and even easier to use.

Quickly switch
between users
without logging
out
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Tips

If you can't shut down or restart your Mac

If you use fast user switching, you might find that you can't shut down or restart your Mac because another user is logged in and has one or more
applications open. To shut down or restart your Mac, you'll need an administrator password.

For Mac computers with Touch ID
You can use your Touch ID when switching to another user. This needs to be enabled In the Touch ID & Password settings pane. All you need to do is click the
fast user switching menu in the menu bar, then select your name. Place your finger on Touch ID and you will be logged in.

Practice
Add Fast User Switching to the Menu bar
1.Go to System Settings.

2. Click Menu Bar.
3. Scroll down to Fast User Switching. Select the checkbox to add Fast User Switching to the menu bar.

4. Click on the Menu and select how to display the appearance of the menu:
« Full name - shows the user’s full name.
- Account Name - shows the user short name.
+ lcon - Shows the picture you have chosen when creating the user.

Use fast user switching and switch between users by following these steps:
1. Click your name in the menu bar, and then select Login Window.

2. Notice the icon to the left of your name in the login window. This means that you are logged in.
3. Select another user, i.e. Warren Peace and log in.
4.Click on Fast User Switching on the Menu bar.

5. Notice the check marks to the left of the users. This indicates the users that are logged in.
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Configure Your Mac for Special Needs Users

Your Mac comes with features designed for users with special needs. Users with vision difficulties can enlarge the images onscreen, and those with hearing
difficulties can set the screen to flash instead of playing an alert sound. These and other features for keyboard control and mouse movement are available
in Accessibility in System Settings. You'll hear the names of buttons, menu items, and more. macOS will even read you a block of selected text or an email
message.
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Tips

Adjust how much macOS zooms in and out

To adjust how much or how little macOS zooms, go to Accessibility > Zoom > Advanced. Under Controls, Use the sliders to adjust the maximum and
minimum zoom levels.

Set macOS to speak selected text
To set macOS to speak selected text when you press the specified keyboard shortcut, go to Accessibility > Read & Speak and enable Speak selection. Click
Info(®) to customize the settings such as Keyboard shortcut.

Change the voice macOS uses
If you don't like the voice macOS uses, you can change the voice by choosing from a variety of voices in Read & Speak. Click the System voice menu, and
then select a voice you like.

VoiceOver and Braille Support
VoiceOver is the first screen reader to provide plug-and-play support for refreshable braille displays. Plug in or sync one of over 100 compatible displays, and
the VoiceOver description is presented to you in braille. For more information on braille displays, please refer to https://support.apple.com/en-us/HT202524.

Accessibility available from anywhere
You can access Accessibility from anywhere on your Mac with the Command-Option-F5 keyboard shortcut or by adding Accessibility to your menu bar.

Practice
Turn on some features for special needs users by following these steps:
1. From the Apple menu, select System Settings.

2.Click Accessibility.

3.Click Zoom.

4. Enable Use keyboard shortcuts to zoom.

5. Press the Option (), Command () and Equal (=) keys. Notice how macOS zooms in on the area around your cursor.

6.Move your cursor around to see how your screen tracks. Press the Option (C ), Command (&£) and Minus (—) keys to zoom out.
7.Click Previous (<) then click Keyboard. Enable Sticky Keys.

8. Press the Command key. Notice how the symbol appears onscreen (top right-hand side).

9. Press the H key. Notice how System Settings disappears from the screen.

10.Press Command (d£) - Tab to select System Settings.

11. Disable Sticky Keys.
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Using Voice Control

Using Voice Control on your Mac, you can dictate text and speak commands to edit text, navigate the desktop and apps, and control your Mac, performing
tasks such as scrolling in a document or pressing a button. Voice Control provides a standard set of commands: Basic Navigation, Overlays & Mouse,
Dictation, Text Selection, Text Navigation, Text Editing, and Text Deletion. You can also create your own commands.

NOTE: When Voice Control is on, you can't use Dictation.
Voice Control

Menu. In this
example, Voice

Votes Control Control is on.
NOVEMBER New York Select Stop
© Stop Listening . .
45 Voice Control Start Listening Listening to
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5 Mode
& Q search Voice Control [ @) Control
Mostly Cloudy Vaice Controlallows you to use your voice to edit text and interact © pictation Mode

‘with your computer even when you are on calls.

@ John Appleseed 4 Command Mode

Apple Account Languege English (United States)

= Family

@ wi-Fi
Show hits ollEas
€ Bluetooth o G
piterepiiii i Play sound when command is recognized
' o s
(2 Battery Overlay @) Automatic (MacBook Air Microphone)

) MacBook Air Microphone

A Spelling Mode

Microphone Automatic (MacBook Air Microphone) &) switt Mode

General Fade overlay after inactivity

® Accessibility Voice Control Settings...
- Voice Control Tutorial Open Tutorial...

Learn and practice Voice Control commands in this
interactive tutorial.

Appearance
(=) Menu Bar

3 o Improve assistive voice features
Deoneoeceasn TSI

= and transeripts o your Vocal Shortcuts and Voice Control interactions.
Desktop & Dock This information is sent only with your consent and is submitted
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€3 Displays

spotiight Commands..  Vocabulary...
Wallpaper

3 Notifications

D) sound

1809 ERO T CREBB® " ¥ AR M

Multiple languages
If you downloaded additional languages to use with Voice Control, you can quickly switch languages from the Language menu. Click Add Language and

select the language to download.

Pausing Voice Control
If you take a break and don't want words you say to be interpreted as commands, say “Go to sleep” or click Sleep in the feedback window. When you want

Voice Control to listen for commands again, say “Wake up” or click Wake up in the feedback window.

Practice
Enable Voice Control
1.Go to System Settings, click Accessibility.
2.In the Accessibility, click Voice Control.
3.Enable Voice Control.
4. You can add another language to voice control by clicking the Language menu and select Add Language.

Voice Control Commands
Voice Control is always listening, just say a command.
1.Say "Open Safari.”
2.Say "Quit Safari."
3.Say "Show Commands.”
You should now see the Command window and the commands listed depending on the app you are in.

Tip
Overlay Commands
When You enable Overly, you have a choice to label the onscreen items. You may choose item
names, numbers or numbered grid. For example, if you have number overlay enabled, You may
call out the number "46" to disable Voice Control instead of saying "Disable Voice Control.” P D ppecem
Names and Number overlays: [ J @ voeecom - )
Use number and name overlays to quickly interact with parts of the screen that Voice Control Lo} it e _
recognizes as clickable, such as menus, checkboxes, and buttons. [—— L X B;’:’ Zi"(:“":s::
Grid Overlay: g; — show s oo
Use grid overlays to interact with parts of the screen that don't have a control, or that Voice 3 e Feseinanen s recoszee g
Control doesn't recognize as clickable. @a .~ g @D ron tumbers B
o >
Voice Control Tutorial €@ Oen Tutorial,

Learn and practce Voice Control commands i this
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Understanding File Permissions

Have you ever wondered how it's possible for all users of your computer to access your Public folder even though they can't access other folders in your
home folder? File permissions let your Mac know which files are yours and which ones belong to others. File permissions act as access controls. They control
who can see and make changes to a file or folder; who can simply see a file or items in a folder; and who has no access at all.

® © @ i chapter3info sysdiagnose_Logging.
Chapter 3 38.3MB |
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Modified: October 4, 2023 at 1:14PM

/Add Tags. Add Tags.

General:

3
,304,495 bytes (38.3 MB on
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Locked
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-
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Permissions:
Read & Write Allows a user to open the item and change it.
Read Only Allows a user to open the item, but not change its contents.
Write Only Users can copy items to the folder, but can't open it. Only the owner of the folder can open it.
No Access Blocks all access to the item.
Practice

Assign permissions to users and groups
1. Select a folder or file, then click File > Get Info.

2.1f the information in Sharing & Permissions isn't visible, click the disclosure triangle (>).

3. Select a user or group from the Name column, then choose one of the following from the pop-up menu in the Privileges column. If necessary, click the
lock icon and enter an administrator's name and password.

Apply permissions to all items in a folder or a disk
1. Select a folder or a disk, then click File > Get Info.

2. Click the lock icon to unlock it, then enter an administrator's name and password.
3.Choose "Apply to enclosed items” from the Action pop-up menu.

Change an item's owner
1. Select the item, then click File > Get Info.

2.Click the lock icon to unlock it, then provide an administrator's name and password.
3.1f the new owner's name isn't listed in the Name column in the Sharing & Permissions section, click Add (+) to add the new owner.
4. Select the new owner in the Name column, then choose “Make __ the owner” from the Action pop-up menu (looks like a gear).

Add or remove a user or group in the Name column
1. Select an item, then click File > Get Info.

2.1f you don't own the item, click the lock icon to unlock it, then provide an administrator's name and password.
3.Inthe Sharing & Permissions section, do one of the following:

4.To add a user or group, click Add (+) below the table, select a user or group, then click Select.

5. To remove a user or group, select the user or group, then click Remove (-) below the table.

Undo changes
You can undo any changes made in the Sharing & Permissions section of an Info window since opening it, except applying permissions to all the items in a
folder or disk.

1. Make sure the Info window remains open after making your changes.

2.Choose "Revert changes” from the Action pop-up menu.

3. Set permissions of shared folders
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Review

Below is a list of terms from this chapter. See how many you know. The page number for each of these terms are listed for your reference.

Administrator Account Page 42
Guest User Account Page 43
Screen Time Page 46
Fast User Switching Page 48
File Permissions Page 51
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Working with Apps

Today, there are over a million apps available for macOS. In addition to apps written for
macOS, your Silicon Mac can also run apps written for iPadOS and iOS.

What You'll Learn

- Using Apps

- Apps

- Working with App Settings

- Saving Files

- Open a File with Another App
- Forcing an App to Quit

- App Store
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Using Apps
macOS comes with a variety of apps to get you started. Your Mac includes apps to increase your productivity and entertain you. These apps are found in the

Applications folder. There are other useful apps that don't automatically appear in your Dock when you use macOS but can be added if you will use them
frequently and want quick access. A full list of apps available in macOS can be found in the appendix of this guide.
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Tips
For PC switchers

In macOS, you can use many of the same apps you've used on your PC, such as Microsoft Office, Adobe Reader and Dropbox. If you have a PC app that does

not have a Mac version, you can purchase a license for Windows 11 or later from Microsoft and you can use third party products such as Parallels, VMWare
Fusion, or Virtual Box.

Practice:

Take a look at the apps installed on your Mac by following these steps:
1. From the Go menu, select Applications.

2. Scroll through the Applications window to see what apps are installed on your Mac.

3. Double-click the TextEdit icon to open the TextEdit app.

4.0Open a few other apps, such as Notes, Chess, or Calculator.

5.To quit an app, click the app’s title in the menu bar, and then select Quit or use the shortcut & - Q.
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Apps
Apps is a new feature in macOS tahoe that help keep your apps organized in catergores. It will even allow you to view and launch iPhone Apps. If You cannot
find an app in a catergory, you may just search for it. You may even drag and drop an app from the app list to your dock for easy access.
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Tips

App Categories

When You first launch apps, you see all your apps in one place. Under the search field and above the apps is a list of categories for the apps. Click on one of
the categories to see what apps are listed. For example, click Creativity and you will see a list that consists of Photo, Freeform, Font Book and Image Capture.

Search
With the amount of apps we install on our devices these days, it may be hard to visually find an app. Above the Catergories strip is a search field. Click on the
search field and enter the name of the app and see the results underneath.

List view
Click on Options () and change the view from Grid to List. if You have signed in with the same Apple Account as your iPhone, you may even view iPhone
apps in the list.

Practice
Explore Apps
1. Click Apps on the Dock.

2.in the categories strip, click Creativity. Confirm you see Photos, Freeform, Digital Color Meter, Font Book and Image Capture.

3.Press the Delete key to show all the apps.

4. Click Options () and change the view from Grid to List.

5. Click on the search field and enter Pho. Confirm you see all apps that contain Pho, i.e. Photos, iPhone Mirroring, Phone, etc...

6. Select Photos if it's already selected. Press the Tab key. This will list any file the app have created. Confirm Photos Library. photoslibrary appears.
7.Click on the serach field and enter word. Confirm there is no listing for word. Double-click Search App Store.

8. The App store opens and the results for word appears.
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Working with App Settings

Just as you can customize macOS to suit your needs, you can also customize most macOS apps to make them easier to work with. App settings are different
for every app, but you can always count on a similar look and navigation structure when customizing the app settings. If you don't know what a setting does,
try it. You can always undo the change if you don't like it.
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Practice

Take a look at some app settings by following these steps:
1. Open Safari by clicking its icon in the Dock.

2.Go to the Safari menu, and then select Settings.

3. Notice how the settings are organized by category in the Safari Settings toolbar. Click a few of the settings to see what is available.
4.Open another app by clicking its icon in the Dock. Go to the app menu, and then select Settings.

5. Notice that the toolbar options have changed, but the layout is similar.

6. Click some of the settings to see what changes you can make.
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Saving Files

No matter what type of project you're working on, it's a good idea to save your changes regularly. When you save a document, a sheet appears. You use this
sheet to name the file and choose where to save it. A sheet is attached to the window it belongs to, so you always know which file you're saving. You can save
your files in a frequently visited place such as your Documents folder, or you can navigate to another location on your hard disk as needed.
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Tips

Save as you go

Apps developed with Auto Save can automatically save changes to your document as you work, freeing you from manual saving and from the worry that
you'll lose your valuable work if the app quits. Since Auto Save saves all changes in the background, you can work without the distraction of pauses or
progress bars. Auto Save in macOS adds the changes directly into the file so there's only one copy of the document on your Mac.

Revert to last saved version
Apps with Auto Save enabled let you easily undo recent changes. To revert back to it's original state, go to the File menu and select Revert To.

Duplicate a document
Duplicate creates a copy of a document and places it next to the original, so you can start fresh using the original as a template.

Documents on iCloud
You can instantly move iCloud-supported documents to iCloud from the document menu. Untitled iCloud-supported documents are stored in iCloud so
they're available on all your devices.

Practice
Practice saving documents in macOS by following these steps:
1. Click on Apps and click the search field.

2.Enter Text and click on TextEdit.
3. Click New Document. Enter some text in the TextEdit document window.
4. From the File menu, select Save.

5.In the Save sheet that appears, choose the Documents folder from the Where pop-up menu, and then click Save. Your work is saved in the Documents
folder on your hard disk.

6. Create another TextEdit document, which you'll save on your desktop.

7.In the Save sheet, click disclosure (M), and notice how the contents of your hard disk appears.
8. Click the Desktop icon in the Sidebar of the Save sheet, and then click New Folder.

9. Enter My Documents for the name of the folder, and then click Create.

10. Click Save to save the file to the new folder on your Desktop.

11. Navigate to the Desktop and you can see the folder you just created.
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Open a File with Another App

By default, macOS uses specific apps to open particular files. Sometimes you might want to open a file with an app other than what macOS has been
configured to use. You can use the File menu to change the app that opens a file. You can also open a file in another app simply by dragging it to a different
app icon in the Finder or the Dock. For example, you might want to open an image file using Safari instead of Preview.
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Tips

Change the app that will open multiple files
To change the app for multiple files, simply select the files in the Finder, and then go to the File pull down menu, hold the control key down to change the
menu choices and select Get Summary Info. In the "Open with" pane, choose the app in which you want the selected files to open.

Change the default app that will open all files of a certain type
If you want to change the default app to open all files of a certain type, click Change Allin the "Open with" of the Get Info window.

Practice
Open an image file using Safari, and then set the Finder to always open the file with Safari
1. Go to the Practice Lessons macOS folder, Practice Images folder.

2. Double-click one of the image files to open it. Notice how it opens in Preview.
3. Quit Preview by choosing Quit from the Preview menu.

4. Select the same image file and on your keyboard, hold down the Control key.
5. Click on the file to bring up a menu.

6. Select Open with and select Safari.

7.Notice how the image opens in Safari.
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Forcing an App to Quit
Occasionally, an app may take longer than you think it should to perform a task. If you believe that an app has become unresponsive, and you want to force it

to quit, you can do so without causing any ill effects to other apps. When you force an app to quit, you may lose any unsaved changes to files that have been
modified since the last time you saved them. For this reason, forcing an app to quit should be a last resort.
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Tips

How will you know if an app has stopped responding?

To find out whether an app has stopped responding, go to the Apple menu, and then select Force Quiit. If any apps have stopped responding, it will state
which app is not responding.

Force an app to quit from the Dock

If an app is unresponsive, you can try forcing the app to quit from the Dock. Click and hold the app icon in the Dock while holding down the Option key, and
then select the Force Quit option.

For PC switchers Use the Force Quit key combination

On your PC, you may have pressed Control-Alt-Delete to force an app to quit, or restart your computer. On your Mac, you can access the Force Quit window
by holding down the Command, Option, and Escape keys simultaneously.

Practice
Use Force Quit to close the Preview app by following these steps:
1. From the Go menu, select Applications.

2.In the Applications window, double-click the Preview icon to open the Preview app.
3. With Preview open, select Force Quit from the Apple menu.

4.In the list of open apps, select Preview and then click Force Quit.

5. Close the Force Quit window.
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App Store

The App Store changes the way you update your existing Apple software and add new apps to your Mac. The App Store is built into macOS and is just
like the App Store for iPhone, iPad and Apple TV. You can browse thousands of free and paid apps, then download apps to all your Macs authorized for
personal use. It's easy to find apps: you can browse by category, such as games, productivity, and music, or do a quick search for something specific. Apps
automatically install directly to your Applcations folder.
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Purchasing and installing apps is easier than ever

You use the same Apple Account and password you use for Music. If you don't have one, simply go to https://appleid.apple.com to create your own Apple
Account for downloading apps for your Mac. You can also click on your account on the bottom left to view your purchased items. This also allows you to
quickly download apps you've previously purchased.

App Store Settings
Set how App Store updates your apps. To change these settings in App Store on your Mac, select App Store > Settings.

Apps pushed to all Mac computers
The App Store can automatically download apps purchased on another Mac. Choose App Store > Settings. Select the checkbox on Automatically download
apps purchased on other Mac computers.

App Store notifications
When an update is available, you receive a notification. You will also see a badge on the App Store icon in the Dock and a number next to Updates in the
sidebar that shows the number of updates available.

Tell people about Mac apps
In App Store, you can rate and review apps and tell your friends about them.

Customize App purchase settings
Have your Mac always require a password for in-app purchases, or allow purchases for a 15-minute interval after the password was last entered, and then
require the password again after that.

App updates from the App Store
You can update third-party apps from app store updates as long as the apps were purchased from the app store. When an update is released, the app's page
will advise you what's new in the update as well as any additional features or fixes.
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Review
Below is a list of terms from this chapter. See how many you know. The page number for each of these terms are listed for your
reference.

Apps Page 55
Force quitting an App Page 59
App Store Page 60
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Chapter

Managing Multiple Tasks

You can run multiple apps at once, switch between those apps, and even work more
efficiently by using apps within other apps.

What You'll Learn
- Hiding, Showing and Minimizing Windows

- Moving Between Applications

- Using Mission Control to find items on a Busy Desktop
- Moving Data Between Applications

- Full Screen, Split View and Tile Windows

- Multi-Touch Gestures

- Stage Manager




Hiding, Showing and Minimizing Windows

When you work with multiple applications at once, your desktop can quickly become cluttered. Hiding applications is one way to keep your Mac neat and
tidy. If you're working with multiple windows in one application, minimizing a window might work better than hiding the application. Hiding an application or
minimizing a window removes the application or window from the desktop and stores it in the Dock. A hidden application is still open, and the contents of a
minimized window are intact. Both have simply been moved out of your way, so you can get other work done.
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Tips

Quickly minimize multiple windows

If you have multiple windows open in one application, and you want to minimize all of them, hold down the Option key ("\_ ) while clicking the yellow button in
the upper-left corner of any of the windows. This sends all of the windows to the Dock.

Use the keyboard to hide applications quickly
If you have many applications open, pressing Command - H (& - H) quickly hides the active application. If you want to hide the other open applications, use
the Option-Command-H (\_-38 - H )key combination.

Practice
Hide applications, show applications, and minimize a window by following these steps:
1.Go to the Practice Lessons macQOS folder > Practice Images folder.

2.Double-click several of the image files to open them.

3.In one of the image windows, click the yellow button to minimize it. Watch how the window shrinks into the Dock.
4.Move your pointer over the minimized image in the Dock, and notice how its title appears.

5. Click the image in the Dock to expand the window to its full size.

6.From the Preview menu, select Hide. Notice how all of the windows disappear from the desktop.

7.Click the Preview icon in the Dock and watch all of the windows appear again.
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Moving Between Applications

With a busy schedule and a lot to do, you might have a word processor, spreadsheet application, email program, and a web browser open at the same time.
You can use the Dock to quickly switch between open applications by clicking their icons. Another way to quickly move between applications is to use the
Command-Tab key combination.
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Practice
Use the keyboard to quickly switch between applications by following these steps:
1. Click on Launchpad on the Dock.

2.0pen a few applications, such as TextEdit, Calculator, Address Book, Preview, and Safari.

3. Hold down the Command key (&8) and press the Tab key. Notice the screen displays the icons of your currently open applications.
4. Press the Tab key again. Notice that the selected application changes.

5. Move your pointer over another application icon. Notice that it becomes selected.

6. Press the left/right arrow keys. Notice how this also allows you to select which application to bring forward.

7.Release the Command key (28). You will now be in the last application you selected.
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Using Mission Control to Find Iltems on a Busy Desktop

Have you ever wanted to take a quick look at everything on your desktop? Mission Control brings together everything running on your Mac including open
windows, full-screen apps, Spaces, and Dashboard, in one bird's-eye view. Whether you need to sort through multiple applications or multiple windows in
one application, or even if you need to quickly find a file or folder on your desktop, finding the file you are looking for is as easy as pressing a key, the Mission
Control key (80) on your keyboard.

Add more
Desktops

Home

Establish your

first Mac
deployment

- A row of thumbnails across the top of the screen represents Desktop Spaces, and your full-screen apps.
- The lower part of the screen shows a view of the open windows on your desktop and apps. Click anything to instantly navigate to it.

Tips

Clear the desktop temporarily

To move all windows out of the way and view the desktop, press Command - Mission Control key (20). To move the windows back to their places, press the
keys again. If your keyboard doesn't have a Mission Control key (30), press F11. (On a portable keyboard press fn - F11.)

View all windows for the current app
To see all open windows for the app you're currently using, press Control-Down Arrow. To return the desktop to normal,
press the keys again.

Practice
Zoom to Mission Control
1. From a trackpad, swipe up using three or four fingers, or from a Magic Mouse, double-tap with two fingers.

2. From the keyboard, press the Mission Control key (20).
3.1f your keyboard doesn't have a Mission Control key (20), press Control-Up Arrow.

4. Your open windows are grouped by app. To use a specific window, click in the window. You can also click the thumbnail images for Dashboard, full-
screen apps, and Spaces (if you use them).

5.To leave Mission Control, click in the window you want to use, or outside a window to go back to the window you were using before going into Mission
Control. You can also swipe again or press the key you used to enter Mission Control.

Set Mission Control shortcuts
1. Click Apple menu > System Settings, then click Mission Control.

2.Inthe Hot Corners, Active Screen Corners section, select one of the pop-up menus and select actions to perform when you move the pointer to a screen
corner. After you set an active corner, move your mouse to that corner of the screen to see the resullt.

3.Inthe Keyboard and Mouse Shortcuts section, open the pop-up menus to select keyboard shortcuts, mouse shortcuts, or both. If you have a multiple-
button mouse, you see two columns of pop-up menus in the Keyboard and Mouse Shortcuts section.
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Moving Data Between Applications

One way that you can be more efficient when working with your Mac is by moving data between applications. Not having to retype the same information into
two different applications can save countless hours. You can move data between almost any two applications. You simply drag a word, paragraph, or graphic
from one application to another. You can even drag the data you want to move from the application to your desktop.
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Tips

Use clippings as an extended clipboard

If you have several paragraphs that you want to move around in a document, but don't want to continuously copy and paste, you can drag paragraphs, one at
a time, from the document to the desktop to create clippings, and then delete them from the document. When you decide where in your document you want
to put the paragraphs, drag the clippings there.

Practice
Move data between two different applications by following these steps:
1.From the Go menu, select Applications.

2.Double-click the Safariicon to open the Safari application.

3.In Safari, go to https://hcsonline.com/services/education-services/general-services.

4. Select a paragraph of text, and then drag the text to the desktop. Notice that this creates a text clipping on the desktop.
5. From the Safari menu, select Quit.

6.In the Applications window, double-click the TextEdit icon to open the TextEdit application.

7.Click New Document.

8.Drag the text clipping from the desktop to the TextEdit window.

67



68

Full Screen, Split View and Tile Windows

Many apps on your Mac computer, including the Finder, support Full Screen and Split View. Full Screen allows an app to fill the entire screen and allows
you to work without any distraction from the Desktop. Split View lets you work in two apps side by side at the same time. This option is accessed by
holding the pointer over the @aximize ( )/linimize () button. If you have an extended display, you may move the window to a specific display.
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Go Full Screen in the Finder Window
You can use the Finder in Full Screen. In the top-left corner of a Finder window, click Enter Full Screen (@) To stop using Full Screen, move your pointer
to the top-left of the screen and click Exit Full Screen (&)

Hold the Pointer Over the Full Screen Mode for Options

Hold the pointer over Enter Full Screen (@) to select how you want the window to be positioned on your ® ,;»_,.
display. These options include: —
- Tile Window to the left of Screen (@) - Fill Screen with selected window () Fall
. Tile Window to the right of Screen (CB) - Arrange selected window to the left (). s U @5 =
- Tile Window to the top of Screen (=) - Arrange three windows with selected window to the left (@8)
- Tile Window to the bottom of Screen (l=a)) - Tile four wndows equally on screen (@8) A
Selecting one of these options will allow you to collaborate between the two or more windows. If you E@m W © &
have an extended display, you may move the window to another device or another display. 6 T ElSmen 5
©]
B Move to S27E590
=i B3 Move to U32J59x

While in Full Screen, you can:

Show or hide the menu bar: Move the pointer to or away from the top of the screen. If you deselected the option to hide and show the menu bar in full screen,
the menu bar is always shown.

Show or hide the Dock: Move the pointer to or away from the Dock's location.

Move between other apps in Full Screen: Swipe left or right on the trackpad or Magic Mouse with three or four fingers, depending on how you set your
trackpad settings.

While in Split View, you can:
Show or hide the Dock: Move the pointer to or away from the Dock’s location.

Show or hide a window's title and toolbar: Click the window, then move the pointer to or away from the top of the screen.

Make one side bigger: Move the pointer over the separator bar located in the middle, then drag it left or right. To return to the original sizes, double-click the
separator bar.

Change sides Use a window's title and toolbar to drag the window to the other side.

Move an app window to the desktop Click the app window, move the pointer over the green button in the top-left corner of the window, then select Move
Window to Desktop. The app is displayed on the desktop. The app that remained in Split View is now Full Screen in its own space; to return it to Split View,
press Control-Up Arrow to enter Mission Control, then click the app in the Spaces bar.

Use an app window full screen Click the app window, move the pointer over the green button in the top-left corner of the window, then select Make Window
Full Screen. The app that remained in Split View is now Full Screen in its own Space; to return to Split View, press Control-Up Arrow to enter Mission Control,
then click the app in the Spaces bar.
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Tile windows
Window tiling in macOS offers several practical advantages, particularly for productivity and focus. You can use any of the following methods to tile windows
on Mac:

- Drag the window to the edge of the screen. Release the window when the highlighted area appears.
- Press the Option key while dragging the window to the highlighted area.

- Use Full Screen mode (@) in the top-left corner of the window.

- Use menu options. Choose Window from the Menu bar and select one of the options:

- Tile active window - Fill the Desktop with the active window
- Tile multiple windows - Tile full screen
- Center the active window

Tip

Maximize a window

To work in a bigger window without going full screen, you can maximize the window; the window expands, but the menu bar and the Dock remain visible.
Press and hold the Option key (C) and click Maximize (€). To return to the previous window size, Option-click the Maximize button again. You can also
double-click an app’s title bar to maximize the window.

Use Split View on Other Displays
To use apps in Split View on other displays, make sure the “Displays have separate Spaces” option is turned on in Desktop & Dock settings (This is on by
default.)

More Options

Press and hold the Option key while you hold the pointer over Enter Full Screen (@) to display more options. ( ° @ Apple Configurator 2 has a
These options include: ‘ N

- Resize window one-quarter and move to the top-left ()

- Resize window one-quarter and move to the top-right (=)

- Resize window one-quarter and move to the bottom-left (=)

- Resize window one-quarter and move to the bottom-right (Cal)
- Center selected window on the screen ((m]) (=) 0] E ] &3
- Arrange selected window to the right (El).

- Arrange three windows with selected window to the right (El)
- Tile four wndows equally on screen (@)

@ Full Screen >

3 Move to LG HDR 4K
@ Move to Richard Goon iPad Pro (2)

Practice
Move and Tile App Windows
1.Open a few apps such as Safari, Calendar and Maps.

2.Go to Safari and hold your pointer over Enter Full Screen (@) in the upper-left corner of a window.

3. Select "Tile Window to Left of Screen (@J)" from the menu. The window fills the left side of the screen.

4. Select Maps and hold your pointer over Enter Full Screen (&) in the upper-left corner of a window.

5. Select "Resize window one-quarter and move to the top-right (™). The window relocates a quater size to the top-right of the screen.
6. While the Maps window is still active, hold your pointer over Enter Full Screen (@p) in the upper-left corner of a window.

7.Select "Arrange three windows with selected window to the left (l&). Maps has relocated to the Left-hand side covering half the screen while Safari
and Calendar are tiled equally on the other half.

8. Select the window for Safari. Click on the top of the window. The window snaps back to the original size.

Resize Windows While in Split View
1. Open two apps such as Safari and Maps.

2.Go to Safari and hold your pointer over Enter Full Screen (@) in the upper-left corner of a window.

3. Select "Tile window to left of screen ([J)" from the menu. The window relocates to the left side of the screen.

4. Select Maps and hold your pointer over Enter Full Screen (@) in the upper-left corner of a window.

5. Select "Tile window to right of screen ((W)"from the menu. The window relocates to the right side of the screen.
6. Move the pointer to the middle of the gap until a handle appears.

7.Click and drag the handle either to the left or to the right to resize the windows.
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Multi-Touch Gestures

Multi-Touch gestures transform the way you interact with your Mac, making all you do more intuitive and direct. Now an even richer Multi-Touch experience
comes to macOS. Enjoy more fluid and realistic gesture responses using swiping, pinching, tapping, rotating and gestures spreading fingers.
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Tips:
Customizing how your gestures work and setting options for your trackpad or mouse
Go to Apple Menu > System Settings > Trackpad or Mouse Settings.

Practice

Default Gestures in macOS

Swipe between pages

Swipe 2 fingers left or right in apps like Safari and Preview and the new page moves in, replacing the previous one.

Swipe between full-screen apps
Swipe left or right with three fingers to move from one full-screen app to another. One app whips off the screen and is replaced by another.

Notification Center
Swipe left from the right edge with two fingers to access Notifications and Widgets.

Swipe for Mission Control
A swipe up with 3 fingers on the trackpad shows you all the open windows for an application.

Open/Close Launchpad
Pinch three fingers and your thumb on the trackpad to open and close Launchpad.

Show desktop
Spread three fingers and your thumb on the trackpad to move all open windows off the screen, revealing the desktop.

Note: See Apple support article for all the Multi-Touch gestures: https://support.apple.com/en-us/HT204895
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Stage Manager
Use Stage Manager to focus on tasks and moving between apps and windows easier as well as leaving your Desktop appearing clutter free. Your recently
used apps are neatly arranged along the left side of the screen for quick access, while the window you're working with is positioned in the center of the

screen. When you switch to a group, all apps in the group open in the center of the screen. If the Dock is positioned on the left, Stage Manager will be arranged
on the right.
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Turn on Stage Manager
On the Menu bar, click Control Center (&) and Click Stage Manager (:0) to turn Stage Manager on/off.

Customize Stage Manager
To change the Settings for Stage Manager, open System Settings and click Desktop & Dock from the sidebar. In the Windows & Apps section, next to Stage
Manager, click Customize.
- Recent applications: Show recently used apps on the left or right side of your screen depending on your dock position. If this option is turned off, recently
used apps are hidden. Just move the pointer to the left edge of the screen to briefly show them.
- Desktop items: Show items on the desktop. If this option is turned off, items on the desktop are hidden—click the desktop to show the items when you
want to access them.
Click the “Show windows from an application” menu, then select an option:
- All at Once: Show all available windows for an app when you switch to it.
- One at a Time: Show only the most recently used window for an app when you switch to it.
To switch to a different window when this option is turned off, click the app on the left again to open the next available window.

Practice
Navigating with Stage Manager:
1.In the Finder, launch five apps from the Dock including Safari.
2.7Turn on Stage Manager, if it's not already on.
3.0n the left side of the screen, click on an app. Notice how the app switches place with the main app window.
4. Click on the desktop, confirm saved items appear on the Desktop and the app windows are parked to the left.

5. Click on Safari from the left. Create a couple of new windows. Click on an app from the left to switch out Safari. Confirm Safari has a stack of windows
when parked.

6.Drag an App from the left to the center to create a group. Click on an app from the left to switch places. Confirm the group of apps appear on the left side.
To ungroup the apps, drag an app to the left side of the screen to remove it from the group.

71



Review
Below is a list of terms from this chapter. See how many you know. The page number for each of these terms are listed for your reference.

Mission Control Page 66
Full Screen Page
68-69
Split View Page
68-69
Multi Touch Gestures Page70
Swipe Page70
Stage Manager Page 71
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Keep Your Mac Secure

macOS has several security features built in to make your Mac more secure. Most of
these features are invisible to most users, so you can feel safe knowing that your Mac is
secure even if you don't notice anything different.

What You'll Learn

- Keep Apple Software Up-to-Date

- Keep Your Data Private with Lock Screen

- Keep Your Mac Secure with FileVault and Lockdown Mode
- Allowing Applications and Accessories

- Privacy

- Passwords

- Passkey

- Time Machine




Keep Apple Software Up-to-Date

Apple regularly updates their software to add new features, improve performance, and tighten security. If you have the Software Update setting in System Settings
set to automatically check for updates, the System Settings in your Dock will show a badge when there are software updates for macOS software. A banner
notification will appear on your screen when there are macOS updates available as well. You can set Software Update to automatically download and install your
macOS updates and/or your security updates. You can also set Software Update to automatically install application updates from the App Store.
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Tips
Update/Restart Now
Click Update/Restart Now to install all the available system software and updates that appear in the Software Update pane.

Update Tonight
Click Update Tonight to install downloaded updates overnight. You need to make sure your Mac is powered on, not in sleep mode, and connected to the
internet

Automatically keep my Mac up to date
In System Settings > General > Software Update, click Info (®) for Automatic updates. Enable Install macOS updates and Install application updates from the

App store.
~
Installed macOS T|
Automatically
D load new up when bl
1at a
h Install macOS updates [ @)
Install Security Responses and system files [ @)
ity [ oone
nce
)

Practice
Update your software by following these steps:
1.From the Apple menu, select App Store, or you can launch App Store from your Dock.

2.1f there are updates, the updates will be listed for you.
3.Click "more" to expand, to see in detail, what is being updated.
4. Click Update Now.
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Keep Your Data Private with Lock Screen

Computers are often used to store personal and private information forfor the user’s eyes only. Apple has a built in feature for your Mac called Lock Screen.
Lock Screen enables you to secure your Mac when you walk away by setting the screen to auto-lock after a set period of time, requiring your login password
to unlock your screen. This prevents invasive eyes from getting access to your data.
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Practice
Customize your lock screen
1. From the Apple menu, select System Settings.

2.Click Lock Screen.

3.Enable "Show message when locked."
4. Click Set.

5. Type in a message for the Lock Screen.
6. Click OK.

Setup a Hot Corner for lock screen
You can set up a Hot Corner for a Lock Screen so right before you leave your Mac, you go to a Hot Corner to activate the Lock Screen. You may set a
Hot Corner with a keyboard shortcut to avoid accidental activation when the pointer goes to a corner.

1. From the Apple menu, select Desktop & Dock.

2. Scroll down, click Hot Corners.

3. Hold the Option Key down on your keyboard.

4. Click on the top-right menu and select "\_ Lock Screen.

5. Click Done.

6. Hold the Option key down on your keyboard and move the pointer towards the top-right.

X Start Screen Saver X Lock Screen

Quick Note
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Keep your Mac Secure with FileVault and Lockdown Mode

macOS provides FileVault as a means to encrypt the information on your Mac to prevent unauthorized users from accessing your information. FileVault
provides XTS-AES-128 encryption with a 256 bit key to encrypt the disk and all files located on the drive. Lockdown Mode is an optional, extreme protection
that's designed for individuals who might be personally targeted by some of the most sophisticated digital threats. When Lockdown Mode is enabled, your
device won't function like it typically does.
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WARNING: Don't lose your recovery key. Store your key in a safe place that you can get access to. This means do not store the recovery on your
computer that you have encrypted with FileVault. Without your passwords or your recovery key, you or Apple will not be able to get access to your
computer.

macOS Security Features:

Full disk encryption

FileVault encrypts the entire start up drive on your Mac, helping keep your data secure. FileVault does not support encryption of RAID disk sets if they are your
Startup drive.

What does Lockdown Mode do?

When Lockdown is enabled, certain apps and features will function differently. For example, in Safari, certain web technologies are blocked, which may cause
websites to load slower or not work at all. New configuration profiles cannot be installed, but if the Mac was enrolled before Lockdown Mode is turned on, the
Mac can be managed by a Mobile Device Management (MDM) system.

Review the following article about Lockdown Mode: https://support.apple.com/en-us/HT212650

Recovery Mode

When you boot your Mac into Recovery Mode, you will need to enter the password for the administrator account before proceeding. You have the option to
erase the Mac. After you erase the Mac, you will have to reinstall the macOS. Since the data has been encrypted, retrieved data from drive utilities will not be
usable.

Tips

No Automatic Login

When FileVault is turned on, your Mac requires your user account password to unlock your built-in startup disk and allow your Mac to finish starting up. No
user account is permitted to log in automatically.

Multiple Users
If other users have accounts on your Mac, you're prompted to enable each user and enter their password before they can unlock the disk. User accounts
added after turning on FileVault are automatically enabled.

Recovery Key

macOS presents you with a 24-character alphanumeric recovery key, which can be used to unlock a FileVault-encrypted disk even if you forget the password
for every account authorized to boot up the system. You should write down this recovery key; or copy, paste, and store it somewhere secure. Just be sure you
save it in a location other than this computer’s drive, so you'll be able to retrieve it should you be locked out of the drive. Alternatively, you can opt to have your
iCloud account reset your password.

Exclude websites from Lockdown Mode
To exclude a website while browsing: Go to the Safari menu > Settings for [website]. Then deselect the Enable Lockdown Mode checkbox. To include the
website again, select the checkbox.

Chapter 6 Keep your Mac Secure



NOVEMBER New York
MTWTF
34567

0112138

47°
17 18 @20 21 2

.
24 25 26 27 28 Cloudy
H:47° L:37°

Practice (Optional)
Turn on FileVault

< > Lockdown Mode

Lockdown Mode

When your Mac is in Lockéown Mode, applications, websites, and
features will be strictly limited for security, and some experiences
will be completely unavailable.

Messages

Most message attachments are blocked, and some features are unavailable.
FaceTime

Incoming from people you have not prey

blocked. Featu s SharePlay and Live Phot

Web Browsing

Some web technologies and browsing features are blocked.

Photos

Location will be excluded by default when sharing photos, and Shared Albums
will be removed from Photos

Device Connections.
Wired connections. ssories while your Mac is locked are blocked.
Apple Services

Incoming invitations for Apple Services from people you have not previously
i blocked.

Profiles
Configuration profiles, such as profiles for school or work, cannot
be installed.

(LSS Turn On Lockdown Mode

Getting Started on macOS Tahoe

NOTE: FileVault encryption cannot be used with some highly partitioned disk configurations, such as RAID disk sets.

1.Go to Apple menu > System Settings,
2.Click Privacy & Security.

3.Scroll to FileVault.

4.Click Turn On.

5. Enter an administrator name and password.

7.Select how to unlock your disk and reset your login password if you forget your password:
A.Use your iCloud account: Click "Allow my iCloud account to unlock my disk.”
B. Create a recovery key: Click “Create a recovery key and do not use my iCloud account.” Write down the recovery key and keep it in a safe place.

8. Click Continue.

9. If your Mac has multiple users, click Enable Users, click Enable User and enter the login password (or have the user enter it) for each user that you want
to allow to login after the Mac starts up, then click OK. If you don't allow a user to log in after startup, an administrator must log in before the user does.

10. Click Continue.

Encryption will begin. Depending on how much data is stored on your computer, the time for encryption will vary. You can use your Mac as usual while your

information is being encrypted.

Note: If you see an alert message that encryption has been paused, your Mac may have detected a problem that could keep the encryption from completing
successfully. For example, if your portable computer is not plugged into an electrical outlet, the encryption process may pause until the power plug is

connected.

Enable Lockdown Mode
1.Go to Apple menu > System Settings,
2.Click Privacy & Security
3. Scroll to Lockdown Mode.
4.Click Turn On.
5. Enter an administrator name and password.
6. Click Turn On and Restart.
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Allowing Applications and Accessories

macOS Tahoe has ways to protect your Mac from malicious apps and devices. In System Settings > Security, you can choose to allow applications downloaded
from the App Store only or from the App Store and identified developers. By choosing only the App Store, you know these apps are reviewed and compliant to
Apple's requirements. Your app installs are less secure when coming from another method. For Apple Silicon Macs, you have to approve USB or Thunderbolt
devices you connect to your Mac.
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Tips

Choose where apps are installed from

For maximum security, select to only allow applications downloaded from the App Store. The default setting for macOS is Mac App Store and identified
developers.

Unidentified Developer Alert
If you have selected Mac App Store and identified developers, macOS alerts you if you attempt to open an app from a developer who does not have a
Developer ID.

Manual override
If you receive an alert that an app is from an unidentified developer, you can still choose to open the app. Control-click the app icon to reveal a contextual
menu. Select Open and you'll see a dialog that allows you to open the application.

Allow accessories to connect
If you have an Apple Silicon Mac Portable, you have to approve new USB or Thunderbolt devices and SD cards that you connect to your Mac. If you select
Allow, the accessory allows both power and data transmission. If you select Don't Allow, the accessory can still charge, but no data is transmitted. If you prefer
not to manually approve new devices or accessories when you connect them, you can change this setting.

1.Go to Apple menu > System Settings.

2.Click Privacy & Security.

3. Scroll to Allow accessories to connect.

4. From the menu, select Automatically When Unlocked or Always to allow accessories to always connect without manual approval.

Practice:
Select "Apps Store” option and test:
1.Go to Apple menu > System Settings.

2.Click Privacy & Security.

3.Scroll to Allow applications downloaded from.
Note: The default is set as Mac App Store and identified developers.

4.Change this setting to App Store from the menu.

5. Launch Safari and navigate to https://www.teamviewer.com/en-us/teamviewer-automatic-download/
6. Click Download now. Click Download TeamViewer.

7.Click Allow.

8.When the download completes, double click TeamViewerdmg.

9. Double click Install TeamViewer.pkg.

10. Note the message that pops up on your screen warning you that the “Installer macOS.pkg” can't be opened because we chose to allow apps from the
App Store only.

11.Click OK.
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Privacy

As your Mac computer gets smarter, more of your apps will interact with other apps and utilize features like your location, to give you better, more accurate
information. The Privacy section in Privacy & Security is where you control the flow of shared information such, as Location Services, Accessibility by apps,
sharing Diagnostics and Usage information, and sharing apps with other apps (i.e., your Contacts or your Calendar).
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Tips
PC Switchers
On Windows 10, this is the same as going to your Start Menu, selecting Settings > Privacy.

Accessibility
Allows apps to have control of your computer. If you are ever concerned about an app having control of your Mac, go to System Settings >
Privacy & Security > Privacy > Accessibility, check for apps that have requested control. Just deselect the app to prevent it from controlling your Mac.

Practice
Adjusting your Privacy settings:
1. From the Apple menu, select System Settings.

2.Click Privacy & Security.
3.Click Privacy > Location Services.

4.1f Location Services are off, enable Location Services. Enabling Location Services allows apps and websites to use your Mac's current location to provide
information appropriate to your location.

5. Notice the Apps listed on your Mac that can use Location services and which ones are not allowed.
6. Notice that System Services is listed here. Scroll down and click Details.

7.Review what has been enabled for System Services. Disable Setting time zone.

8. Enter password for the admin account. Click OK.

9. Click Done.

10. Click General from the left column. Click Date & Time.

11. Confirm Set time zone automatically using your current location has been disabled.
12.Enable Set time zone automatically using your current location.

13. Confirm a message Location Services are turned off appears. Click Open Privacy Settings.
14. Click Details for System Services.

15. Enable Setting time zone.

16. Enter password for the admin account.

17.Click Done.
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Passwords

The Passwords app stores your passwords, passkeys, and verification codes in one convenient location. They're accessible across all your devices when
signed into the same Apple Account and with Passwords enabled in iCloud settings. If you use AutoFill for signing into apps and websites, your passwords will
automatically appear in the Passwords app.
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Weak or Compromised Passwords
When you create and save passwords for websites and apps, your Mac automatically detects common vulnerabilities, such as weak or reused passwords. It
also securely monitors your passwords and notifies you if they are found in known data breaches. To change a weak or compromised password:

1. Select Security in the sidebar. You'll see a list of accounts with weak or compromised passwords.

2. Click on an account to view details. If the password is weak or compromised, a message will explain the issue.

3.Click the series of dots in the Password field to copy the existing password. This can be useful when you're asked to enter your old password while creating

anew one.
4. Click Change Password and update your password on the website or in the app.

If the website or app supports passkeys or Sign in with Apple, consider using these features for added security and convenience. If upgrading isn't an option,
your Mac can generate a strong password that you won't need to remember. If you receive a warning about a password for a website or app that no longer
exists, you can remove the account from your Mac and iCloud Keychain. In the Passwords app, click All, then swipe left on the account using two fingers on
the trackpad.

Verification Codes

Some websites and apps provide two-factor authentication (also called multifactor authentication) to enhance account 3
security. Even if someone knows your password, this extra layer of protection helps prevent unauthorized access. Your

password serves as the first authentication factor, while a temporary, one-time verification code is often used as the B

second factor. Backblaze

1.Sign in to the website or app's account management section and navigate to the options for enabling two-factor
authentication with an authenticator app.
2. Select the option to manually enter a setup key (sometimes labeled as a setup code or similar), then copy the key.

User Name jappleseed.personal@icloud.com

Password ®sccscscsccscscsscce

3.Open the Passwords app on your Mac. Code * 063 826

4.Find and select the account for the website or app. Website secure.backblaze.com

5. Click Edit, then choose Set Up Code. Modified Today
N J

6. Paste the copied setup key into the Setup Key field.

7.Click Use Setup Key to confirm.

8. Click the Verification Code to copy it.

9. Return to the website or app and paste the verification code in the designated field to complete the setup.

Add Passwords extensions for third-party web browsers
1. Go to the Passwords app on your Mac.

2.Click on the Passwords menu.
3.Select Get Browser Extension.
4. Click View for your third-party browser and follow the onscreen instructions.
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Share Passwords
AirDrop allows you to securely share passwords and passkeys with an iPhone, iPad, or another Mac. However, specific requirements must be met for sharing
passwords and passkeys via AirDrop:

« iCloud Keychain must be set up on your Mac.

- The person you're sharing with must be in your contacts list in Contacts, and they must be listed with the email address they use for iCloud.

+ You must be in the other person’s contacts list in Contacts, and you must be listed with the email address you use for iCloud.

Send a password or passkey
1.1n the Password App, click All.
2.Select the account you want to share.
3.Click Share ((M).
4. Select the device or person you want to send the password or passkey to.

Share a password or passkey to a group

1.Choose File > New Shared Group.

2.Enter a name for the group.

3.Click Add People.

4. Enter the names of people you want to share with, then click Add. As you type, matching names from your contacts appear. If a contact's name is

dimmed, their device might not be using the latest software. You can also add existing groups, which appear at the bottom of the list.

5.Click Create.

6. Select the desired passwords, passkeys, and Sign in with Apple accounts to move to the group.

7.Click Move.
The people in the group can now use your passwords, passkeys, or Sign in with Apple for the accounts you selected. The next time they open Passwords
settings, they are prompted to accept or decline your invitation. Click Notify via Messages to notify the people in the group that you've shared with them. If you
don't want to notify them, click Not Now. As the person creating the group, only you can add and remove people from the group, rename the group, and delete
the group.

Stop sharing with a group
1. Click the shared group in the sidebar.
2. Click the account with the password or passkey you want to stop sharing.
3. Click the pop-up menu next to Group, choose Stop Sharing, then click Stop Sharing.
4. The password or passkey is now available only to you.
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Passkey

A passkey is a way to sign in to an app or website account without needing to create and remember a password. Instead of a password, a passkey uses
Touch ID or Face ID to identify you. If your Mac or Magic Keyboard has Touch ID, you can sign in with Touch ID. You can also sign in with an iPhone or iPad by
scanning a QR code and using Face ID to verify your identity.
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Create a passkey
Before creating your first passkey, you must have iCloud Keychain set up on your Mac.

1.When you sign up for a new account, enter an account name, then click to submit.

2.When you see the option to save a passkey for the account, select how you want to sign in:
- Touch ID on your Mac: Place your finger on the Touch ID sensor.
- Scan a QR code with your iPhone or iPad: Click Other Options.
- External security key: Click Other Options.

Sign in to an account with a passkey
1.0n the account sign-in page, enter your account name, then click the account name field.

2.Click your account in the list of suggestions.
3.Do one of the following:

- If you have Touch ID on your Mac: Place your finger on the Touch ID sensor.
- If you have an iPhone or iPad: Click Other Options, click “Passkey from nearby device,” then click the QR code.

NOTE: Bluetooth must be turned on in Settings > Bluetooth for your iPhone or iPad. Bluetooth must also be turned on for your Mac.
- External security key: Click Other Options, click “Security key," then follow the instructions onscreen.
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Time Machine

Time Machine is an automatic backup system that's built right into macOS. It keeps an up-to-date copy of everything on your Mac. Time Machine backs

up your System files, applications, accounts, settings, music, photos, movies, and documents. What makes Time Machine different from other backup
applications is that it keeps a spare copy of every file and it remembers how your system looked on a given day, so you can revisit your Mac as it appeared in
the past.
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Choose certain folders and files to be backed up
You can customize what items should be omitted from Time Machine backup with System Settings > General > Time Machine > Options. Under Exclude
from backups, click Add(+), navigate and select the folder or file to omit from the backups.

Encrypted backup

macOS includes the option to create encrypted backups to an Airport Time Capsule or external attached drive. Encryption is not available if you are using

a disk directly connected to your Mac that is formatted using an Apple Partition Map (APM) or Master Boot Record (MBR) partition and the disk has more
than one partition. If the disk is formatted APFS with multiple volumes, you can do an encrypted Time Machine backup to a volume. When you switch a Time
Capsule or network backup disk from unencrypted to encrypted, your existing backups are erased and new encrypted backup sets are created. When you
switch locally connected disks (such as an external disk) to encrypted backups, your data is preserved and encrypted.

Backup to multiple locations
Time Machine allows you to choose multiple backup locations and seamlessly switch between them. You can have a backup of your data at work and at
home.

P
Practice ) ) . TM Backups
Setup a disk for a Time Machine backup B 444 7B available
1. Connect an external hard drive to your Mac.
. . E t Back ' )
2' GO tO SyStem settlngs and C“(:k General' Y::Z':'t r::t:oruepyour data without this password.
3. Click Time Machine.
New Password XXXITYYY
4. Select a disk for backup.
. Re-enter Password LXYYYYYYY
5. Encrypt Backup is on by default. Set a New Password for your encrypted Backup.
6. Re-enter the Password and enter a hint. int
7.Click Done. Disk Usage Limit © None Custom
g
Restore a file that was deleted .
1. Create a document from TextEdit and save it to the Desktop. cancel . (EEEND
v

2.From the Time Machine menu in the Menu bar, select Backup Now.

3. After the backup is complete, delete the test file.

4.From the Time Machine menu in the Menu bar, select Browse Time Machine Backups.
5. Select the test document and Click Restore.

6. Confirm the document has been restored.
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Review

Below is a list of new terms from this chapter. See how many you know. The page number for each of these terms are listed for your

reference.

Time Machine Page 83

FileVault Page
76-77

Lockdown Page
76-77

Passwords Page
80-81

Privacy Page 79

Gatekeeper Page 78
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macOS Apps

macOS includes tools that will change how you work, play, and search on your Mac.
From Mail, Contacts, and Calendar to Messages, Reminders, and Notes, you can access
a variety of information quickly from your desktop that is also available on your other
devices such as iPhone and iPad.

What You'll Learn

- Spotlight

- Mail

- Safari

- Preview

- Dictionary

- Siri & Apple Intelligence
- Notes

- Contacts

- Calendar

- Reminders

- Messages

- Stocks

- News

- Books

- Freeform

+ iPhone Mlirroring
- Phone

- Shortcuts

- Journal
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Spotlight

Sometimes it can be difficult to remember where you saved a file, get help with a conversion of measurement, or a definition. Apple has given you Spotlight
for this and more. Spotlight is a desktop search technology built into macOS giving you comprehensive and instant search results that are automatically
updated. With Siri Suggestions, you can also get news, sports scores, weather conditions, stock prices, and more. Spotlight can be used at any time and will
immediately begin showing search results, even before you have finished typing.
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Tips
Start a new Spotlight search
Click Spotlight (Q) in the upper right hand of the Menu Bar or press Command + Space Bar to open Spotlight.

How to search

You can enter a word or a search phrase just like when you Google something (i.e., email from Rich, Tax.pdf, or presentations by Chris); open an app by typing
the name of the app and pressing return; get conversions, calculations, and definitions. Convert temperatures by typing one type of measurement (Celsius)
and you will be given the equivalent (Fahrenheit). For example, 33° Celsius and click on 33° Celsius to Fahrenheit. Enter a calculation and you get the answer.

Spotlight suggestions

Spotlight suggestions allow you to search for news, sports, movies, stocks, weather, and more from the web, and using sources like Wikipedia, Bing, Maps, and
Music. To use this option, you would go to Apple Menu > System Settings > Siri & Spotlight. Go to Search results. To include a category, in Spotlight searches,
enable it from the list; to exclude a category from Spotlight searches, disable it from the list. By default, Spotlight results include Siri Suggestions.

Quick Look in Spotlight
When you find a file you need to preview, select it from the results, and then tap the Spacebar on your keyboard. This works only on documents that support
Quick Look.

Drag and drop from Spotlight
You can drag items from the Spotlight menu, which makes it quick and convenient to make a copy of a document to another location and send a document
via email or AirDrop.

Specify an area to search

Spotlight makeg it easy tolfind what you nged by letting you segrch by category, including apps, files, actions, A @ @
and even the Clipboard. Simply open Spotlight and press the Right Arrow key to choose where to search.
Weather and Sports
If you need to know what the weather is like in Lisbon, Portugal, you can simply use the phrase “weather in Lisbon, Portugal” On the result you'll see current
weather and a forecast. Sports scores are the same. You can type in things such as “Nets Score”, to show you the score of the Nets game.
Modifier Keys within Spotlight
After you get your results from your Spotlight search, you can use the following Keyboard shortcuts:
+ Hold down the Command key to see the location of the currently selected item as text to the right of the selected item in the Spotlight results window.
- Command+R or Command-+Enter will show the currently highlighted result’s location in Finder, or launch an appropriate app.
- Command+ L skips directly to the dictionary definition search result.
- Command+B will search for the term in the default browser, using whatever search engine is selected as default.
- Typed the wrong search term? Command + Backspace will instantly erase it.
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New features in Spotlight:
- Actions & Quick Keys
Perform tasks like sending messages, creating calendar events, running shortcuts, or even formatting text within apps (like making selected text bold in
Pages) directly from Spotlight, often with assigned one-key shortcuts.
- Unified & Ranked Results
See all result types (files, apps, emails, web, clipboard) together, intelligently ranked by relevance and usage, making it easier to find what you need.
« Clipboard History
Search and access items you've previously copied, including text,images, and files, directly in Spotlight.
- Quick Website Searches
Type a website name (e.g., "Amazon”) and press Tab to search that site instantly.
- Integrated Cloud Search
Find files from third-party cloud services (like Google Drive, Dropbox) directly in Spotlight.
« Search History
Press the up arrow to revisit past searches and actions.
- Enhanced Filtering
Filter results by App, File type, Folder, or File Provider to narrow your search.
- Screenshot Search
Enter /screenshots to find recent screenshots and even search for text within them.

Practice
Practice using Spotlight
1. Click Spotlight (Q) in the upper right corner of the Menu Bar.

2. Slowly type the word "video” in the Search field. Notice how the search results update as you type.

3.In some previews with Video or Sound, press the Spacebar to use Quick Look to play what you see.

4. Press the Spacebar to close out of Quick Look.

5. Enter the equation 55x22. After you get the result, Press Command + Delete (Backspace) twice to start a new search.

6. Enter 22C and press Enter. Confirm the temperature converted to 71° F. After you get the result, Press Command + Delete (Backspace) to start a new
search.

7.Enter $100 and press Enter. Confirm you see a conversion rate as a result.
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Mail
Mail for macOS gives you everything you need from a mail client with the ability to send, receive, and manage your email for all your email accounts, including
iCloud, Microsoft Exchange, Google, Yahoo! and AOL. Mail works with Notifications, Ccontacts and Calendars to keep all your data in sync.
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Swipe in Mail
When using the Classic View for mail (not in columns), you get all the swipe capability that users of iOS have been enjoying. Two-finger swipe to mark,
delete, or archive messages. Right swipe to mark a message as read or unread, left swipe to delete or archive a message depending on how you set up

Mail View Settings.
Save time with suggested events and Contacts
Mail automatically suggests events to add to your Calendar and people to add to Contacts when an email you receive has a new contact or potential event.

Use Data Detectors to add a contact to your Contacts
In a message you've received, move the pointer over a phone number, email address, or street address anywhere in the text. Mail detects the information and
outlines it as a field with a pop-up menu. Click the arrow and select an option from the pop-up menu.
Handoff from One Device to another
If you use Handoff, you can start your message in Mail on another device, then finish it in Mail on your Mac. To continue writing a message handed off to your
Mac, click the Handoff Mail icon that appears at the right-side of the Dock.
Smart Mailboxes
Smart Mailboxes allow you to see, in one location, messages matching user defined criteria from any folder in Apple Mail. Editing a message in a smart
mailbox alters the original message.
VIPs & VIP Smart Mailbox
VIPs are the people who are most important to you in your Apple Mail. Click the menu next to a sender or recipient at the top of a message to add the name to
your VIPs. To view all messages sent from VIPs, click the VIP smart mailbox in the Favorites bar.
Siri
Siri on your Mac makes using Apple Mail easier. You can send a quick email, have your email read to you, create a reminder to look at an email later, search for
email, and more. Here are some examples of what you can say to Siri:

- "Send an email to John about our travel plans”

« "Read my email”

« "Remind me about this in an hour”

Filters

Quickly find unread or read emails in a mailbox by using filters to change which messages are shown. You can apply additional filters for Attachments, VIP, to
Me, or CC'd to Me.

Search

By default, Search will search all folders, you then have the option to select the specific relevant account and folder you want to search more specifically.

Full Screen to Split View

When you use Mail in full screen, messages open in Split View, side-by-side with the message list. You can easily read and write messages without having to
switch windows.
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& Mail File Edit View Mailbox Message Format Window Help < ®m Q 8 TueDec23 10:28PM
; 7/
View oEcemaeR | New York
emails by . o
Categories D 250 messages, s
D@ &
2 Primary n X 1Message
& Inbox 1 d
> VIPs . £ This message is from a mailing list.
CreativePro Network 1216/25
Flagged December Events Digost
2 80 Be the first to see our full 2026 event calendar! =3 Consumer Reports Cars
D orafts &7 Car Brands Ranked by Maintenance Costs
To: rgoon@mac.com,
Consumer Reports Cars .
Sent : er Rej
< Car Brands Ranked by Maintenance Costs Roply-To:  Consumer Reports Cars Click to
Smart Mailboxes s s easily
unsubscribe
Jecus Citi Alerts
S linox A $32.90 transaction was made on your Costco Anywhere ac froma
View the transaction details. CUSTOM ALERT Richard g
O orafts GoonCardmember since 2021Card ending in 3400 transaction. - mailing list

7 sent American Express MyCredit Guide 12016125
Your FICO®* Score has changed December 16, 2025
T Junk Log in to your account to see why Hello, RICHARD Log in We've N

noticed your FICO®" Score has been updated Stay updated an.
1 Trash
Mr. Edward Posnak 12715125

T Archive Triumph 40

B All Recipes
Allstate. Monoprice 1201525
 Santa's Secret Steal: $20 OFF for $100+ Order
B American Ex.
Apple
Sz ups 1271525
B Arcadia UPS Update: Package Scheduled for Delivery Today
B backblaze

uPs 12115125
UPS Update: Package Scheduled for Delivery Today

Downloading Messages
15,668 new messages

Where is the Send button?
The default view for Apple Mail in macOS Tahoe is icon only. The Send button is (@) now located in the top right. To change the view, go to the View menu
and select Customize toolbar (ﬁ). On the bottom-left corner, change Icon only to either Icon and Text or Text only.

Attach Photos from iPhone or iPad
You can insert photos or scanned documents from your nearby iPhone or iPad into emails you are composing by clicking the Photo Browser button in the
toolbar of your emails, then choosing an option.

Moving Mail to Mailboxes
You can quickly move selected emails to another mailbox by clicking the Move to button in the toolbar of the Mail window, then choosing a mailbox. Mail can
suggest a mailbox based on where you moved similar emails in the past.

Schedule an email with Send Later .- ()
Click the menu next to Send options ((fy) and select an option. You may choose Send Now or pick a suggested day and —— .
time. When you select Send Later, you get to choose what day and time to send the mail out, i.e., 4/25/2025 at 5:36 PM. :: po0A Tomerro Eet”td
end Later... utton on
Inbox Categories top-right

Starting in macOS 15.4, emails can be categorized into different tabs, such as Important, Updates, News & Subscriptions, Schealule an email to be sent out

Transactions, etc... This will allow you to prioritize messages in your Inbox.

Smart Replies
Smart Replies help you quickly respond to Messages with suggested responses.

Apple Intelligence
With Apple Intelligence allows you rewrite, proofread or summarize your mail before sending out. Apple Intelligence will even help summarize the important
parts of an extensive email for you.

Unsend emails .

Composing
If you've made an error in your email or sent an email by mistake, you can recall an email with & @ W Aa o0 [ = %
Undo Send at the bottom of the Sidebar. To change the amount of time you have to unsend S e Tt e G S e e e
emails or to turn Undo Send off, click Mail > Settings, click Composing, click the °'“";gg'm e
"Undo send delay” pop-up menu, then select an option. R e
Remind Me
If you don't have time to respond to an email right away, you can set a time and date to receive e
areminder and move a message back to the top of your inbox. Swipe or control-click on the When sending o a group, show all member addresses
email and select a time to be reminded to respond to the email. Mark addrasses nct encing with

Send new messages from: Automatically select best account (2]

Hide My Email Sending: | Set a delay time for
If you subscribe to iCloud+, Hide My Email allows you to write and send messages without o send deiay (10 Seconds 6 an Undo Send.
having to share your real email address. e sane e ot o ot e

Quote the text of the original message
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Safari

Safariis your web browser, an application that helps you find and view webpages with new features and improved security. Safari's clean, sleek look lets you
focus on the web instead of your browser. The browser frame is a mere one pixel wide. You see a scroll bar only when you need one. You see no status bar by
default, giving you more room to browse and view the web. And with commonly used tools like a search field built right into Safari, you can get anywhere on
the web faster.

Profile

2 Personal v < hcsonline.com

Menu |
(E Technical professionals. Trusted advisors. Certified Apple ex... %8 Jamf Apple Device Management. Mac iPad iPhone TV Apple... . A
@ Mac Experts P
| hosoniine.com
i v S ~ 2 Premium (:) r‘J T @
Services upport > Company ' Tochoiea Parner | (9 I I
Tabs A“L’Jh
ichaid 0 Share Show/
@ Add to Reading List menu hide Tab
[ Add to “Work” overview
Apple Certifications A Bokmark tor

& New Quick Note Create a
© Add to Dock new tab

Is Your IT Team 0 i Safr
@ Email This Page
@ Email Link to This Page

Certified? =y

L Notes Download
N Openin News .
menu will
Certifications are available for most Apple &) Freeform h
: ; : @ Journal appear when

technologies and skill levels from business e you have

workers to IT professionals, developers, @ shortcuts downloaded

technology trainers, and system architects. ® Copy content and

CERTIFIED SUPPORT CERTIFIED IT MDM TR, & Edit Extensions... not cleared
Professional Protessional
= — p
1808 =R0
Smart search field

Safari has one field for typing both search terms and web addresses. When you type in the field, Safari detects a likely web page match based on your
previous browsing and presents it as a Top Hit. Top Hit suggestions improve as you select the results.

Share button
The Share button is built into Safari, so it's easy to share web pages using Mail, Messages, Facebook, Twitter and more.

Pinned sites
Pinned sites will appear on every Safari Window you open, even if you quit and reopen Safari.

Download button
The download button does not show until you download a file in Safari. If you select clear from the Download button, the button will disappear as well, until the
next time you do a download.

Drag-and-drop downloads
You can drag downloaded files from the Downloads list to your desktop for easy access and organization.

Find option

When you use Find in Safari, you can choose to do a Google search or select Find and a Find bar will appear for you to enter a search within the page you are
on. To the left of the search field, the number of matches appear. These matches are highlighted in the Safari page. When done, click on Done and the Find
bar disappears.

Favorites/Top Sites
With the View Show Favorites Bar, you get a Start Page (38) on the left. By clicking the Start Page (332), you are brought to all your favorites along, with
frequently visited sites, sites shared with you, your Reading List, and websites visited on other devices, such as an iPad or iPhone or another Mac.

Sidebar
Safari incorporates Bookmarks handling into a sidebar that also incorporates Reading List, links Shared with You and iCloud Tabs, to the left of the browser.

Offline Reading List
Safari saves the web pages in your Reading List so you can catch up on your reading even when you don't have an Internet connection. If an article in your
Reading List contains multiple pages, Safari fetches the pages and stores them, so you can read the entire article offline.

For Browsing Privacy
Click File > New Private Window so that your browsing history will not be saved by Safari and websites will be asked not to track you.

Stop videos that Auto-Play

Safari keeps unexpected and unwanted videos with audio from playing, so you can browse in peace. Do you have a favorite site where you always want
videos to play? Use new per-site settings in Safari to enable media auto-play, by going to Safari > Settings > Websites and click on Auto-Play to setup what
can Auto-Play and never Auto-Play.

Password Autofill
When you log in to a website, Safari offers to save your password for Autofill, so you don't have to type it the next time you log in.
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Click to show/hide
the Sidebar

eoe Q Search or enter website name h + B

R HCS — Start Page.

List of

Tab Groups oy

HCS Tab Groups

Extensions
© Graphics
- Supercharge your Safari browsing with
@ Hes f extensions that can find discounts, block ads,
| and more.

iCloud Tabs.

& RGoon MacBook Pro ‘
& Richard Goon iMac
saved

Click (llbeomarts

iCloud Tabs 0dReading Eat

Drag to Reorder

! - . Yt Favorites

sites visited Saved links uf e Q5 ® Suggestions

from other © Privacy Report
devices 5 00 Reading List

© Recently Closed Tabs
& iCloud Tabs.

to view 72 Shared with You

Show in Suggestions
O Frequently Visited
2+ Shared with You

(&) Background Image

f

P Customize a
on nstagram: *Than... | [T i
el Start Page

Updated Start Page
A start page design can include Favorites, Frequently Visited, and Siri Suggestions that show relevant websites in your browsing history, recently visited sites,
bookmarks, reading list, iCloud Tabs, and links you receive in Messages.

Weak password warnings

When you sign in to an account in Safari with a weak, easy-to-guess password, Safari warns you and helps you replace it with a stronger one. gg;’; t/\hdZnu
Distraction Control for more tools
This feature allows you to hide distracting elements on webpages, like sign-in banners, cookie preference pop-ups, @ e
and newsletter signup overlays. Click the Page Menu and select Hide Distracting ltems. Click on the distracting items S

to hide the items. Click Done when finished hiding distracting ltems. @ Hide Distracting Items...

Live Text with graphics on Safari = Vieo Vievier

With Live Text, you can select the text in a photo or image, then work with the words and numbers in Safari. Go to Q Zoom 100% &
a photo or image that shows text (the text can be words, a phone number, an email address, a website address, or @& Find...

a street address). Move the pointer over the text, then drag to select it. Control-click and choose an option such as @ Website Settings...

Copy or Search the web.

Shared Tab Groups

Share a set of tabs with friends. Everyone can add their own tabs and see the Tab Group update instantly as you work together.

Tab Group start pages
Tab Groups have dedicated start pages that you can customize with a background image and favorites.

Pinned tabs in Tab Groups
Customize your Tab Groups with pinned tabs for each group.

Web page image translation
Added support for translating text in images using Live Text.

Website settings sync
Settings you've set for specific websites, like Page Zoom and Automatic Reader view, will sync across devices.

Highlights
Safari automatically detects and displays relevant information on a webpage, such as summaries, locations, and quick links to learn more.
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Preview

Preview allows you to view and mark up PDFs and images. You can also remove pages or combine pages in PDFs. Preview also works well with documents in
iCloud Drive. You can take a screen shot of a selection, window or the entire screen and import the picture right into Preview. You can import an image from a

scanner or camera right into Preview.

[ oceusen
SMTwWT e
12
78 00 m0
1518 @ 18 1
212223 20 25 -
2020 %0 3

mv232.pdf
Page 2 of 2 — Edited

[(n}%
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(front and ba W8 LR maermunDIS o Mikary i
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Enhanced Document

“&’ REALID Documem istration

IMPORTANT:
o )

Regis
IfyoudoNOT

¥
LICENSE/PERMIT/NON-DRIVER ID CARD:

Entor the 1D number on New York State ||

license/permit/non-driver ID card.
NAME (Print your name - Last, First, M)

John Appleseed

TELE
631-555-5555

{ERE YOU GET YOUR MAIL
80 Orville Drive, suite 100

“and Name, Rural Deivery, Apt. No. andlor P0. B0x No.

CITY OR TOWN [STATE

K

ZiP GODE
11716

Bohemia
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Suffolk

NEW ADDRESS - WHERE YOU LIVE
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STATE |2 CODE
©

“and Nams,
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. Ol commercia O snowmoie Dot Cloter
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WARNING! Knowingly providing false information on this form is a misdemeanor and will result in penalties authorized by law.

PART 2 Complete this section to PURCHASE A REPLACEMENT DOCUMENT THAT SHOWS YOUR NEW ADDRESS

Mark the box fr esch type f document that you cuenty have and want o updsle o show Your new sddress. Then, pay the es(s) with &
check that has the account holder's name pre-printed or a money order, payable to Oommlssloner of Motor Vehicles” for the total fee.

Tips
Combining and rearranging PDFs

Using the View Thumbnails in PDFs to display the page thumbnails, you can combine PDFs by dragging thumbnails from one PDF to another. To rearrange a

PDF, you would change the order of the thumbnails in the PDF.
Annotate PDFs

Using the View Markup Toolbar, you can gain access to the Markup tools to highlight, underline, or strike through text. Add text using the Text Button. You can

add notes as well.

View a Digital Asset Exchange File (.dae)

You can open a .dae file, which displays a three-dimensional view of an object or scene. If the .dae file contains an animation, onscreen controls appear in the

window. Click the Play button to view the animation.

Fill out and sign PDF forms

If you receive a PDF from an email that must be signed, you have to print out the file, sign the form with a pen, scan the signed document and send it back.
This can be a long, drawn-out chore. Now, you can use Preview to fill out a PDF, sign the PDF and send it back. You can also have it auto-fill your information,

provided that you have your My Card in Contacts entered.

Practice
Create a signature
If you are looking to sign a PDF, you must first capture your signature.
1.0pen a PDF.
2. Click Markup (®).
3.Click Sign (g ).
4. Use of the following methods:
- Create a signature using your trackpad
- Create a signature using your built-in camera
- Create a signature using your iPhone or iPad

Fill out a PDF
1. Open Preview.
2.Go to File Menu > Open.
3.Go to the Practice Lessons macOS folder and open MV44_Permit.
4. Click AutoFill Form.
5. Click on the field for Full Last Name.
6. Select Your card that is listed
7.Confirm that your address and information is auto-filled in the form.
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Dictionary

How often do you wish you had a dictionary or thesaurus at your fingertips? macOS includes a built-in dictionary that enables you to look up words from
anywhere you are working on your Mac. You can use the Dictionary app that comes with macOS, or you can just control-click on any word in any document
giving you the option to look up that word.

DECEMBER New York

o l22

. < Select
AL 20 20 an-2eL 2K Mostly Clear Dicti -
25 20 30 31 H:3te L1ge XK ) < | > JDictiomary A \ A " different
dictionaries
apple i English I English Thesaurus  Spanish  Spanish - English  Apple W\k\pedval for different
Apple o o
v English definitions

Apple Account

Apple Arcade

ap-ple |‘ap()|

Apple Books
Apple Business E... noun

Apple Business M... 1 the round fruit of a tree of the rose family, which typically has thin red or
green skin and crisp flesh. Many varieties have been developed as dessert or
cooking fruit or for making cider.

Apple Campus - an unrelated fruit that resembles an apple in some way. See also custard
apple, thorn apple

apple butter

Apple Card
abple Cash 2 (also apple tree) the tree which bears apples.
LRy Genus Malus, family Rosaceae: numerous hybrids and cultivars
Apple Configurator
apple core 3 (the Apple) short for Big Apple
Apple Corps
PHRASES
Apple Devices

S the apple never falls far from the tree

) proverb family characteristics are usually inherited: he's a fool, Mary, as his
2ppleiFileSystem father was—the apple never falls far from the tree.
Apple Fitness+ the apple of one's eye | THE ap(o)l ov wonz i |

Apple Games app a person of whom one is extremely fond and proud: a daughter who had

Selecting a dictionary to use
In the Dictionary Settings, you can choose to use a specific dictionary or change the order in which dictionaries are displayed. To turn on or off a dictionary,
click the checkbox next to the dictionary you want to enable or disable. If you want a dictionary to be viewed first in the results, just drag it to the top of the list.

Increasing and decreasing the font size
If you find that the default font size of the Dictionary is too small or too large, you can easily change this by clicking the letter "A" buttons at the top of the
window. The larger "A" will make the font larger and the smaller "A” will make it smaller.

Using Dictionary from within other applications

Have you ever been in an application like Safari, and seen a word you would like to know the definition for? You can easily look up words with the built-in
Dictionary. Just highlight a word, control-click, and select “Look up <selected text>" from the menu that appears. A window will pop open with the definition.
You can choose to view the Dictionary or the Thesaurus. If you want, you can even open the word up in the Dictionary application, by clicking the More button.

Practice
Look up a word with the built-in Dictionary
1. Open the Dictionary application from the Applications folder.

2.Enter the word "apple” into the search window.

3. Your search results are tabulated and changed as you enter each letter.

4. When apple becomes first on the list, you will see the definition.

5.Go to the Practice Lessons macOS folder and open the Sample Lesson 7 document by double-clicking it.

6. Select a word in the file by double clicking on the word.

7.Control-click and select Look Up from the contextual menu.

8. Select your source for your information from the window that opens. € Dictionary 3 Areos

ter-mi-nal | 'tormoenoal | adjective
. . . f, formi i d at the end
Look up a word while in Safari Qe e
. . the terminal tip of the probe. more
1.Launch Safari and go to https.//www.apple.com/c?s/rjacos/. Thes o aptc
2.Scroll to a paragraph and select a word, i.e., Continuity. terminal adjective t |
. . . " L 1 a terminal illness. INCURABLE, untreatable, S IC
3. Right-click or Control-click and select “Look up Continuity” inoperable, end-stage; FATAL, mortal,
. ) . L . deadly, lethal, killing. more
4. Notice how it gave you a definition from the dictionary along with other references. Ab
5.0n the bottom of the window, click on the options to view things referenced e NN , "‘at_‘°a1”5y
) Cenp G Loia
to the word Continuity. line to enter commands for macOS to :oar dort
— perform. Terminal is a type of program more
[ R sixcoior oo s VShor i Gcon
Scroll through 2. Open the Terminal app, which is in the Utilities folc
to view other
references
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Siri & Apple Intelligence

Similar to its functionality on iOS devices, Siri on your Mac serves as an intelligent personal assistant, enabling efficient multitasking and task completion
through simple voice commands. Apple Intelligence is a sophisticated personal intelligence system that integrates advanced generative models with a nuanced
understanding of your individual context, providing insightful and relevant assistance while maintaining a strong commitment to user privacy.

DECEMBER New York

swTwr e s 39°
123456

T et

s @ e w20 .

nmmune s |

202030 o He33s Li2ae

Photos will appear here when they are
ing

finished process

Search and drag Siri results

(J Read memyemails |
) Read my messages

(2) Read me a poem

You can ask Siri to search for information, and then drag the results into a window or application on your desktop. For example, you can ask Siri to find an
image on the web, and then you can drag it into your Pages document. Or you can ask Siri to find a restaurant, then drag the location from Maps into an

invitation.

Type To Siri

You can type a Siri query instead of speaking to it. If you're at the library or in a meeting, you can ask Siri to find something for you on your Mac without
disrupting the people around you. Click on Siri on the top-right on the Menu bar. Enter your query in the Siri field. You may also press the Command key
twice, to quickly access type to Siri. Note: If Apple Intelligence is turned off or unavailable in your language or region, you can still type to Siri by changing

accessibility settings. Go to System Settings > Accessibility and select Siri. Enable Type to Siri.

Use ChatGPT

You can choose to enable ChatGPT from OpenAl on your Mac to access a range of enhanced features. Here's how it works:

- Access ChatGPT through Siri

Siri can use ChatGPT to help answer certain questions, including those related to your photos and documents. I.E. In Siri, type or say, “What should | get my

uncle for his 70th birthday? He loves to fish."

« Use ChatGPT with Writing Tools
ChatGPT can generate text or images from a simple description, helping you create content
quickly and easily. For example, in Siri, enter or say, “What kind of recipes can | make with this?"
with a photo of fruit open in the Photos app.

- Connect Your ChatGPT Account
You do not need a ChatGPT account to use basic features. However, if you have a ChatGPT
account (free or paid), you can connect it for additional capabilities. A paid ChatGPT account
allows your Mac to access more powerful features more often.

You maintain full control over when ChatGPT is used, and you will always be asked for permission

before any of your information is shared.

Before Setup, ChatGPT must be installed on the Mac computer before continuing.
1. Click the Apple menu > System Settings
2.Click Apple Intelligence & Siri > Extensions
3.Click ChatGPT, click Set Up, then click Next.
4.Do one of the following:
- Use ChatGPT without an account: Click Enable ChatGPT.
- Use ChatGPT with an existing account: Click Use ChatGPT with an Account, then
follow the onscreen instructions.
Note: If you want your requests saved to your ChatGPT chat history, you must be
signed in to a ChatGPT account.
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4 ChatGPT Extension

Use ChatGPT «©
. Your Mac can use ChatGPT to help you write text, create an image, answer
questions, and more. OpenAl Terms of Use...

ChatGPT Account
Sign In...

If you sign in, ChatGPT can keep a record of your requests. About ChatGPT
Extension & Privacy...

Capabilities
Requests Advanced
Image Creation Advanced

You'll have access to basic and advanced ChatGPT capabilities until you reach your
daily limit. If you exceed the limits, access will be restricted for up to 24 hours.

Upgrade to ChatGPT Plus

Confirm Requests [ @)
If ChatGPT can help, Mac will confirm the request before sending anything
to ChatGPT. Sending a file will always require a confirmation.
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& Mail File Edit View Malbox Message Format Window Help = ©® © Q ° 8 Mondans 11:32PM

D00 (3 et S O C@e BT O M- o s
f“é“:l]ln... = — Y Use Apple

Apple 112126 MacOS 26 includes a new “Liquid Glass" toggle, enhanced Apple Music support, improved FaceTime performance, and added content filters Intelligence to
> < AlSent Your Apple Account was used to signin to .. G for teen accounts. mac0S 15.7.2 and macOS 14.8.2 provide important security fixes. .
Dear John Applessad, Your Apple Account summarize a

(jappleseed.personal@icloud.com) was used to. fong email

Smart Mailboxes

— e < Richard Goon 9 Inbox - iCloud  November 11, 2025 at 12:35 AM
am B —— pcs s sy i
& Inbox 3 MacOS granted access to Google Account; @ o b &3 (e

Drafts
D oratts ® Google 12/16/25 | wanted to share a quick update on the latest operating-system releases from Apple and what they mean for your
< sent Somoono added you e ization. These updates were released last week.
Jappleseed. personal@iCloud.com added as
= Junk recovery email; remove if unrecognized; see sec. 1. macOS 26

@ Tresh © Google 12116125 + Key changes include: : : ]
ras Sooal 5 o Anew “Liquid Glass” toggle allowing users to switch between clearer/transiucent visuals or a more opaque,
y alertfor jappleseedpersonal66@g.. (7 - 3 = b Ay s
B Archive I AGE SO R AT D tinted appearance — improving legibility and reducing visual strait
jappleseedpersonal66@gmail.com. jappleseed. o Enhanced support in Apple Music: AutoMix now works over AirPl
o Improved FaceTime under I i it
® Backblaze 12/16/25 o Added default content filters for teen accounts (ages 13-17) to strengthen online safety.

& Inbox Your Sign In Settings have been updated & + Numerous security patches (90+), addressing vulnerabilities across WebKit, kernel memory, and more. %
Sign-in settings changed to TOTP; backup
O oraits method must be available; view in My Settings

Exchange

2. macOS 15.7.2 and macOS 14.8.2
Backbl: Te
7 sent ackblaze Team e « This update provides important security fixes and is recommended for all users.

Backblaze Authentication
T Junk This Backblaze Authorization code is required for ; X

security purposes. Backblaze Authorization Co. Let me know if You have any questions.
MW Trash 1

Backblaze 1216125
T Archive [Verify email] Complete your Backblaze ac... (%

Verify email address to start Backblaze

B convers... account; link expires soon; contact support if ne.

Richard Goon
17225 Senior Systems Engineer, HCS Technology Group

Your Apple Account was used to signintoi.. ¥

Apple Intelligence

Use Apple Intelligence to improve your writing, create custom images, and manage content across your apps. In Photos, you can create a Memory Movie by
going to Memories and selecting Create a Memory Movie, then entering a description. To make original images, open the Image Playground app and either
choose a suggestion or write your own description, adjust the style, and add people. To clean up photo backgrounds, open a photo in Photos, click Edit,
then use Clean Up to remove distractions. Manage notification summaries by going to System Settings > Notifications > Summarize notifications, and click
individual summaries to view details. To use Apple Intelligence, you need a Mac with M1 or later.

Writing Tools with Apple Intelligence
With Apple Intelligence, you can use Writing Tools to proofread your work, create different versions of the same text to help you find the right wording and

tone, summarize selected text, and compose content from scratch. Writing Tools are available in most places you write, including third-party apps and
websites.

Apple Intelligence in Apple Mail

When writing in apps like Mail, select the text and click Writing Tools to improve tone, flow, and wording, or to create Writing tools in Apple Meil
summaries, lists, or tables. You can use Priority Messages to quickly view your most urgent emails, like a same-day dinner o b §
invitation or boarding pass. Smart Reply helps you compose a fast email response to ensure you've covered everything. S EasllaRants
You can also view summaries that automatically appear in your inbox, and generate summaries of complex emails and Q 1)
long email threads to view all the pertinent details. Proofread Rewrite

Use Apple Intelligence in Photos

© Friendly
With Apple Intelligence, you can easily search your photos and videos, create memory movies to highlight the stories you N
want to revisit, and enhance your images by removing distracting objects to focus on what matters most. = concise
Summarize audio recordings with Apple Intelligence = GmmE
In Notes, you can easily record audio—whether it's a class lecture, an important meeting, or a personal reminder. With Apple = Key Points
Intelligence, the recording is automatically transcribed, and a clear, concise summary of the transcript is generated. This - t
= List

allows you to quickly review and focus on the key points without having to listen to the entire recording.

8
Image Playground :
In the Image Playground app, you can use Apple Intelligence to create custom images in just seconds by combining # Compose...
concepts, detailed text descriptions, and even people from your photo library. Simply select the elements you want to
include, and Apple Intelligence will generate an image based on your choices. You can also access Image Playground directly within apps like Messages and
Freeform, making it easy to create and share personalized images across your conversations and projects.

Table

Live Translation
Live Translation lets you translate text messages and audio or video calls across languages in real time. For instance, during a FaceTime call with family or

friends who speak different languages, Live Translation helps everyone understand each other seamlessly. Built directly into Messages, FaceTime, and Phone,
the feature uses Apple-designed models that run entirely on your device, keeping your personal conversations private.
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Notes

Use the Notes app to conveniently capture and organize important information, whether it's checklists, lecture highlights, recommended restaurants, or
files and photos for quick access. Notes also supports collaboration, allowing you to share content with other iCloud users. With macOS drag-and-drop
functionality, you can easily add images, videos, files, and text directly into a note. Additionally, you can save content from apps such as Safari, Photos, and
Maps. When using internet accounts like iCloud, Gmail, Microsoft Exchange, or Yahoo!, your notes remain accessible across all your synced devices.
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With gallery view, you can see all your Notes as thumbnails, and easily scan the images in them to find the note you want. Or use powerful search features to
find objects in attached images, text in a scanned document, and more.

Add links
Notes supports links — simply highlight a URL and drag it into the note.

Fonts, bullets, tables and lists
Format your note with fonts, rich text, bulleted items, and numbered lists.

Collaborate
When you use iCloud Notes, you can invite others to view or make changes to a note or folder. If you share an iCloud note with a group conversation in
Messages, you'll see updates in the conversation whenever someone makes a change to the note.

No internet connection? No problem
If you create notes while disconnected from the Internet, the notes are available to your accounts after you reconnect.

Adding Tables to Notes
Need to organize a potluck? Keep track of Little League stats? Track expenses on a business trip? Keep everything organized in a table by clicking the Table
Button or choose Format > Table. You can also copy a table from another app (such as Safari or Pages) and paste it into Notes.

Lock with password
Encrypt locked notes end-to-end with your login password. Go to Notes > Settings. Click Set Password and you can use the login password or create a
custom password.

Enhanced Smart Folders
Automatically organize notes in Smart Folders based on powerful new filters. Create rules for Date Created, Date Modified, Shared, Mentions, Checklists,
Attachments, Folder, Quick Notes, Pinned Notes, and Locked notes.

Pin Notes
By default, the notes you've changed most recently are listed first, but you can sort notes differently. You can pin your most important notes to the top of the
list for easy access.

Organize Notes

Notes is organized with Quick Notes on top, Shared Notes and then Accounts, i.e. iCloud. Within the accounts, ;ﬁf p— Ry -
you may see an All folder, Notes folder and Recently Deleted folder. To create a folder, on the bottom left-hand, New Folder
click New Folder, enter a name for the folder and click OK. You also have an option to create a Smart folder. W . (e
Smart folders will organize your notes by tags or filters.
w N Make into Smart Folder
4P| Organize using tags and other filters.
Not
hay cancel [ OK |
9 PA
Personai
O
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New in Notes:
Audio recordings
Audio recordings can be started right from inside a note, and kept with related comments, checklists, and documents.

Live Transcripts
Live transcriptions appear in real time as you record audio, and the resulting transcripts are fully searchable, ensuring easy access to the information you need.

Sections

Collapsible sections allow you to hide or reveal text in long notes—simply click next to a section header to make your notes easier to navigate.
Highlights

You can highlight text in your note using a selection of five colors, enabling important content to stand out clearly.

Practice
Create a Note with a pic and share it
1. To start a new note, click New Note (&) in the Toolbar. Start typing in the Notepad.

2.Add a picture or file: Drag a picture or file, such as a txt file, onto the note. To delete a picture or file, select it and then press the Delete key.
3.Share a note: Display a note, click Share ((1) at the top of the Notepad, and then choose Email or Message.

Quick Note
1.Launch Safari.

2. Access Quick Note by doing one of the following:

® © ® NewNote Ac = BB @ »

- Keyboard shortcut: Press and Hold the Fn key or Globe Key (®), then Press Q. December 16, 2025 at 4:04PM Choose Photo or Video
. . . | it Record Audio
+ Hot Corner: move the Pointer to the bottom right-hand corner. Click the note that appears. [t rrme—— ~ B Attach File
3.Go to Safari. | Apple Configurator Blueprint | ———

4.Go to hesonline.com. Take Photo

5. Scroll down and click on a technical article.
6.0n the top right-hand, click Share (() and select Add to Quick Note.
7.Confirm the article appears in Quick Note.

& Scan Documents
4 Add Sketch

Richard Goon iPad Pro (2)
Take Photo

& Scan Documents
4 Add Sketch

Managed Service Configurations with Blueprints
in Jamf Pro
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Contacts

Contacts provides a flexible and convenient way to store contact information for family, friends, and colleagues online. Apple has made it easy to have one
place for all your names, numbers, addresses from Facebook, Google, and Microsoft Exchange. All your connections information, including their photos, will be
kept up to date. Contacts is integrated with Mail, Messages and other applications, enabling you to enter contact information once and have instant access to
it from multiple applications.

Click
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Perform actions from Contacts

Click on the labels and get options to perform, such as clicking on the phone label gives you the option to call or send a message. Clicking on the email label
gives the option to email, message, send my card, or use spotlight. Clicking on the address label gives the option to open maps, get directions, copy the
address or copy the map URL. Place your cursor by a number or email and an option appears to the right for messaging or calling as well. Click Share ((I)) to
send a contact to another App or device.

My Card
When you first setup your Mac, a default Contact card is created with your information on it. You can add additional information, use a different picture or add
a nickname. My Card is usually located at the top of the list of Contacts.

Duplicates
Contacts comes with the ability to remove and consolidate duplicates under the Card Menu > Look for Duplicates.

Birthdays
Birthdays from Contacts are automatically pulled into your Calendar app in the Birthday Calendar

Link Contacts

If you have multiple accounts in Contacts, a contact may have separate cards from different sources, such as Yahoo and Google. Linking these cards
consolidates them into a single view while keeping each account's card intact. In the contacts list, select the cards to link, then go to Card > Link Selected
Cards. If a duplicate exists within one account and another card for the same contact is in a different account, choose Card > Merge and Link Selected Cards.

Practice
Adding a Contact and vCards
1. Launch Contacts from the Dock.

2.Click Add (+), then select New Contact.
3. Add your contact information.
4. Click Done.

5.Go to the Practice Lessons macOS folder and drag Samplevfc into the Contacts window to add contacts to your Contacts app. If you want a contact to
be in a specific Group you can drag the Contact to that Group.

6.Drag an address card out of the Contacts window to your desktop to create a vCard.

7.To create a single vCard containing multiple contacts, select multiple contacts and drag the selected cards out of the Contacts window. Some
applications may not be able to read cards that contain multiple entries.

Create Lists
1.Click Add (+) near the bottom of the window, then choose New list.

2.Enter a name for the new list.

3.To add a contact to the list, drag the contact's name from the Name column to the list.

4.To remove a contact from the list, select the contact's name and press the Delete key.
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Calendar

Calendar allows you to easily schedule and track appointments, meetings and activities. You can view multiple calendars at the same time, share your
calendar information with others, and more.
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Add Meeting Notes, Attachments or URLs
Adding meeting notes, attachments or a URL is easy. Tap the event to reveal the quick-edit window.

Search suggestions

When you're searching for an event, Calendar offers suggestions so it's easy to find what you're looking for.

Travel time

Get an estimate based on walking or driving.

Maps

Calendar adds a map showing your event's location. Click to open it in the Maps app.

Time to Leave

Calendar will automatically notify you when it's time to leave for events that contain the event location. Departure times will be adjusted based on current
traffic conditions.

Suggested Events

Events found in Mail automatically will appear in Calendar. For invitations, click on accept and the event will be added as well.
Reminders

WIth reminders in Calendar lets you create, view, edit and complete reminders alongside your meetings and appointments.

Practice
To add an event to a calendar
1.Change the calendar view by clicking the Day, Week, Month, and then Year tab.

2.In Day or Week view, drag from the start time to the end time for the event, and then type a name for it. You can also quickly create a new one-hour event
in Day, Week, or Month view by double-clicking within the day you want the event to appear.

3. Quickly create an event by clicking Add (+) in the toolbar and use natural language “class on June 6". As you type, suggestions will appear that
you can use.

4.In Month View, double click a day, enter a name and duration such as Lunch at 6-7. As you type a suggestion will appear with the name and duration
split into separate fields. Select the suggestion to use it or ignore it if its not what you want.

5. To make any other changes for the event (for example, how often it repeats or whether it has an alarm), double-click the event, and then click Edit and
make your choices in the event editor.

6.If the event is in a different time zone, go to Calendar > Settings > Advanced and select the checkbox for “Turn on time zone support.” Close Settings
and then, in the event editor, choose the correct time zone

7.To invite someone to an event, click Add Attendees, then enter names or email addresses, separated by commas. If the contact is saved, just type their
name. Matching emails will appear as you type. Click Send to send the invites.

8. Select an event you created and press the Delete key. The event is deleted.
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Reminders

There are five sections: Today, Scheduled, All, Flagged, and Completed, which allows you to view your reminders and tasks in one view, whether it's for work or
family. The Today section are reminders that need to be addressed immediately, scheduled, or have a date attached. The All section is for viewing everything
all at once. The Flagged section is for your reminders that have a flag added to separate them out. If you are logged in with the same Apple Account on all

your devices, Reminders will sync across your devices so that your reminder list is the same on all of your devices.
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Add due dates
Manage your tasks with due dates. Add a due date to a reminder and Reminders alerts you when the deadline approaches.

Location-based reminders
Add a location to a reminder on your Mac, and receive a notification on your iPad, iPhone, or your Mac when you depart from or arrive at that location.

Subtasks
Every reminder can have subtasks. Indent reminders to turn them into subtasks of the reminder right above them.

Shared Reminder List
Share a list of Reminders with other iCloud users.

Retrieve Deleted Reminders
Recently Deleted list in Reminders lets you view and retrieve deleted reminders.

Move reminders on your Mac
You can move one or more reminders within a list or to another list. To select multiple reminders, you can Shift-click or Command-click to select the reminders
and then drag them to another list in the sidebar.

Multiple accounts
You can use other accounts for Reminders such as Google, Microsoft Exchange, Yahoo, AOL, and other CalDAV services. You can also create reminders that

appear only on your Mac.

&) d =+ Q
Practice
Creating a Reminder Reminders

& Collaboration

1.To create a reminder, click Add (+) in the upper right hand corner.
2. Type in: buy coffee for home.
3. The reminder shows on the list
4. Select the box to the left of the reminder to mark it as complete. @
5. Select Completed to look at the completed reminders.
Sorting Reminders and Creating Reminder Lists O Mail
1. To sort a Reminder, select a reminder list in the sidebar then go to View > Sort By and select either Q Messages
Manual, Due Date, Priority, Creation Date or Title. e
2.7To create a new Reminder list, click Add (+) in the lower left hand corner. Name the Field Private.
3. With Private selected, click Add (+) to create a reminder in your Private Reminders.
Add a reminder from another app
1. Launch Notes and create a note called Groceries. Enter Bread and Eggs to the Note.
2.Click Share button ((ﬁ) and select Reminders.
3.Send Copy, Select Private from Choose List, then Click Add.
4.Go to the Reminders app and you should see a Reminder in Private Reminders list called Groceries.
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Messages
The Messages app is for instant messaging. With Messages, you can text, video chat, or have audio chats with your friends or contacts.
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Including pictures in your messages
Drag image files to the area where you type your message. A small icon appears to indicate that the picture will be sent when you press Return. You can add

text before and after the picture.

Delivery receipts
With Messages delivery receipts, you know when your messages have been delivered.

Read receipts
You can let friends know that you've read their messages by turning on read receipts in Messages Settings. Messages informs your friends when you've read
their messages. You can have read receipts for individuals when selected in Details.

Conversations everywhere
Messages keeps your conversations up to date on all your devices. You can start a conversation on your Mac and pick up where you left off on your

iPhone or iPad.

Send aninline reply to a message
You can send an inline reply to a specific message in a conversation. Inline replies improve clarity and help keep conversations organized by creating new
threads. In a conversation, Control-click the message and choose Reply. Enter your message, then press Return.

Receive messages sent to your iPhone number
Add your iPhone number to your Apple Account in Messages so when someone sends a message to your iPhone, you can receive it and reply on your Mac.

Search messages
Use the search field to quickly search for images, items, and even text in an image.

Unsend or edit a message

You can unsend or edit recent messages, giving you the opportunity to fix a typo or pull back a message that you accidentally sent to the wrong person. Your
recipient sees that you unsent a message and your edit history. To unsend or edit messages, you must be using iMessage with macOS Sonoma or later, iOS
16 or later, or iPadOS 16.1 or later. If your recipients have devices with earlier versions, they receive follow-up messages with the preface “Edited to” and your
new message in quotation marks. SMS or MMS text messages can't be unsent or edited.

Practice

Edit a Message

You can edit a recently sent message up to five times within 15 minutes of sending it.
1.In the Message App on your Mac, select a conversation

2. Control-click the message, then choose Edit (or press Command-E).
3.Make any changes, then press Return..
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Stocks
If you have used the Stocks app from your iOS or iPadOS devices, then you may already be familiar with the Stocks app in Sequoia. The Stocks app has been
improved to make it easier to view stock quotes, interactive charts, and top business news from Apple News.
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Change the chart range

You can display historical price data for 1 day (1D), 1 week (1W), T month (1M), 3 months (3M), 6 months (6M), 1 year (1Y), 2 years (2Y), 5 years (5Y), 10 years
(10Y), or its entire history. Just select a ticker symbol in your watchlist and click an option in the range selector at the top of the chart. The time range you
choose is highlighted in the range selector. When you change the range, the range you select applies to all ticker symbols.

View chart data for a single pointin time

Choose a time range that includes the date you want to view in the chart. For example, if you want to view a date that occurred more than 30 days ago,
choose a time span of at least three months in the range selector. Move the pointer over the chart. If the range selector is set to 1D or 1W, the date, time, and
price are displayed above the chart. For other ranges, the date and price are displayed. As you move the pointer across the chart, the information is updated.

Tabs and Windows
You can view financial information in different ways by opening additional tabs and windows. You may want to use separate windows to compare stock charts
or use tabs to go over financial news.

Widget

You can use Stocks widget to keep track of price quotes and the performance of individual ticker symbols or watchlists. You can add Stocks widget to
Notification Center or your Mac desktop. There are two types of Stocks widgets: Symbol widgets and Watchlist widgets. You can customize your Stocks
widgets to display specific symbols or watchlists, and choose when your widgets will show relevant news stories, where available.

Yahoo Finance
On the bottom left-hand corner, click on Yahoo! Finance to take you to the Yahoo Finance page for more news.

Read the top business news of the day
You can read business news from Apple News right in the Stocks app on your Mac. If you're an Apple News+ subscriber, you also see Apple News+ content
in the Stocks app. Just click a ticker symbol in a watchlist, then click a headline to view the full story

Practice

Create and manage watchlists in Stocks on Mac

1. Click the name of the current watchlist at the top of the sidebar, then do one of the following:
- Choose New Watchlist.
- Choose Manage Watchlists, then click the Add Watchlist button.

2.Enter a name for the new watchlist.
3.Click Save.
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With Apple News, you can read interactive and engaging stories from a large variety of publications (or channels) across a broad range of topics, such as
Entertainment, Politics, Food, or Science. The more you read, the better Apple News gets at understanding your interests.
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Follow and unfollow channels and topics in News on Mac
You can follow your favorite publications (called channels) and topics (such as sports or travel) in Apple News. Channels and topics you follow are listed in the
sidebar, and their stories appear more often in Today and other feeds. If you change your mind later, it's easy to unfollow them.

Search
If you don't see the channel, topic, or story you wanted, you can search Apple News for it. You can also go to File and select Discover Channels to browse
channels and topics.

Apple News+

Apple News+ lets you enjoy hundreds of magazines, popular newspapers, and content from premium digital publishers directly in Apple News on your Mac.
You can subscribe to Apple News+ or to Apple One Premier, which includes Apple News+ and other Apple services. When you follow an Apple News+
magazine or newspaper, it's added to the sidebar for easy access.

Save stories in News
You can save stories in Apple News to read later. Stories that you recently saved are available even when you're not connected to the Internet. Click a story to
view it and then choose File > Save Story or press Command-S. When you are ready to read them, scroll to the bottom of the sidebar and click Saved Stories.

Practice
Explore channels, topics, and stories in News on Mac
1.In the News app on your Mac, click an item in the sidebar (if you don't see it, click the Sidebar button in the toolbar).

The sidebar can include:
- Today, which presents top stories selected by Apple News editors and the best stories from the channels and topics you follow.

- News+, which presents top stories selected by Apple News editors, the best stories for you from Apple News+ magazines, and the full catalog of
magazines to browse. You must subscribe to Apple News+ to read many of the stories.

- Coverage of special events curated by Apple News editors.
+ Channels and topics you follow.
- Channels and topics suggested by Siri or—if you chose not to have Siri suggest items—by your actions in Apple News, such as whether you follow or
block channels and topics, and love or dislike stories.
2.0n the right, scroll up or down to browse stories, then click a story to read it. While reading a story, you can browse other stories by using keyboard
shortcuts, or swiping right or left with two fingers on a trackpad or mouse. You can also watch videos, love or dislike a story, share it with others, or save it
toread later.
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Books
Choose from thousands of books and audiobooks to create your personal library. You can also have books read to you by listening to audiobooks.
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[QIITSVISI APPARENT
@®. ..

@ John Appleseed

Continue Reading
On the Sidebar, click Home. Under Continue, you will see all the books you have started to read. To remove a book from Continue, move the pointer towards
the right of the book, click Options (-+-) and select Remove.

Bookmark where you left off
On the page you want to bookmark, move the pointer to the top of the page, then click Bookmark ([). If you want to remove a bookmark, click the Bookmark
button. To see all the bookmarks in a book, click the Show Bookmarks ( [R])

Custom View

To change the appearance of the typeface or background, click Appearance (AA). To change the background color, click on the choices of color, you have
the option of white, sepia, gray or night. To change the typeface, choose from the font list below. To make the type bigger or smaller click the big "A”" to make it
larger and little "A" to make it smaller.

Show all Bookmarks Show Highlights and Notes Change Appearance Search in book
Table of CONtEN!S ey I Share m— I
] ] * s Bookmark
[ [ ) [ ] =B iMac Essentials D A Q lﬁj
Practice
Add a Book

1.In the Book app on your Mac, click Book Store.

2.Click the Menu Browse Selections and select Computers & Internet.

3.Scroll down to Free Apple User Guides and click MacBook Pro Essentials.

4.Click Get (you may have to sign in with your Apple Account.)

5. Click Read and confirm the book is loading the first page of the book.

6. Swipe to the next page with your mouse or trackpad. Optionally, move the pointer to the right of the page and click next page ())
7.Move the pointer towards the top to show the toolbar. Click Bookmark ([1) to save your place.

8. Select some text and then choose a color. Select another section of text and select Add Note. Enter “Important” and click Done.
9. Move the Pointer and click Show Highlights and Notes. Confirm you see what has been highlighted and see the Note “Important”
10. Click Show all Bookmarks ( [_A] ). Click on the bookmarked page.
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Freeform
Freeform is a blank canvas for drawings, text boxes, videos, PDFs, links, sticky notes, and other files. People can share boards over FaceTime for discussion,
and updates from all participants are synced to everyone in real time. NOTE: Freeform was released with macOS version 13.1 and greater.
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Tendler  Bran..oma

Collaborate

Add to Reading List
@ Airbrop

Device Manage
Services
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ment

Q mail

O Messages
Notes

N Open in News

Invite with Link

@ Journal
Reminders

@ shorteuts

® Copy

£ Edit Extensions..
Use a Device Management Services system to:

 give students restricted permissions over their own devices, including iPad setup, document

storage and approved apps.

- gives teachers the tools to manage their classrooms and keep students focused on their education.

180" SO RO "7 20 By

Collaboration
You can collaborate with others by sharing a Freeform board. Anyone you invite receives a link to open the board in the Freeform app. Before you begin, be
sure to enable Freeform in your iCloud settings. Click Share ([I]) and choose how you want to share the board (via Messages, Mail, AirDrop, etc).

Add Sticky Notes
Give feedback when you're collaborating on a Freeform board by adding comments in a sticky note. Click Sticky Note (&) from the toolbar and start entering
your note.

New in Freeform
Scenes
Scenes in Freeform enable you to organize content into distinct sections, which you can then save, label, and arrange according to your preferences.

Practice
Share a Freeform board
1.In Freeform, click a category in the sidebar, then double-click a board to open it.

2.Click Share (M) in the toolbar.

3. Click Share option, (>) choose who can view and make changes to the board (only people you invite, or anyone with the link).
4. Select how you want to share the board: Messages, Mail, AirDrop, etc...

5. After the person accepts the invitation and has the document open, start collaborating by adding content to the board.

6. Notice peoples' name appears as they add content to the board and you can edit or move things around.
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iPhone Mirroring
iPhone mirroring allows you to connect and use your iPhone from a nearby Mac while your iPhone remains locked. You may also have iPhone notifications
appear on your Mac.

DECEMBER . New York

| smTwrT s o
Liaa l36

789N

115 16 17 18 19 20 PS

n 2@y Mostly Cloudy

28 29 30 31 Hi39° Li3ae

College...7

23 42°

39all-day

Requirements

- Both devices have Wi-Fi and Bluetooth enabled.

- You're signed in to the same Apple Account on both devices.

- Both devices meet minimum system requirements for Handoff.

Setup

1. Open the iPhone Mirroring app and make sure your iPhone is nearby.

2.Enter your device passcode.

3.Choose one of the following:
« Ask Every Time: Receive a prompt for Touch ID or your device passcode each time you use iPhone Mirroring.
« Authenticate Automatically: Automatically connect to iPhone Mirroring without needing to authenticate.

Notifications
1.0n your iPhone, Go to Settings > Notifications. Banner Style
2.Choose an app, i.e. FaceTime.
3. Scroll down to Show on Mac.
4. Enable/Disable Notification for Show on Mac. Bacdes

Sounds

Show on Mac

Practice

Use Mouse or Trackpad to control your iPhone

After you have connected and are able to view your iPhone from the iPhone Mirroring App, perform the following:
+ Click on an app to open.

« Click on the Close bar to exit out of the app.
- Control-click or right click on an app to edit the Home screen. Share app, requires a passcode to open an App or remove an app.
- Swipe on the Mouse of trackpad to navigate to another page of your Home screen.

Edit Home
B

Screen

/" Rename

G’ Home

Ll
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Phone

Getting Started on macOS Tahoe

Apple’s Phone app on macOS Tahoe brings familiar iPhone calling features directly to Mac computers, letting users make and receive calls, check voicemail,
and manage recent conversations without reaching for their phone. The app seamlessly syncs with iPhone, supporting features like call history, contacts, and
continuity for handoff between devices. With a clean, native interface optimized for the desktop, it turns your Mac computer into a fully capable extension of

Apple's calling experience.

) New York
Filter the MW F Aan

call list 0:: f £1
ise78 00
12 18 1818 10 17

Incoming Call

Access the

O Missed

s ° Q
‘

%99

Show All

o
519 20 21 22 23 2 Clobdy Y Q search
25 26 27 28 29 30 31 Hi34e Li21®
v % Calls

Recents

+1(631)4 1400
Qo —

(631) 50
2 Commack, NY

Charles
@ o s2su
+1(516) 566-0135

Yesterday

n31PM

Yesterday

Setup
In order to use the Phone app, you have to have the following:
+ Your Mac computer and iPhone have Wi-Fiturned on and connected to the same network.
- Both devices are signed in to the same Apple Account.
« Set up your iPhone to allow phone calls on your Mac computer.
- You are signed into FaceTime and have your phone number turned on in FaceTime settings on both devices.

Make a call

Click Keypad (), then do one of the following:
- Enter the number using the keypad: If you make a mistake, click Delete (€Q).
- On your recent list, click the Call button (%) on the right of the name or number.
« Click on one of your favorites.

Receive a call
When someone calls you, a notification appears in the top right of your screen. You may do one of the following:
- Answer the call: Click Answer (®).
- Decline the call: Click Decline (@).
- Send the call directly to voicemail: Click Live Voicemail (@).
- Reply to the caller using Messages: Click Decline with Message(©).

Voicemail

keypad

Use the Phone app on Mac to play, delete, or share voicemail messages with ease. When Apple Intelligence is enabled, voicemail summaries appear beneath

each missed call, letting you quickly see who contacted you and what they said.

Jeannine
m B Janine is having email problems; Rich is requested to 91125 N
help; call number is provided

Lucille
@ @S Computer is not working; advice is requested; it may be ~ 9/9/25 €\
time for a new machine
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Shortcuts

A shortcut is a quick way to get one or more tasks done with your apps. The Shortcuts app lets you create your own shortcuts with multiple steps. Mix and
match actions to create shortcuts that interact with the apps and content on your Apple devices, as well as with content and services on the internet. Each
shortcut is made up of one or more actions.

8 Q search

2 Gallery
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® =
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T street Address
@) Share Sheet 1 i= All Actions $ scripting
Line 1: 80 Orville Drive =

X B Controls © Device
@ Quick Actions 2 Line 2: Text
= 7 Location 7 Media

Menu Bar 6 ity i
! <q Gity; | Bohemia @ Sharing D Documents

F State: New York s

Starter Shortcuts. 1 Postal Code: 11716
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Starter Shortcuts 2

]
B
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© Send Message
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@ Play Music

Comment
::":: =20 £ Show Content

(%) Show Alert
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8 count
© Choose from Menu
it
@ Repeat
Repeat with Each

Browse the Gallery/Add to your Shortcuts

In the Sidebar, click Gallery. The Gallery contains some pre-made shortcuts for you to use. For example, go to the Photography section and click on Add (+)
for remove Background from Portrait. Click All Shortcuts and confirm the shortcut is ready for you to use. Double-click on the shortcut to view what actions
are used for the shortcut.

Menu Bar
To add a shortcut to the Menu Bar, double-click a shortcut, on the top-right, click Info (®). Then select the checkbox for Pin in Menu Bar. In the Menu Bar, click
the shortcut (&) menu and select the shortcut.

Practice

Enable a shortcut to run in other apps on Mac

To allow a shortcut to run from within other apps, you need to either add it to the share sheet or set the shortcut as a quick action.
1. Double-click a shortcut, then on the top-right, click Info (®).

2.Click Details, then select the checkbox for Show in Share Sheet and Use as Quick Action & Services Menu.
3.Close the Shortcut.

4. Launch Safari.

5. Click the Safari Menu and Select Services.

6. Confirm Shortcuts section appears with the shortcut in the section (fig. 100-A.)

7.While still in Safari, click Share (ﬂ]) and select Shortcuts. - . . .

8. Confirm a window appears with the Shortcut (fig. 100-B.) o oousal ©@C 06 o o
Safari Extensions...

9. Select the shortcut and click done. =] I

Settings. G shortcut for macOS - G

Privacy Report...
Settings for youtube.com...

TR W
Development
B Activity Monitor
B Allocations & Leaks
B File Activity
. H SystemTrace
~ Time Profile Active Application
| Time Profile App Under Mouse
~ Time Profile Entire System
ggle Instruments Recordin

Clear History..

[ NoN ] H shortcuts

Hide Safari

[al=] Tile Last 4 Windows Hide Others.
Gy © actions Show All

Quit Safari

9
Shortcuts
Tile Last 4 Windows

Turn Text Into Audio

=] E =] Cancel Done

s rvices Settings...

fig. 100-B fig. 100-A
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Journal

Apple Journal on Mac is a free, private, and minimalist journaling app that syncs with your iPhone and iPad. You can add photos, music, drawings, and audio
recordings to enhance your life experience.

IANUARY New York Create an
LD R, 3 3 o Travel entry for a

12 e €
8Os 6780 neighborhood of Oceanside. Jjournal
1213 14 15 16 1 o
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Create
multiple
Journals

Journals

All Entries

3¢ Journal

& Baseball Stadiums

©O Comic Con

A% Travel
2 Birthdays and Anni.. 2 San Diego Padres game Sept 10, 2025
s Padres Game - Padres loses to Cincinnati Reds on playoff Run. Went with friend Ed. Padres List of
@ Lfe O had a very nice museum on San Diego Athletes. | found out Chris Chambliss was from the or
7 Restaurants 2 Area, Oceanside to be specific. entries in a
Journal
Las Vegas
Going to Las Vegas for the Consumer Electronics Show (CES). Looking forward to see what
new technology coming for us in 2026.
) - o =
180 SO ECOOBE 7 v A
Create ajournal entry
1. Click Journal on the side bar.
2.Click Add (®). <7
3. Start writing or click the Add Drawing (®) to add a drawing. Add from Photo Library | ] ] | Add Audlo recording
4. After you finish your entry, click Save (©). Add from Camera Add Location
Edit an entry
1. Select an entry you want to edit.. The More menu
. . located on the
2.Click More (-*+), then choose Edit bottom right of -
3.Do the following: an entry T
. . ookmar}
- Click on the date to change it to another date.
5 Choose Journals  d
- Change or remove the title. )
. Print
- Modiify the copy.
4.Click Save (). Delete
Create more journals
You can create multiple journals to organize entries for different topics.
1.Click Add (®) in the side bar above All Entries. o
. . Choose Journals
2.Enter a name for the new journal and select a color. Click Done. ]
3. You can reorder journals by dragging a selected journal up or down. % Journal
|
4.You may also add an entry to multiple journals. Click More (-++) and B rravel
select Choose Journals.
. 4 Birthdays

Protect your journals & Baseball Stadiums
Your entries and any changes you make to them, appear on your iPhone, iPad, and

Mac (where you're signed in to the same Apple Account). You can keep your journal private
so0 only you can access it with your login password or Touch ID. Just go to Journal > Settings,

click General, and enable Lock Journal.

E/ Comic Cons

Work

L

Select multiple journals for an enrty
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Additional macOS Tools

FaceTime
Make video and audio calls using Facelime on your Mac using your Apple Account or mobile phone #. Requires an internet connection to use. Can use your
iPhone to make calls on your Mac when your iPhone is nearby, on Wi-Fi, and signed in to iCloud and FaceTime using the same Apple Account.

Maps

Maps gives you directions to or from a location, including current traffic conditions. With Maps you can locate addresses, businesses, landmarks and more.
Some locations will show contact information, photos, and reviews. After you get directions, you can use the Share button to send the map and directions to
your iOS device. You have the option of getting directions for driving, walking or transit. Transit includes schedules to help you decide your best way to get
where you are going.

TextEdit

Create and edit plain text, HTML, and rich text formatted documents. You can add images, annotate the images by drawing on them. Formatting is not
available in plain text documents. The document would need to be converted to rich text format for formatting options to be available. Text edit documents
can be stored in iCloud drive and accessed on the Web or any device logged into iCloud with the same Apple Account.

QuickTime Player

From its inception in 1991, QuickTime has stood at the forefront of video technologies — first with software-based video, then with Internet video. You can
play video and audio files in QuickTime Player. Quicktime Player supports closed captioning and subtitles. QuickTime Player can also be used to create, and
then edit, your own screen, movie, or audio-only recordings, which can then be shared right from the App.

Photos

From a camera or iOS device, you can easily and quickly import your photos right into Photos, which will automatically include time and place. Full-featured
editing options enable you to crop, straighten, remove red-eye or blemishes, improve light and color, and more. With iCloud Photo Library, all of your photos
and videos from all devices logged in to iCloud with the same Apple Account will appear in Photos on your Mac.

iMovie

Create movies and trailers at up to 4K resolution. Use the video filters, fix shaky video, and create realistic green-screen effects. Comes with iMovie Theater to
watch finished movies and trailers on all devices logged into iCloud with the same Apple Account.

Music
The Music app on macOS (preceded by the iTunes) can be used to purchase, stream, download, and organize digital multimedia.

Calculator
App for performing basic, advanced, or programmer calculations. Convert values, round results, enter complete equations using Reverse Polish Notation.

Disk Utility
Used to manage internal and external storage devices. You can divide a storage device into sections (called partitions), check and repair errors on your disks
and volumes, and eject or mount disks.

Voice Memos
Voice Memos lets you create recordings with your Mac's built-in microphone, wired headphones, AirPods or another Bluetooth headset.

Home
You can easily and securely control the products that you use in your home from your iPhone, iPad, iPod touch, Apple Watch, or Mac. Turn on lights, adjust the
thermostat, or set a scene to control both.

Screenshot

You can take screenshots or recordings of the screen on your Mac using Screenshot or keyboard shortcuts (See page 124 for keyboard shortcuts).
Screenshot provides a panel of tools that let you easily take screenshots and screen recordings, with options to control what you capture. For example, you
can set a timer delay or include the pointer or clicks.

Terminal
Access the complete UNIX operating system in macOS.

TV
Apple’'s TV app brings together movies, shows, live sports, and Apple TV+ in one place, making it easy to watch, track, and discover what to stream next
across all your devices.

Activity Monitor
Get details about the processor, apps, disks, memory, and network activity on your Mac.

Stickies
Keep notes, lists, and even pictures in sticky notes on your desktop. You see the notes whenever the Stickies app on your Mac is open.
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Apple Account & iCloud

Apple created a unique way for connecting your data, your apps and your media on all your
Apple devices with iCloud by using a unique identifier called an Apple Account. You can use
an email address of your own or one created from Apple. Using Apple Account and iCloud,
you are able to quickly set up a new device with your email, contacts, calendars, photos,
messages, reminders, Safari, notes, keychain, music, videos, Books, apps and more.

What You'll Learn

- Apple Account

- Change your Apple Account

- iCloud

- iCloud on the Web

- iCloud Features - Content, iCloud Drive
- Review
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Apple Account

Your Apple Account is the personal account you use to access Apple services like the App Store, iTunes Store, iCloud, iMessage, the Apple Online Store,
FaceTime, and more. Use the same Apple Account everywhere you sign in to make sure that all your Apple services and devices work together seamlessly
and you can access your personal content from all your devices. You can even use your Apple Account for your login when you set up your user on a new Mac
computer. Go to https://account.apple.com to create one.

‘ Safari  File Edit

o Lpersonalv < account.apple.com
JANUARY
smT
@  stre  Mac  iPad  iPhone  Watch  Vision  AiPods  TV&Home  Entertainment  Accessories  Support QU
S .
" 12 1 Apple Account Signin  Create Your Apple Account
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25 26 2

One account for everything Apple.

A single Apple Account and password gives you access to all Apple services.
Sign in to manage your account.

Sign In

BO OB " ¥ AN®

Creating an Apple Account

There are several ways to create an Apple Account. You can create your Apple Account when you turn on your Mac for the first time as part of the startup
process. You can go to https://account.apple.com and select Create Your Apple Account in the upper right. If you want to get a free iCloud email address, click
Get a free iCloud email address, when filling out your application for an Apple Account.

| forgot my password for my Apple Account. How do | retrieve it?
If you forget your password to your Apple Account, you can go to this URL to reset your password:

https://iforgot.apple.com/password/verify/appleid

How do I signin?

Any time you set up a new device or access an Apple service, you'll be asked to sign in with your Apple Account and password. After you sign in, you'll gain
access to the service and all the personal information in your account residing in iCloud. You can sign in with Your Apple Account in the following locations of
your Mac:

- Select Apple menu > System Settings > Apple Account
- Open Music, then select Store > Sign In
- Open App Store, then select Store > Sign In
- Open Mail, then select Mail > Settings > Accounts
- Open Calendar, then select Calendar > Settings > Accounts
- Open FaceTime, then select FaceTime > Settings > General
- Open Messages, then select Messages > Settings > Accounts
Family Sharing
Family Sharing makes it easy for up to six people in your family to share each other's Music, Books, and App Store purchases without sharing accounts. You

can pay for family purchases with the same credit card and approve children’s spending right from a parent’s device. You may also share photos, a family
calendar, and more to help keep everyone connected. To set up Family Sharing:

1.Go to System Settings > iCloud > Family.
2. Click Add Member. A new window will open letting you add a family member's email address or Apple Account or you can create an Apple Account for a
child who doesn't have an account yet.
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Secure your Apple Account

In most cases, your Apple Account is also the primary email address of your Apple Account account. You can change your Apple Account to any other email
address you control, as long as it's not already in use as an Apple Account or as an alternate email address. If your email address ends with @icloud.com, @
me.com or @mac.com, it's already your Apple Account.
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Change Password
Go to System Settings > Apple Account > Sign-In & Security, click Change Password. When changing password, make sure to use a combination of upper
case, lower case, numbers and special characters with no less than 9 characters for your new password.

Trusted Phone Numbers
You have the option, (recommended) to add a second trusted phone number. This enables you to be reached with notifications from Apple regarding your
Apple Account when you don't have access to your primary phone number for password resets and two-step verification.

Two-Factor Authentication

Because your password is no longer sufficient to secure your account, two-factor authentication improves the security of your Apple Account and

all the personal information you store with Apple. With two-factor authentication (2FA), your account can only be accessed on devices you trust, such as
your iPhone, iPad, Apple Watch, or Mac. When you sign in to a new device for the first time, you'll need to provide two pieces of information: your password
and the six-digit verification code. By entering the code, you're verifying that you trust the new device. Once two-factor authentication is turned on, you
can no longer turn it off.

Legacy Contact
A Legacy Contact is someone you choose to have access to the data in your Apple account after your death. Your Legacy Contact can be anyone you
choose, and you can designate more than one Legacy Contact. They don't even need an Apple Account or an Apple device. To file an access request after
you pass away, they'll just need:

- The access key that you generate when you choose them as your contact

- Your death certificate

Account Recovery
If you lose access to your account, a recovery method can help you get your account and data back. Your device passcodes can be used to recover
end-to-end encrypted data. If you forget your passcodes, you'll need a recovery contact or recovery key.

Security Keys

A security key provides extra protection against attacks such as phishing or social engineering scams. Using a security key with two-factor authentication
will help strengthen the login process and help prevent your second authentication factor from being intercepted or requested by an attacker. For more
information to setup a security key for your Apple Account, please go to:

https://hcsonline.com/support/white-papers/how-to-configure-security-keys-for-apple-id

Practice
Add a second number to your Apple Account
If you have a second line on your phone, you can add multiple phone numbers to your Apple Account.
1.Go to System Settings > Apple Account > Sign-In & Security.
2. Scroll to Two Factor Authentication > Trusted Phone Numbers. Click Add (+).
3. Select your region and your second phone number including your area code.
4.Choose how you want to verify the phone number, Text message or Phone call.
5. Enter the six-digit verification code to add your number.
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iCloud

iCloud connects you and your Apple Devices in all kinds of ways. It helps keep the latest versions of your documents created with iCloud apps, your photos,
notes, contact, calendars, reminders, Safari Bookmarks, and Keychain all in sync and up to date. iCloud can also be used to share photos, calendars, locations
and more with family and friends. You can use iCloud to locate a lost device as well.
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iCloud Features:
- Same content can be found on all your Macs and iOS devices, logged in with the same Apple Account, with an Internet connection.
- iCloud Drive Safely store and organize all kinds of documents in iCloud. You can access these documents from all your Macs and iOS devices sharing
the same Apple Account.

- Photos iCloud Photo Library lets you store your entire library of photos and videos in iCloud. You can create a shared Photo Library to share with family
andjor friends. iCloud Photo Sharing can be used to share albums of photos and videos with only the people you choose. Photo Stream is where iCloud
stores all photos recently added to your Mac and other Apple devices.

+ Mail, Contacts, Calendar, Notes, and Reminders Keep all of these up to date and in sync with iCloud.

- Safari See the webpages you have open on your Mac and iOS devices. Read articles from your Reading List, even when you're offline. Plus, use the same
bookmarks on your iOS devices, Mac, and Windows computer.

- iCloud Keychain Keep your passwords, credit card information and more up to date and the same for all your Macs and Apple Devices.

« Find My Find your missing devices by logging into iCloud.com with your iCloud account.

- Family Sharing Makes it easy for up to six people in your family to share each other's Music, Books, iCloud storage, and App Store purchases without
sharing one Apple Account account. You can pay for family purchases with the same credit card and approve kids' spending right from a parent’s device.
You may also share photos, a family calendar, and more to help keep everyone connected.

- Pages, Numbers, and Keynote Use these apps to store documents on iCloud Drive. These documents will be accessible on all your macs and iOS
devices that work with iCloud Drive.

What is iCloud+?
iCloud+ is a premium subscription that expands your iCloud services. You get extra features such as:
- iCloud Private Relay Hide your IP address and browsing activity in Safari and protect your unencrypted internet traffic, without affecting browsing
performance.
- Hide My Email Create unique, random email addresses that forward to your personal inbox so you can receive email without having to share your
personal email address.
- HomeKit Secure Video Connect your home security cameras in the Home app to record your footage and view it from anywhere, while keeping it private
and secure.
+ Custom Email Domain Personalize your iCloud Mail email address with a custom domain name. You can invite friends and family members to use the
same domain with their iCloud Mail accounts.
« iCloud+ includes additional iCloud storage. You can choose an iCloud+ plan with 50 GB, 200 GB, or 2 TB of storage.
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Change Storage Plan...

Backups

iCloud Drive
701 M8

Mail
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]
iCloud Photos
L e

OTHERS

R shortcuts

Tips

iCloud for Windows

After setting up your iCloud account, you may go to a Windows machine and install iCloud for Windows from http://www.icloud.com/icloudcontrolpanel. After
installation, just sign In with your Apple Account.

NOTE: iCloud for Windows requires Windows versions 10. or later For more information about system features and requirements, refer to this support
article: https://support.apple.com/en-us/HT204230

Included in your free iCloud?
Free email account with 5 GB of storage for your email, iCloud app documents, photos, and iOS device backups. Purchased content doesn't count for space
used.

What is Stored on my iCloud Account?
You can see what you have stored in your iCloud account by clicking on Manage, found above the iCloud storage graph. On the left column, you see what
services are stored on your iCloud account. Click on one of the services, such as Photos, to get more details on how photos is utilizing iCloud storage.

How do | add more space to my iCloud account?
As you start running out of space for Your iCloud account, you can subscribe to add more storage. Above the iCloud storage graph, click Manage. Click
Change Storage Plan and choose a plan that fits your needs.

Advanced Data Protection for iCloud

Advanced Data Protection for iCloud is an optional setting that offers Apple's highest level of cloud data security. If you choose to enable Advanced Data
Protection, the majority of your iCloud data, including iCloud Backup, Photos, Notes, is protected using end-to-end encryption. Before you turn on Advanced
Data Protection, you'll be guided to set up at least one alternative recovery method: a recovery contact or a recovery key.

Practice
Sign into your iCloud account with your Apple Account on your Mac.
1.Go to Apple menu > System Settings, iCloud.

2.Enter your Apple Account and the password associated with the Apple Account.

3. Select the check boxes for the Apps and services you would like to use with iCloud.
4. Click iCloud Drive. Click Options.

5. See what you have enabled for iCloud Drive.
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iCloud on the Web

Don't have access to your Mac, your PC or an iOS device? You can still access your iCloud data on the web by going to iCloud.com. You will find all the iCloud
apps you use along with all your current data. All edits will push to your Mac, PC and iOS devices when they connect to the internet.

Tips
Web-Only access to iCloud

icloud.com

‘ i )
Photos Drive
el &

iCloud N NTbers

Notes

Find My

John

jappleseed.personal@icloud.com

Photos Mail g
@ Library - 29 Photos @ Inbox - 85 unread me...

® Backblaze Team 12/31/25
Your Backblaze Trial Ends Today

® Backblaze Team 12/29/25
3 Days Left in Your Backblaze Trial!

® Backblaze Team 12/26/25
Access Your Files On the Go With Backbla.

®

Free level of iCloud for anyone including people that don't own Apple devices. You get 1 GB of free storage, access to Web versions of Pages, Numbers, and

Keynote.
Browsers supported

iCloud.com can be accessed on recent versions of Safari, Firefox, Chrome, Edge, and Opera.

Cannot be upgraded.

Web only cannot be upgraded. To obtain more storage and access to all iCloud features, you need a Mac or iOS device.

Practice

Sign into your iCloud account with your Apple Account using Safari
1. Launch Safari from your Dock by clicking on the Safari icon.

2. Type icloud.com in the Smart Search Field.

3.Sign into iCloud by typing your Apple Account and your password.

4. Click the Arrow in a circle pointing to your right.

5. Click on the different apps and notice how they are like the Apps on your Mac and how they are different.
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iCloud+ Features

Getting Started on macOS Tahoe

iCloud+ has some enhanced features to better protect your privacy from prying eyes. iCloud+ expands your iCloud service with premium features like iCloud
Private Relay, Hide My Email, HomeKit Secure Video support, and all the storage you need for your data.

icloud.com

.

Photos

= O

Mail Contacts

|

Invites

Calendar

Richard |
rgoon@mac.com ® N

iCloud+

Reminders Numbers

Photos
@ Library - 8,719 Photos, 92 Videos

= P

® Apple
Your Apple

® Team Sna
Amanda

® Supporta
Product Inf

iCloud Private Relay

Apps

@

Mail Contacts

.
[ :

Drive

Calendar

Notes  Reminders

Pages  Numbers  Keynote

iCloud+ Features

% Hide My Email

(% Custom Email Domain
@ Private Relay
Homekit Secure Video
© Apple Invites

More

& Your iCloud Storage
@ Your iCloud Plan

® Data Recovery

@ iCloud User Guide 7

L

Photos

(8

Invites

lzoee

Find My

iCloud Private Relay helps prevent websites and network providers from getting a detailed profile about you. When Private Relay is turned on, the traffic
leaving your device is encrypted and sent through two separate internet relays. This prevents websites from seeing your IP address and location and network
providers from collecting your browsing activity. Private Relay maintains your general location, which allows Safari to show you localized content and results.
To Enable iCloud Private Relay, go to System Settings > Apple Account > iCloud. Click Private Relay and enable the service.

Hide My Email

Keep your personal email address private by creating unique, random addresses that forward to
your personal inbox and can be deleted at any time. When you reply to a message, your personal
email address remains private. The message appears as if it was sent from the Hide My Email

address. You can create as many addresses as you need. You can add a label or note to an address

to help you remember how you've used it, and you can also deactivate or delete addresses you no
longer use. You can access your list of email aliases through System Settings > Apple Account >
iCloud. Click Hide My Email.

HomeKit Secure Video

You can add your home security cameras in the Home app to record your footage and view it from
anywhere. It's all end-to-end encrypted, and none of the video counts toward your iCloud storage.
You can access HomeKit Secure Video on your iPhone, iPad, iPod touch, Mac, or Apple TV. The
video is privately analyzed by your Home hub using on-device intelligence to determine if people,
pets, or cars are present. You can view the last 10 days of activity in the Home app. You can invite
other people who use iCloud to share control of your home and view video from your cameras in
the Home app. To enable Home, go to System Settings > Apple Account > iCloud > Show More
Apps. Locate Home in the list. For more information please visit:

https://support.apple.com/guide/home/cameras-hmeb54708fc8/mac

Custom Email Domain for iCloud Mail

Hide My Email

Q Search

ChatGPT

classy.org
Cloudflare Dashboard
efmfeedback.com
elizabethwarren.com
estatesales.org
eventbrite.com
Evernote
everydaywinner.com
gearlaunch.com
Grammarly

Houzz

ipsosinteractive.com

+ ov

Keep your personal email address private by creating a unique, random address that forwards to
your personal inbox and can be deleted at any time.

ChatGPT
Sign in with Apple

You created this email on July 24, 2024. Learn more.

Hide My Email
poty 1@privaterelay.appleid.com

Copy Email

Forward To

r¢ m

©

Manage Settings

You can add a custom email domain you already own to iCloud using your iPhone, iPad, Mac computer, Windows computer or on iCloud.com. After you set up
a custom email domain, you can send and receive mail from that domain on your iPhone, iPad, iPod touch, Mac, and Windows computer, and on iCloud.com.
Make sure you're signed in with the same Apple Account on each device. If you have devices where you're not signed in with your Apple Account or that have
the Mail feature turned off, you won't be able to see your mail on those devices. For more information on setting up a custom email domain, please go to:

https://support.apple.com/guide/ficloud/set-up-a-custom-email-domain-mm0e4339d289/1.0/icloud/1.0
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Review

Below is a list of terms from this chapter. See how many you know. The page number for each of these terms are listed for your reference.

Account Recovery

Apple Account Page 112
iCloud Page 114
Hide My Email Page 114

Page 113
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Complete list of Apps and Utilities in macOS

Applications

App Store
Update your software and add new software to your Mac

Apps
Organize your apps into categories for easy access

Journal
Capture and reflect on everyday moments and special events using
photos, videos, audio recordings, locations, your state of mind, and more.

Automator
Automate frequent tasks

Keynote
Create presentations to wow your audience

Books
Best sellers, the Classics and Textbooks all right on your Mac

Mail
Send, receive and manage your email for as many accounts as you have

Calendar
Schedule and track appointments

Maps
Directions to and from any location

Calculator
Simple and complex calculations

Messages
Easy way to stay in touch with your friends and colleagues

Chess
Challenge yourself to a game

Mission Control
A bird's-eye view of all your open windows, desktop spaces, and any
apps in full screen or Split View

Clock
See the time in cities around the world

Music
Organize and play your music

Contacts
All you contacts at your fingertips

Dictionary
Words at your fingertips

News
Apple News collects and organizes stories from a wide range of
publications and topics

FaceTime
Video and Audio calls with your Apple Account

Notes
Jot down thoughts or make a list. Easy and convenient. Can sync to all
your apple devices

Find My
Keep track of family, friends and devices

Numbers
Spreadsheets by design like you've never seen them before

Finder
Browse and organize your files on Mac and iCloud

Pages
Word Processing and page layout all in one app

Font Book
Letter-perfect type management

Passwords
The Passwords app securely manages your passwords.

Freeform
A digital whiteboard for ideas and collaboration.

Phone
Allows you to make and recieve cellular from your Mac.

GarageBand
A music creation studio inside your Mac

Photo Booth
Take snapshots and videos with fun effects.

Games
A central hub for games you enjoy and the friends you play with

Photos
Enjoy and share your photos

Home
Use the Home app on your Mac to control and automate Homekit-
enabled accessories.

Podcasts
Organize and play your subscribed podcasts

Image Capture
Capture images from your devices

Preview
View and work with PDFs

Image Playground
Create fun, custom images instantly using Al on your device

QuickTime Player
Crystal-clear video playback

iMovie
A video editing app for users with little or no video editing experience

Reminders
Create To Dos and reminders

iPhone Mirroring
Allows you to control your iPhone from your Mac

Safari
Web browser
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Getting Started on macOS Tahoe

Utilities Folder

Siri
Your personal assistant

Activity Monitor
Track processor and memory usage.

Stickies AirPort Utility
Stick to the point. Wireless setup made easy.
Stocks Audio MIDI Setup

Use the Stocks app to view ticker symbols and find business news.

Control all your audio devices with a single utility.

System Settings Bluetooth File Exchange
Customize your system Share data wirelessly.
TextEdit ColorSync Utility

Simple word processing

Color management system.

Time Machine
Automatic backup for your Mac

Console
Track system messages.

Tips

A quick guide and suggestions to help you get the most out of macOS

Sequoia

Digital Color Meter
Exact color values when you need them.

TV
Organize and play your videos

Disk Utility
One stop for managing disks.

Voice Memos
Record voice memos from your Mac.

Grapher
Explore equations visually on your Mac.

Weather
Find out about the weather locally and other locations

Magnifier
use your Mac and another connected camera to zoom in on your
surroundings.

Migration Assistant
New Mac setup, simplified.

Print Center
Manage print jobs from connected printer.

Screen Sharing
View and control the screen of another Mac on your network.

Screenshot
Take screenshots or screen recordings.

Script Editor
Automate tasks with AppleScript.

System Information
Details about your hardware, network, and software on your Mac

Terminal
Use UNIX commands to get more from your Mac.

VoiceOver Utility
Full featured screen reader
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Special Characters
The following is a list of the most often-used special characters. Remember, hold down the “modifier keys," the ones that don't do anything by
themselves, then tap the character key just once.

Character Key combination = Name

" Option [ opening double quote
" Option Shift [ closing double quote
! Option] opening single quote
! Option shift ] closing single quote; apostrophe
- Option Hyphen endash
— Option Shift Hyphen | em dash
Option;; ellipsis
Option 8 bullet
fi Option Shift 5 ligature of fand i
fl Option Shift 6 ligature of f and |
© Optiong copyright symbol
™ Option 2 Trademark
® Optionr Register Trademark
° Option Shift 8 degree symbol
¢ Option 4 cents symbol
€ Option Shift 2 Euro symbol
/ Option Shift 1 fraction bar
Option 1 inverted exclamation mark
¢ Option Shift / inverted question mark
Acute Press Let Go, then press
Optione Spacebar
a Option e a
A Optione Shift a
é Optione e
E Optione Shifte
i Option e i
i Optione Shift i
Optione o)
o} Optione Shifto
U Optione u
U Optione Shift u
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Circumflex Press Let Go, then press

" Optioni Spacebar

a Optioni a

A Option i Shift a

é Option i e

E Option i Shift e

7 Option i i

1 Option i Shift i

(0] Optionii o)

o} Optionii Shift o

[0} Optionii u

U Option i Shiftu

Diaeresis Press Let Go, then press
Optionu Spacebar

a Optionu a

A Option u Shifta

é Optionu e

E Option u Shifte

7 Optionu i

i Option u Shift |
Optionu o)

o) Option u Shifto

U Optionu u

U] Option u Shift u

y Optionu y

Tilde Press Let Go, then press
- Optionn Spacebar
a Optionn a
A Optionn Shift a
fi Option n n
N Optionn Shift n
o] Option n o)
o} Optionn Shifto
Grave Press Let Go, then press
Option” Spacebar
a Option® a
A Option” Shift a
e Option” e
E Option" Shifte
i Option” i
i Option" Shift i
0 Option* o)
6] Option" Shifto
u Option” u
U Option” Shift u
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macOS Keyboard Shortcuts

You can make your work go faster by using these macOS keyboard shortcuts that work in the Finder and many other macOS apps..

Command Keyboard Shortcut

Windows

Add Selected Item to Sidebar | Shift+Option+T

Close All Windows Option+Command+W
Close Window Command+W

Copy Command+C

Cut Command+X
Duplicate Command+D

Eject selected disk or volume | Command-+E

Empty Trash Shift+Command+Delete
Find Command+F

Find Again Command+G

Force Quit Command+Option+Esc
Get Info (on selected itemor | Command-+|

items)

Go to All My Files Shift+Command-+F
Go to Applications Folder Shift+Command+A
Go to Desktop Shift+Command+D
Go to Home Folder Shift+Command+H
Help Shift+Command-+?
Hide Current Application Command-+H

Log Out Current User Shift+Command+Q
Make Alias Command-+L
Minimize Window Command+M

Mission Control: All Windows | Control+Up Arrow
Mission Control: Application Control+Down Arrow

Mission Control: Show

F11 (fn+F11 on laptops)

Desktop

Move to Trash Command-+Delete
Empty Trash Shift+Command-+Delete
New Finder Window Command+N

New Folder Shift+Command+N
New Smart Folder Option+Command+N
Open Command+O

Open Inspector Option+Command-+l

Open a new tab

Command + T

Open preferences for the
front app

Command+ Commal,)
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Command Keyboard Shortcut

Paste Command+V

Print Command+P

Quick Look (at selected item) | Command+Y or Spacebar
Quit Command+Q

Save Command+S

Screen Shot Shift+Command+3
Screen Shot Selection Shift+Command+4
Screen Shot App Shift+Command+5
Select Al Command+A

Show Character Viewer - Control +Command+Spacebar
shows emoji

Show Original (of selected Command+R

alias)

Show View Options Command+J

Show/Hide Sidebar Option+Command+S
Show/Hide Dock Option+Command+D
Show/Hide Status Bar Command+/

Show/Hide Tab Bar Shift+Command-+T
Show/Hide Toolbar Option+Command+T
Spotlight Command+Space Bar

Spotlight search from the
Finder

Command+Option+Space Bar

Switch Apps Command+Tab

Switch Windows Shift+Command-+Tilde(~)

Turn VoiceOver On/Off Command+F5 (fn+F5 on
laptops)

Turn Zoom On/Off Option+Command+8

Undo Command+Z

Use an app in full screen

Control+Command+F

View Window as Icons Command+1

View Window as List Command+2
View Window as Columns Command+3
View Window as Cover Flow | Command+4




macOS and Windows Keyboard Equivalents

Getting Started on macOS Tahoe

Are you an macOS user who has to use Windows at work? Are you a former Windows user new to the Mac platform? As you've

probably surmised, there are key differences between the general operation of the two Operating Systems. Here are some of the

common Mac/Windows keyboard equivalents.

Function macOS Windows
Close dialog without any action Esc Esc
Contextual Menus Control + Click Right-Click

Copy afile Option + drag icon Control + drag icon

Create an alias/shortcut Command + M Right Click and choose
create shortcut

Create an alias/shortcut in a specific location | Command + Option and drag Alt + drag

[tem'’s Info or Properties Command + | Alt + Enter

Move a file

Drag icon to location

Shift + drag icon

Select additional items without deselecting
previously selected items

Shift + Click on items

Control + Click on items

Select Al Command + A Control + A
Send to Trash/Recycle Bin Command + Delete Delete
Startup with Extensions Off/Safe Mode Shift F8

Switch to next active application Command + Tab Alt + Tab
Cut to clipboard Command + X Control + X
Copy to clipboard Command + C Control + C
Paste from clipboard Command +V Control +V
Undo Command + Z Control + Z

Quit a frozen program

Command + Option + Esc

Control + Alt + Del

Quit/Close a program

Command + Q

Alt + F4

Screen capture to clipboard

Command + Control + Shift + 3

Print Screen

Active window to clipboard

Command + Control + Shift + 4 + CapsLock and click

Alt + Print Screen

Create a picture of a portion of your screento | Command + Control + Shift + 4 None
clipboard

Create a picture of a portion of your screen Command + Shift + 4 None
to disk

Create a picture of a specific window to disk | Command + Shift + 4 + CapsLock and click None
Screen shot to disk Command + Shift + 3 None
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System Settings
On first launch of System Settings, you will see a sidebar on the left containing all of the customizable settings of macOS. Click on any setting listed to access
the relevant setting. The General setting is selected by default when System Settings is opened.

[ 2N ) <

Use search to
— Q Search

find a setting
@ John Appleseed

Apple Account

General
Wi-Fi Manage your overall setup and preferences for Mac, such as software
updates, device language, AirDrop, and more.
Bluetooth
Network g
About

Q Battery

@ Software Update >

G Storage >
Accessibility
Appearance & AppleCare & Warranty
@ Menu Bar
3 Apple Intelligence & Siri © AirDrop & Handoff
Desktop & Dock

& AutoFill & Passwords >
a Displays
Spotlight Date & Time >
Wallpaper Language & Region
0 Notifications e Login Items & Extensions >
o Sound
. Sharing >
Focus
Screen Time e Startup Disk

i i >
g g a— @ Time Machine
Privacy & Securi

0 J Y Device Management >
) Touch ID & Password
e Users & Groups Transfer or Reset

Search in System Settings If you're not sure exactly what you're looking for, use the built-in search in the top-left corner of System Settings. Click in the
search field and start typing. As you enter your query, the results list will be filtered to match your search term, displaying potentially relevant settings that
might offer what you require.

Grouping in System Settings As you scroll through the settings, you will notice that some settings are grouped. For example, Wi-Fi, Bluetooth, Network and
VPN are grouped for connectivity. Notifications, Sound, Focus and Screen Time are grouped for alerts and time management.

Open a Setting from the Dock You also can access the contextual menu by click and holding on System Settings in the Dock..

Access a Setting from the
Dock using the Contextual
Menu
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General

General settings contains information about your Mac, including details such as serial number, how much storage is being used or what language your Mac is
set to. You can also run software updates, control your AirDrop & Handoff settings, manage Login Items, access Transfer or Reset settings, and manage your
backups with Time Machine.

L IO <
Q search
[ >
o.ofs John Appleseed &,
U Apple Account
General
e Wi-Fi Manage your overall setup and preferences for Mac, such as software
updates, device language, AirDrop, and more.
63 sivetooth
Network
e [ About (:)
| Battery
iz Software Update —
2
Storage —0®
Accessibility S
Appsatance) & AppleCare & Warranty %4@
(&) Menu Bar
%) Apple Intelligence & Siri @ AirDrop & Handoff %4®
Desktop & Dock
(4 AutoFill & Passwords %4©
a Displays
Spotlight Date & Time —Q@
(i) Wallpaper Language & Region .7
Notifications & Login Items & Extensions —0©
Sound
() sharing — '
Focus
Screen Time & Startup Disk %4®
g e cerean @ Time Machine S —{ :)
0 Privacy & Security .
L Device Management %4@)
@) Touch ID & Password
8 Users & Groups (&) Transfer or Reset %

(@ About Shows information about your Mac computer, including your serial number, what kind of processor you have, amount of memory, display resolution
and storage information. You can generate a System Report and manage your storage from here as well.

(@ Software Update Use Software Update to update your macOS software and set whether your Mac checks for and downloads new updates automatically.

(® Storage You can view details about your Mac storage space and increase its availability in the Storage settings. You can see a graphic of storage usage,
recommendations for optimizing storage availability, and options for removing unneeded files taking up storage space.

@ AppleCare & Warranty When signed into your Apple Account, this lists all your devices under your Apple Account and shows the current status or your
AppleCare Warranty.

® AirDrop & Handoff Handoff is when you start something on one Apple Device and hand it off to another. AirDrop allows you to send files to another Apple
device near you. AirPlay allows you to stream content to your Mac using AirPlay receiver. Use this setting to setup options for each service.

® Autofill & Passwords Control your password and passkey autofill settings here. Options include erasing verification codes after they've been used and
specifying a default location for code setup, useful for those who utilize external password managers.

@ Date & Time Use Date & Time Settings to set the date and time on your Mac. You can have the date and time set automatically using a network time
server or set your computer’s date and time manually. Be sure your time is correct so time stamps on emails, messages, and files are correct.

Language & Region Here is where you control the language shown in menus and dialog boxes, and the formatting of dates, times and currencies. By
default, the language used will be the language you selected to use when setting up your Mac, along with the appropriate formatting for your location.

® Login ltems & Extensions If you're an administrator of your Mac, you can select the apps, documents, and server connections that open automatically
when you log in to your Mac. You can manage your extension settings here as well.

Sharing The Sharing Setting opens up various aspects of your Mac to other computers on the network. You will see a list of services available for sharing.
At the bottom of Sharing, you will see your computer's local hostname. This is where you can edit the Local hostname.

() Startup Disk You can make your Mac start up from another volume or another operating system by selecting from what's available in the list. If you have a
Mac computer with an Apple T2 chip or Apple Silicon, you may need to change some additional security features on your Mac.

(@ Time Machine Time Machine is the built-in backup feature of your Mac. To use Time Machine, you need an external storage solution. You can connect an
external hard drive to your Mac using USB or thunderbolt. You can also connect to a mounted network drive for Time Machine.

() Device Management Shows any management profiles installed on your Mac for supervision and management of your Mac computer.

Transfer or Reset Use Transfer or Reset settings to open Migration Assistant or Erase Assistant. Migration Assistant lets you transfer your documents,
apps, user accounts, and settings to your Mac from another Mac or PC, or from a Time Machine backup. Erase Assistant lets you safely erase all content
and settings on your Mac.



General - About

< About Model About Includes an image, model and year of your Mac; Name of your Mac,
Processor, Graphics, Memory, Serial number, and if you have Apple Care coverage.
macOS indicates what version of macOS you are running.
l Displays Shows you what kind of display you are using and the resolution of the
display. Click Display Settings to take you to the Display Settings area.
MacBook Air Storage Shows you how much storage is available on your Mac. Click Storage
Settings to go Storage. See Storage on the next page.
Name John's MacBook Air
- ropes System Report Click System Report to launch System Information for a more detailed
report.
Memory 24 GB
Serial number Q423VV4125
AppleCare+ Expires November 2, 2025  Details...
macO0s
e macOS Tahoe Version 26.0.1
Displays
[ suilt-in Liquid Retina Display 13.6-inch (2560 x 1664)
Display Settings...
Storage
; Macintosh HD 956.55 GB available of 994.66 GB
Storage Settings...
System Report...
e Sass: o ot e AA P Pt
General - Software Updates
¢ SO Available Updates To install all the available system software and other updates
shown in the window, click Restart/Update Now. Click Update Tonight to update when
Z Rpdatelocheculedi ) RestartNow (O~ the Mac is not in use. If an update button isn't shown, your Mac is up to date. To view
information about the available update, click “More info’, then do any of the following:
‘Your Mac will try to update later tonight and will automatically restart. More Info... . .
- To show details about an update, click Info (®).
Installed macOS Tahoe 26.0 - Toinstall updates, select the checkboxes of the updates you want, then click Install
Automatic Updates on @ Now.
Automatic Updates Set update options for installing system software and App store
S softes beims et Loamm mope 1o agfeement the sccompenied updates. Click Info (®) to turn on options:
« To have your Mac download updates without asking, enable “Download new updates
¢ when available.”
- To have your Mac install macOS updates automatically, enable “Install macOS
updates.”
- To have your Mac install system files and security updates automatically, enable
"Install Security Responses and System files.”
p Beta Updates Turn on/off Beta updates. You may choose the type of Beta to install on
T your Mac computer. This is only available if you are enrolled inthe Apple Beta Software
Download new updates when available [ &) Preram‘
Install macOS updates o«
Il i d il
Install Security Responses and system files [ @) Ve Ot e et o v & ~N
macOS$ Tahoe 26.0.1 26.01 9.62GB
m macOS Tahoe 26.0.1
'some users from upgrading to macOS Tahoe on Mac Studio (M3 Ultra, 2025).

For information on the security content of Apple software updates, please visit: https//
0

Your Mac willtry to update later tonight and will automatically restart.

Cancel Scheduled Updates =
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General - Storage

< Storage Storage Bar Chart Shows used and available storage on your Mac. The chart shows
the amount of storage used by different apps with file types and the amount of free
Macintosh HD 386.35 GB of 494.38 GB used storage available.
pm———— M-c-w.m . All Volumes (not shown)Shows a more detailed bar chart showing the storage space
used and available for each volume and container of your internal hard disk.
Recommendations Store in iCloud Manage content to be stored in iCloud Drive including Desktop,
'Y Store in iCloud Store in iCloud... DOCUmentS, PhOtOS' and MeSSageS.
e s A el e A Optimize Storage This will automatically remove any movies or TV shows that you
i — already viewed from your Mac.
sty ;ﬁfj’:;ﬁjf;;’:j‘f‘jmmw g morss ity A Empty Trash automatically Set your Mac to automatically empty the Trash when files
shows that you've already watched from this Mac. are stored in the Trash for more than 30 days.
() Emoy Trash automatically Turn On... Storage by Apps and Categories Use the apps and categories to select and remove
e e ot files. To delete files, click on info (®) to see what files are in this category and delete
content you no longer want to save. You have the option to click Show in Finder to
Applications 489268 ® view the file in the Finder.
O pocuments 1ems © Other Users, macOS, and System Data Shows categories that only list the amount of
aloo a2m8 @ space which they occupy. You can't select and delete files in these categories.
L) Music Creation 23868 (D
# Photos 51 O
&) Other Users & Shared Name

05 X 101 €1 Capitan Retailvmok

& ovupdated 1022210161563 s ma
£ macos 28| camacosnans
& Captate_2019_L521dmg
@ systemData & The TaylorHankins Trbute Concort - Live from Wermbloy Sa... v
20118, 118 P

2018-02-06704-18-00-119336000Z.sav

[ a 6, 8010
B WORKING_MEN mav M

B The Fighting rish mav A

& Myt 2toast o\ .. 12/1/09, 420 AM  655.4 M8

wxn | ClickInfo ( ®) to
open a category.

General - AppleCare & Warranty

The setting pane shows a list of devices that are registered to your Apple Account
and displays if the device is still covered by AppleCare. Click on a device to review
the AppleCare coverage and expiration date.

< AppleCare & Warranty

‘ AppleCare & Warranty
View coverage status for all your devices, and purchase coverage for eligible
devices. Learn more about coverage...

John's MacBook Air
This Device

AppleCare+
& Eipires November 2, 2025
Agreement Number: 6745322232

John's MacBook Air
AppleCare+

MacBook Ar
Serial Number: Q423VV4125
Your device is covered for

/ Accidental Damage Protection
/ Hardware Service

/247 Pririty Access

John Appleseed MacBook Air Learn more about my benefits.
Coverage Expired T

More Devices

Coverage is shown for devices connected to your Apple Account and select
Bluetooth-paired devices.

bilty and response times ma
Your warranty is t
coverage information for your product,




General - AirDrop & Handoff

& AirDrop & Handoff
Allow Handoff between this Mac and your iCloud devices [ @)
AirDrop Contacts Only &

AirDrop lets you share instantly with people nearby. You
can be discoverable in AirDrop to receive from everyone
or only people in your contacts.

About AirDrop & Privacy...

AirPlay Receiver [ @)
AirPlay Receiver allows nearby Apple devices to send video and audio
content to your Mac with AirPlay.

Allow AirPlay for Current User ¢
Only devices signed in to your Apple Account can see and

AirPlay to this computer.

Require password @ set.

General - Autofill & Passwords

< AutoFill & Passwords

All Your Passwords in One Place
Passwords, passkeys, and verification codes are safely stored in the new
Passwords app and are available to use in Safari and other apps.

Open Passwords

AutoFill Passwords and Passkeys [ @)
suggest ds, passkeys, and codes when
signing in to apps and websites

AutoFill from

Passwords [ @)

Passkeys, passwords, and codes

Verification Codes

Delete After Use
Automatically delete verification codes in Messages and Mail after they
are used.

Set Up Codes In @ passwords ¢
Passwords will be used to open links and QR codes for
setting up verification codes.

General-Date & Time

< Date & Time

Set time and date automatically [ @)
Source Apple (time.apple.com.) ~ Set...
Date and time Oct 16, 2025 at 11:51:17 PM
24-hour time

Set time zone automatically using your current location [ @)
Time zone Eastern Daylight Time
Closest city New York, NY - United States

Allow Handoff between this Mac and your iCloud devices Turn on/off Handoff
between your Mac, iPhone, iPad, and Apple Watch. Your Apple devices must have
Wi-Fi, Bluetooth, and Handoff turned on in Settings. You must be signed in with the
same Apple Account on all your devices.

AirDrop Choose who can send files to you. You have a choice of Everyone, Contacts
Only or No One.

AirPlay Receiver Allow nearby Apple devices to stream content to this Mac with
AirPlay.

Allow Airplay for Choose who can stream to your Mac.

« Current User: Only devices signed in to your Apple Account can see and use AirPlay
to stream content to this Mac.

- Anyone on the Same Network: Any nearby Mac, iPhone, or iPad on the same network
can see and use AirPlay to stream content to this Mac.

- Everyone: Any Mac, iPhone, or iPad can see and use AirPlay to stream content to
this Mac.

Require Password Require a password to use AirPlay to stream content to this Mac.

Open Passwords Click to open the Passwords app.

AutoFlll Passwords and Passkeys Enable to automatically suggest and generate
passwords, passkeys and verification codes when sigining in to apps or websites.

AutoFill from Enable/disable a password management app from the list.
|.E. 1Password.

Verification Codes

- Delete After Use: Enable this to automatically delete verification codes from
Messages and Mail after they are used.

- Set Up Codes In: Open verification code setup links or QR codes with selected app.

Set time and date automatically Turn this on to have the date and time on your Mac
set automatically using a network time server. If you want to change the default time
server from Apple, click Set, then type the address of a network time server.

Date and time This allows you to view the date and time set automatically. If you want
to manually set it, turn off Set time and date automatically.

24-hour time Sets the time in 24-hour format in the Menu bar.

Set time zone automatically using your current location Have your Mac automatically
set the time zone based on your location. Location Services must be turned on.

Time zone Set automatically based on your current location. To set it manually, turn off
Set time zone automatically using your current location.

Closest city Shows you the closest major city based on your location.



General - Language & Region

~
< Language & Region
Preferred Languages
English English (US) — Primary
ax
Thursday, October 16, 2025 at 11:51:31PM EDT
10/16/25, 11:51PM ~ $12,345.67  4,567.89
Region United States ¢
Calendar Gregorian ¢
Temperature Celsius (°C) o Fahrenheit (°F)
Measurement system Metric ° us UK
First day of week Sunday ¢
Date format 8/19/25 ¢
Number format 1,234,567.89 ¢
Live Text [ @)
Select text in images to copy or take action
Applications
Customize language settings for the following applications:
4
Translation Languages... ?
/
General - Login Items & Extensions
/ P
< Login Items & Extensions
Open at Login
These items will open automatically when you log in.
Item Kind
+
Extensions
Extensions add extra functionality to your Mac and apps, and some may run in the
background
By App By Category
Books ®
Sharing
w Freeform (@)
Sharing
Image Playground @
S Messages
n Journal @
Sharing
[ Messages (@)
d sharing
S News (@)
N Sharing
Notes @
Sharing
Reminders ®
Sharing
' Shortcuts (@)
Sharing
(i3] System Services [6)
& Convert Image, Create PDF, Markup and 3 more.
“
" /

macOS Tahoe: A Guide to Your System Settings

Preferred Languages View the languages you want shown in macOS; in apps, i.e.in
menus and messages, and on websites. You can drag languages in the list to reorder
them. If you add input sources such as a keyboard, those languages are automatically
added to the list. Click Add (+) to add a language.

Region Choose the geographic region whose formats are used for dates, times,
numbers, and currencies.

Calendar Choose the type of calendar used to display dates and times.
Temperature Choose Celsius or Fahrenheit as a temperature format.
Measurement system Choose Metric, US or UK as a measurement format.
First day of week Choose the first day of the week for your calendar.

Date format Choose the format of how the date is displayed.

Live Text Turn Live Text on/off. Live Text is a feature that allows the Mac to render the
text inimages, so you can copy as text. When Live Text is reading a street address, it
becomes actionable. For example, click on the address and it will launch Maps for you.

Applications List of apps you set to use a language other than the default language.
Add (+)/Remove (-) languages from the list.

Translation Languages Select languages to download to your computer so you can
translate when offline.

Open at Login Add items to open automatically when you log in. If you no longer want an
app to open automatically at log in, select the item and click Remove (-). If you see an item
with a warning (&), the item you want to open at log in may have been moved or deleted.

App Background Activity Allow apps to run background tasks even when they're not open,
such as checking for updates or syncing data.

Extensions

Added extensions Extensions you installed on your Mac. These are extensions created
by third-party developers. If the extension is a content extension that enables extra
functionality in apps, you see an Actions checkbox below the extension. If it's a Finder
extension, you see a Finder checkbox. Select the checkbox to enable the extension.
Actions Content extensions installed on your Mac. Select a content extension to make it
available in apps. For example, if Markup is selected, you can draw on pictures and sign
documents in apps such as Mail, TextEdlit, or Preview.
Camera Extensions Camera extensions installed on your Mac let you add and use
custom camera features.
Color Panels Color panel extensions installed on your Mac let you pick and view colors,
copy and paste color codes, create palettes, and more.
Dock Tiles Dock tile extensions installed on your Mac let you customize the Dock by
adding spacers, setting quick actions, viewing previews, and more.
Drivers Driver extensions installed on your Mac let you add custom drivers that give
apps access to specific system features.
Endpoint Security Extensions Endpoint security extensions installed on your Mac improve
security by monitoring system events for suspicious or potentially harmful activity.
Finder Select a Finder extension to make it available in the Finder such as iCloud Drive.
Media Media extensions installed on your Mac add new options for playback, editing,
and sharing. They can also enable support for additional media formats.
Network Extensions Network extensions installed on your Mac let you customize and
expand core networking features, such as setting up a VPN or configuring content filters.
Photos Editing Photos extensions installed on your Mac, such as Markup. Select a
Photos extension to make it available in Photos while editing photos.
Sharing Select the items that you want in the Share menu.

- Default extensions, such as Mail, Messages, and AirDrop, cannot be deselected.

- If an extension selected in the list doesn't appear in the Share menu, the item you're

trying to share can't be shared using that extension. For example, you can use
AirDrop to share a webpage in Safari, but not selected text.
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General - Sharing

< Sharing

Content & Media

'*' File Sharing

& Media Sharing

Screen Sharing

© ©e|e|e

%1 Content Caching

Accessories & Internet

B Bluetooth Sharing
u Printer Sharing

Internet Sharing

Advanced

<o Remote Management

() Remote Login

u Remote Application Scripting

Local hostname Johns-MacBook-Air.local

Computers on your local network can access your computer at
this address.

Edit...

General - Startup Disk

< Startup Disk

Select the system you want to use to start up your computer

Macintosh HD

macOS 26.0.1

You have selected macOS 26.0.1 on the disk “Macintosh HD". Restart...

Content & Media
File Sharing Share files and folders with others on your network. Share with everyone
or specific users.

Media Sharing Use this to set options for Home Sharing and sharing your media
library.

Screen Sharing Use screen sharing to access your Mac from another Mac, while
you're away, or solve a problem on someone else’s Mac.

Content Caching Use to manage content caching on your Mac. This will help
reduce bandwidth usage and speed up installation on supported devices by storing
downloaded software updates, applications, and other content on your Mac.

Accessories & Internet
Bluetooth Sharing Turn this on to control how your Mac handles files exchanged
between Bluetooth devices.

Printer Sharing Usually used for printers that are connected through USB, share your
printer for others to use.

Internet Sharing Turn this on to share the internet connection on your Mac with other
devices on your local network.

Advanced
Remote Management Turn this on to allow others to access your computer using
Apple Remote Desktop.

Remote Login Turn this on to access your Mac from another computer using SSH
(Secure Shell Protocol).

Remote Application Scripting With Remote Application Scripting turned on, it allows
Apple events sent from other computers to control application on the Mac.

Local hostname The local network name of your Mac. Click Edit to change your
computer’s local hostname.

Set the default startup disk Change the startup disk your Mac automatically uses
from the list. Click Restart.

Target Disk Mode Target disk mode lets you share files between two Mac computers
with FireWire, Thunderbolt 2, USB-C, or Thunderbolt 3 or 4 ports. This is useful when
you need high transfer speeds or if the display on one of your computers isn't working
and you need to get files from it. Essentially, it makes your Mac act as an external hard
drive.

NOTE: Target Disk Mode does not appear on Apple Silicon Macs.
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General - Time Machine

) ] Add or Remove Backup Disk Click Add(+) to add another backup disk. Click Remove
< | 2 JimeMachine (-) to remove a backup disk.
@ Time Machine

Options Click Options for more settings:
Time Machine backs up your computer and keeps local snapshots and
hourly backups for the past 24 hours, daily backups for the past month and
weekly backups for all previous months. The oldest backups and any local

+ Back up frequency: Choose whether to back up manually or select how often
snapshots are deleted as space is needed. . . .
Time Machine backs up your files.
Rtinzeitotus MaceociRia + Back up on battery power: Turn on to create backups every hour even if your
pe (]
Preparing to back up...

Mac is on battery power. This option only appears when an automatic backup
schedule is selected on a Mac notebook.

+ Exclude from backups: Exclude files from a backup to save space on your
Options... -—=»—| backup disk, or to exclude items you back up using another method.

Backup Frequency Automatically Every Hour &

Back up on battery power [ @)

Exclude from Backups

B Backups of John's MacBook Pro
+

General - Device Management

< D e T Use the Device Management to install, view, or remove configuration profiles.

Configuration profiles are files that standardize settings for Mac computers, iOS
This Mac is supervised and managed by: David Yoon Inc. devices, App|e TVS and ViSiOﬂOS devices.

Add (+) Click Add (+) to install a configuration profile.

Device (Managed)

w App Installers - PPPC and Managed Login Iltems
>,

et Remove (-) Click Remove (-) to remove a configuration profile. If you can't remove a
@ Lo ticstions profile, your Mac may be a managed computer.

) 1 setting

53 Managed Login Items - Jamf Apps
U 1 setting

2y MDM Profile
e Unenroll
3 settings

7y Privacy Preferences Policy Control
L’J 1 setting

-

?
General - Transfer or Reset
< R Open Migration Assistant Opens Migration Assistant to transfer files from another
device to your Mac.
i; Migration Assistant Open Migration Assistant...

Erase All Content and Settings Opens Erase Assistant to erase all content and
W T A T D T D (0, G s, o settings on your Mac.
to this Mac from another Mac, a Windows PC, a Time Machine backup, or disk. You
can also transfer information from this Mac to another Mac.

Erase All Content and Settings... ?

1
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Apple Account

This setting encompasses anything that your Apple Account manages, including your Apple Account, Personal Information, Sign-In & Security, Payment and
Shipping, iCloud, Media & Purchases, Family Sharing and Devices.

Q search

a John Appleseed

Apple Account

Ready for Apple Intelligence

B wi-Fi

a Bluetooth
Network
VPN

Battery

2] General

Accessibility
Appearance

(=) Menu Bar

? Apple Intelligence & Siri

Desktop & Dock

< Apple Account
John Appleseed
jappleseed.personal@icloud.com
a Personal Information %46)
a Sign-In & Security %4@
E Payment & Shipping .74©
» iCloud .74@
& Family Set Up .74@
Media & Purchases .*4@
o Sign in with Apple %4@
Devices

i! RGoon MacBook Pro ,7

This MacBook Pro 14"

a Displays

a Spotlight

{53 Wallpaper

< Personal Information
Name John Appleseed
Birthday EE
Age Range for Apps Set Up
Communication preferences ®
Announcements, Apps, Music, TV & More
@ See how your data is managed...

< Sign-In & Security

Email & Phone Numbers

These email addresses and phone numbers can be used to sign in, verify your
identity, and help recover your account. They can also be used to reach you with
iMessage, FaceTime, Game Center, and more.

jappleseed.personal@icloud.com
Primary email

+1
Unavailable for iMessage and FaceTime

Add an Email or Phone Number...

Security

Password

Last Changed November 5, 2024, ChenaeRas s
Two-Factor Authentication
Your trusted devices and phone numbers are used to verify your identity when
signing in.

Recovery Methods
Regain access to your account and data if you forget your password or
device passcode

Recovery Contacts Set Up

Recovery Key Set Up

Legacy Contact
Alegacy contact is someone you trust to have access to the datain  Set Up
your account after your death.

Automatic Verification
Bypass CAPTCHAS in apps and on the web by allowing iCloud to On

(@ Personal Information Allows you to edit your name, birthday and your avatar. You
can turn on/off any Apple announcements including news, new products and
updates.

@ Sign-In & Security You can change your password, add/remove phone numbers,
and email accounts. You can also:
« Setup an account recovery for your Apple Account.
- Manage log ins for third party apps and websites using your Apple Account.
« Setup a Legacy Contact for your successor for your Apple Account.

The last time you changed your password for your Apple Account is found here as
well.

Click Two-Factor Authentication Add or change your trusted phone numbers and
to setup Security Keys to provide protection against attacks such as phishing or
social engineering scams on your Apple Account. Using a security key with two-
factor authentication will help strengthen the process and help prevent your second
authentication factor from being intercepted or requested by an attacker.

You can find more infomation on how to setup security keys for your Apple Account at:
https://hcsonline.com/training/training-articles/how-to-configure-security-keys-for-apple-id
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(® Payment & Shipping View your Apple Cash balance and connect your

< > Payment & Shipping ' o g
Apple Pay to your Mac. You may edit your shipping address from this area.
Payment Method

You can use a variety of payment methods with your Apple Account, including Visa,
Mastercard, American Express, Discover, and PayPal to make purchases or
subscribe to services from Apple.

On an i0S device running i0S 12.2 or later, you can change the payment method for
your Apple Account in Settings. On earlier i0S versions, use the App Store. On a
Mac or PC, use the Mac App Store or iTunes (if available)

Card @D | Mastercard -+-- 9593

Apple Cash Balance

Your Apple Cash balance can be used on any Apple Pay capable iPhone, iPad or
Apple Watch signed in with your Apple Account.

Apple Card Balance

Shipping Address

This shipping name and address will be used for purchases from Apple Store.
Address [ n

23
-3009 United States

Edit

(@ iCloud Click iCloud to take you to the System Settings of iCloud. See iCloud
on page 49.

< Family

Logan

Age 8 ® Family This will take you to the Family Sharing System Settings

Richard (See next page.)

Parent/Guardian

Richard (Me)
Organizer

See what family members can access and share, and manage child account
settings and parental controls.

Add Member...

4 Family Checklist

[ Subscriptions
&9 1 shared subscription

P Purchase Sharing

Enabled

7 Location Sharing
Sharing with all family

(® Media & Purchases Setup password options when downloading free
apps, paid apps or subscriptions. For free apps, your password options are
either require a password or never require a password. For paid apps, there

Account Richard Goon ~ Manage... is a third option: require after 15 minutes. You can manage your in-app

subscriptions and enable/disable Touch ID for purchases.

< > Media&Purchases

App Store, Books, News, Music, and TV

Subscriptions Manage...
Use Touch ID for Purchases [ @)

Sign Out...

?

13
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< > Signinwith Apple

Sign in with Apple

Sign in with Apple is the fast, easy, and more private way to sign in to third-
party apps and websites using the Apple Account that you already have.
Learn more...

Share Accounts X
Open the Passwords app to share your Sign in with Apple accounts

with family and close friends.

Open Passwords App

Apps and Websites

2nd Number
;’... 7-Eleven
& Adobe

Battle.net

- hatODT

< > DevicelInfo

=

Richard Goon iMac

This iMac 24"
Find My Mac Off
AppleCare & Warranty
Model iMac 24"
Version macOS 26.0.1
Serial Number HATFRICFQEXG
Wallet & Apple Pay
Apple Card
Prime Visa ++++ 5100
Business Gold Rewards Card «+++ 6009
Blue Business Plus Card ++++ 2009

Remove Items...

< > Contact Key Verification

Verification in iMessage D

Verify who you are messaging with by comparing contact verification
codes in person or over the phone. In conversations with people who
also have contact key verification turned on, you will see a message if
contact key verification detects an issue or is turned off.

Your Public Verification Code
To allow people to verify they are messaging with you, share your public verification
code. Your public verification code does not contain any private information.

AP . . ihg

Copy Verification Code

Learn More...

@ Sign in with Apple When you see a Sign in with Apple button on a
participating app or website, it means you can set up an account using
your Apple Account. No need to use a social media account, fill out forms,
or choose another new password.

https://support.apple.com/en-us/102609

Devices At the bottom is a list of all devices tied to your Apple Account.
Click on each device to view the Model, macOS version, serial number and
to see if Find my Device is turned on.

You can remove items from the device such as items in Wallet & Apple Pay.
You may even remove devices that you no longer own or use from this list.

(® Contact Key Verification This provides additional security by helping to
detect threats against iMessage servers and allowing you to verify that
you're messaging only with the people that you intend.

https://support.apple.com/en-us/118246
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Apple Account - Family
If you use Family Sharing, you can view which subscriptions and services you're sharing with others, who in your family has enabled the Ask to Buy
feature and more. Family Sharing lets you and up to five other family members share access to amazing Apple services.

eoce < Family
Q Search 25 John (You)
Organizer
) John Appleseed )
@ Apple e Richard
Adult

Wi-Fi

See what family members can access and share, and manage child account
settings and parental controls.

o 6

Bluetooth Add Member..:
Network
+ Do More with Family X
VPN
+¢ Update important information for each family member and
g Battery review recommendations.
/2] General
Accessibility @ Recommended For Your Family
6 active items @
Appearance
= Subscriptions .»4@
@ Menugar @ 1 shared subscription
) Apple Intelligence & Siri
Purchase Sharing
Desktop & Dock Set up Purchase Sharing @
g Displays 7 Location Sharing
Not sharing with family —4©

(@ spotiight

Wallpaper Apple uses your Apple Account, payment details, and information about your family group

to let you and your family members share subscriptions, purchases, and locations; create a
child account; and set up parental controls. Apple may use details about your family group
to send you relevant communications. See how your data is managed...

3 Notifications
Sound ?
Focus

@ Family Members List of family members. Click the name of a family member to see the family member's settings.
@ Add Member Add another family member to your Family Sharing group.
(® Recommended For Your Family Set up recommended settings to get the most out of Family Sharing.

(@ Subscriptions Use Subscriptions settings to view which of the services you subscribe to, are being shared with your family, which subscriptions your
family members are sharing with you, and start or stop sharing eligible subscriptions.

(® Purchase Sharing Allows everyone in your family to share each other's media and app store purchases. You can edit how you share your
payment method.

(® Location Sharing Set Location Sharing so every family member can view each others location through Find My.

Turn On
Recommended For Your Family

Suggestions for getting the most out of Family Sharing.
More Recommendations

Safety and Privacy
. Family Grocery List
. Create a shared grocery list for everyone to add their favorite

@ Share Your Location * items before your next shopping trip.

Family members will be able to see where you are and help you
find lost devices in Find My. Create Shared List
Set Up Location Sharing

e Family Calendar
() Create a shared colendar or your famiy so everyone can stay
Subscriptions and Purchases up to date on important events
i " 1 Create Shared Calendar
Share iCloud+ with Family
‘ Give your family access to additional iCloud storage, Private
Relay, Hide My Email, and other premium features at no extra

charge. Shared Passwords
? Share logins and passwords to shopping sites, utilities,

Share iCloud+ streaming services, and more.

Set Up Family Passwords

- Purchase Sharing
.ﬂ Your family can share the media, books, apps, and

Click on Recommended For Your Family to setup shared resources.

15



Wi-Fi
Use this setting to manage your Wi-Fi connections. You can turn Wi-Fi on or off and confirm the name of your Wi-Fi.

[ N ] < Wi-Fi
Q Ssearch Wi-Fi D a :
Set up Wi-Fi to wirelessly connect your Mac to the internet.
) John Appleseed Turn on Wi-Fi, then choose a network to join. Learn More...
u Apple Account h @
Richard's iPhone 8@ @ Details...
Ready for Apple Intelligence @ Connected
B Bluetooth 7
HCS-WiFi as 0O
Network
VPN Higher_Ground a0
(e Battery v Richard's iPhone 8=
v @ Autorton
2] General Copy Password
- Other Networks Network Settings.
Accessibilty p—
(3) Appearance Fios-NK6Jw 8= O
=) Menu Bar . :
e Fios-RkX2X_5GEXT G
3“ Apple Intelligence & Siri
E) Desktop & Dock ForestMoonOfEndor-Guest a8 @
€3 pisplays ForestMoonOfEndor-loT a0
g Spotlight
Verizon_K4SGS4 8= O
{&:) Wallpaper
WMb81eba = ®
B Notifications
Sound Other...
Focus Ask to join networks Notify ¢ k‘@
Screen Time Known networks will be joined automatically. If no known networks
are available, you will be notified of available networks.
ﬂ Lock Screen Ask to join hotspots Ask To Join &
N . Allow this Mac to automatically discover nearby personal
0 BrivesylESecuity hotspots when no Wi-Fi network is available
) Touch ID & Password
e Users & Groups Advanced... '—7»

@ Wi-Fi Turn Wi-Fi on/off.

(@ Current Status Shows if you are connected to Wi-Fi. Click details to view detailed information for TCP/IP, DNS, WINS, 802.1X, Proxies and Hardware . You
can also use this to disconnect from the Wi-Fi and forget the network.

(® Personal Hotspots When your Mac senses a personal hotspot, such as your iPhone, close by, the name of the hotspot will appear here.

(@ Known Networks List of networks nearby that you have previously connected to.

(® Other Networks List of networks nearby that you have never connected to. Move your pointer on a discovered network and click Connect. Click on Other
to manually enter the name of a hidden Wi-Fi network.

(® Ask to join networks Turn on to allow the Mac to automatically discover nearby networks. If no known networks are available, you will have to manually
connect to a network.

@ Ask to join hotspots Turn on to allow the Mac to automatically discover nearby hotspots when there is no available Wi-Fi.

Advanced The Advanced settings allows you to turn on administrative rights to change the parameters of your Wi-Fi settings as well as show you
information such as MAC address and all the Known networks you have connected to.

Tip

More Options Click on Options (@) next to a known network and you can select the following:
« Turn on/off Auto-Join
- Copy Password
- Network Settings - allows you to turn on/off Low data mode and Limit IP address tracking.
- Forget This Network (appears under Details and Known Networks)



Bluetooth

The Bluetooth setting is used for controlling any Bluetooth devices your Mac is paired with. With this setting, you can turn Bluetooth on or off. If Bluetooth is
set to off, services such as Airplay, AirDrop, Find My and Location services will be disabled. When Bluetooth is enabled, the Mac's name is displayed and the

Mac is discoverable.

macOS Tahoe: A Guide to Your System Settings

w

Q search

< Bluetooth

3 Bluetooth

Connect to accessories you can use for activities such as

streaming music, typing, and gaming. Learn more...

o) John Appleseed

Accessibility

g Notifications

Sound
Focus
Screen Time

Apple Account

is open.

Wi-Fi
3 Bluetooth My Devices

Network
=, Richard's AirPods Pro
VPN Connected - 9% 94% & 83%
Battery Richard’s Magic Keyboard

Connected - ®=: 94%

/2] General

Richard's Magic Mouse
—  Connected - @& 91%

Q) Appearance
PP Fugoo Speaker
(=) Menu Bar Not Connected
? Apple Intelligence & Siri . Magic Mouse 2
Not Ci ted
(&) Desktop & Dock ot Lonnecte
g Displays v Richard's AirPods
Not Connected
2 spotiight
\&:) Wallpaper

Nearby Devices

[ John's MacBook Air

«

This Mac is discoverable as “Richard Goon iMac" while Bluetooth Settings

(@ My Devices This shows your devices that are in discovery mode or devices that are paired with the computer and their current status. Hover the pointer
over an item and a Connect button appears. Click Connect to connect the Bluetooth device to your Mac.

Click Info (®) to show details of the bluetooth device. You can also choose Forget This Device.

(@ Nearby Devices A list of discovered devices that are ready for pairing. Click Connect to pair a Bluetooth device to your Mac.

~

T onan

Name Richard’s AirPods Pro
Device Type AirPods Pro
Model Number A2084
Serial Number H 9
Version 6F21

Connect to this Mac
© Automatically
When last connected to this Mac

AirPods Pro Settings...

Forget This Device... Disconnect m

/

Click Info (®) to view more information on the bluetooth device

17



18

Network

The Network Setting is for the customization of your Ethernet, Firewall, and managing network services. Wi-Fi and VPN settings are accessible here too. You
can more easily access them from the sidebar of System Settings.

[ JCN < Network
Q search 74} USB 10/100/1000 LAN
@ Connected
.00 John Appleseed .
u Apple Account Wi-Fi
@ Connected
Wi-Fi e
€3 Bluetooth ® Inactive @
inactve —0
VPN
& Battery Other Services
2] General Thunderbolt Bridge
@ Not connected 4@
Accessibility
Appearance o W ?
(=) Menu Bar Add Service...
Add VPN Configuration >
O] Apple Intelligence & Siri S —
- Manage Virtual Interfaces... C
Desktop & Dock Set Service Order...
g Displays Locations. >
Spotlight
{9 Wallpaper
Q Notifications

(@ Services Allist of available connection types and settings related to the currently selected service. A green dot indicates the network service is on or
active/connected. A yellow dot indicates the service is on but not connected to a network. A red or gray dot indicates the service is off.

(@ VPN Click to change or view the settings for VPN connections (Same as VPN in sidebar of System Settings.)

(® Firewall Turn on Firewall for added protection against attacks. Once turned on, you can block/allow connections coming into your Mac. You can turn on
Stealth Mode, so when someone tries to ping you, they will not get a response.

(@ Other Services Services that are not in use such as Thunderbolt Bridge.

(® Options (- -+) Enables you to add more services or VPN Connections. You can set the service order to prioritize certain connection types. Manage Virtual
Interfaces allows you to modify settings for the network interfaces.

Tip

Information on a connection Click on a network service (Details) to see more information about the connection. You can view

IP address, subnet mask, gateway, DNS servers, Search Domains and IPv6 Address. You can also delete the service or just make it inactive. You can also turn

on/off Limit IP Address Tracking which will hide your IP address from known trackers in Mail and Safari.

LN J < USB 10/100/1000 LAN

(1) USB 10/100/1000 LAN Name
@ Connected

Search USB 10/100/1000 LAN Details..
2 seerd RO TCP/IP Limit IP address tracking [ @)

@‘ John Appleseed DNS
CEIDIEEE IPv4 Configured Using DHCP.

WINS
@ wi-Fi

@ siuetooth Subnet mask

Network
VPN
(& Battery

USB 10/100/1000 LAN

Limit IP address tracking by hiding your IP address from known
trackers in Mail and Safari.

1P address 192.168.23.136 802.1X

256.266.255.0 Proxies

192.168.23.1 Hardware

DNS Servers 192.168.23.1

Search Domains. Search Domains

(&) General
Accessibility
@ Appearance
(=) Menu Bar

IPV6 address 1dc1:6b23:c778:2643:18bb:6e42:1964:c358

Delete Service... Make Inactive 7

2) Apple Intelligence & Siri
Desktop & Dock
8 pisplays
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VPN

To connect to a virtual private network (VPN), you need to enter configuration settings that may be provided by a network administrator for your organization
or your VPN service provider. If you received a VPN settings file from your network administrator or VPN service provider, double-click the VPN settings file to
add this VPN to your connection list.

[ JCN < VPN
Q Ssearch . HCS ® — O
@ Disconnected
. B John Appleseed
SNOtTE -gh Itst- @ Eopofeeart About VPNs & Privacy... + v ?
ystem Setting
may not e 210 o one. BRE)
Cisco IPSec...

appear unless B Bluetooth evn
you Crea.te Network
e CEID
. @ veN
in Network
Settings () Battery
(See previous @ erora
page for
adding VPN Accessibility
Configuration.) Appearance

(=) Menu Bar

—_“ Apple Intelligence & Siri
Desktop & Dock
a Displays
Spotlight

| Wallpaper

a Notifications

(@ Connections List of VPN services. To connect or disconnect from a VPN service, turn the VPN service on or off.

(@ Add VPN Configuration There are three VPN connection types that you can configure on macOS:
« L2TP over IPSec
« Cisco IPSec
- IKEv2

Tip
Information on a connection Click Info (®) next to a VPN connection you have added here and start entering or modifying the settings.

Third-party VPN clients For example, Sonicwall Mobile Connect, VPN Tracker connections will be listed here but need to be edited in their client app used to
create the connection.

[ < > Network

Q Search USB 10/100/1000 LAN
@ Connected

® L27P over IPSec ey —

Options
TCP/IP Configuration Default ¢
BhS Server address

Proxies
Account name

User authentication Password ¢

Password

Machine authentication Shared secret

Cancel

0P OG0 B0 2 m

& control Center
@ siri & spotiight

Click Info (©) to view the settings for a VPN connection
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Battery

This setting is specific to Mac laptops such as a MacBook Air or a MacBook Pro. Use Battery settings to set options that control your computer’s energy use.

These options also help you extend your battery's life.

Q search

@

Wi-Fi
Bluetooth
Network
VPN

=
& Battery

@ General
Accessibility
@ Appearance

(=) Menu Bar

John Appleseed
Apple Account

E‘ Apple Intelligence & Siri
Desktop & Dock

a Displays

Spotlight

(&) Wallpaper

B Notifications

< Battery

Low Power Mode

Battery Health

Last 24 Hours

Charging on Hold: Desktop Mode
Rarely used on battery

Battery Level

Screen On Usage

Oct19

®» Charging on Hold
Never & ( )
Normal @ @
Last 10 Days »4®
100%
||“ “I“ |‘||‘|W“ “l““ V““H“ m”'ml “’“”H“ -
0%
3 6 9 12A 3 6 9 12P
60m
30m
9 12A 3 6 9 12P
Oct 20
Options... ——’»4@

@ Low Power Mode Reduce energy usage to increase battery life.

(@ Battery Health See the condition and capacity of your computer’s battery, and optimize its lifespan. Click Info (®) to turn on the following:
- Optimized Battery Charging: To reduce battery aging, have your Mac learn your daily charging routine. Then your Mac delays charging past 80% when it
predicts that you'll be plugged in for an extended period of time, and aims to fully charge the battery before you unplug.
- Manage battery longevity: Reduce peak capacity to optimize the battery's lifespan. See the Apple Support article About battery health management in

Mac notebooks.
https://support.apple.com/en-us/102589

(® Usage History This shows you the battery level, how much energy your Mac has used, and how long its screen was on. You can check either the last 24

hours or the last 10 days.

(@ Options Click Options for more settings.

Slightly dim the display on battery

Prevent automatic sleeping on power adapter when the
display is off

Wake for network access

While sleeping, your Mac can receive
incoming network traffic, such as
iMessages and other iCloud updates, to
keep your applications up to date.

Optimize video streaming while on battery
To increase battery life, your Mac will stream high-dynamic-range
(HDR) video in standard-dynamic-range (SDR).

Only on Power Adapter ¢

Slightly dim the display on battery When enabled, the display will dim when
there is no connected power adapter.

Prevent automatic sleeping on power adapter when the display is off Enable
this to prevent your Mac from sleeping when it's plugged in and its display is
off.

Enable Power Nap* Permits your computer to check for email, calendar, and
other iCloud updates while sleeping. If turned on for Ethernet, your computer
can also back up using Time Machine.

Wake for network access Users can access your computer's shared
resources, such as shared printers or iTunes playlists, even when your
computer is in sleep mode.

Automatic graphics switching The Mac will choose the best graphics mode to
increase battery life.

Optimize video streaming while on battery While on battery power, play high-
dynamic-range (HDR) video in standard dynamic range (SDR), which requires

less energy.

*Enable Power Nap is not available on Apple Silicon Macs.



Energy Saver

This setting is specific to Mac desktops such as an iMac, Mac Studio or Mac mini that does not require a battery to power it up. Use Energy Saver to set

macOS Tahoe: A Guide to Your System Settings

options that control your Mac computer's energy use. NOTE: Some of the options may not be available, depending on your Mac.

Q Search

= Family

Wi-Fi
Bluetooth
Network
VPN

2] General
Accessibility
@ Appearance
(=) Menu Bar
-_“ Apple Intelligence & Siri
Desktop & Dock
a Displays
Spotlight

\i:) Wallpaper

Energy
<> EBUPS Level: 100%

Prevent automatic sleeping when the display is off O

Put hard disks to sleep when possible —

Wake for network access [ @)

While sleeping, your Mac can receive incoming network traffic, such as o

iMessages and other iCloud updates, to keep your applications up to date.

Start up automatically after a power failure [ @X
UPS Options... ?

L

b Ll

(@ Prevent automatic sleeping when the display is off When the display tirns off, your Mac will still be awake and active.

(@ Put hard disks to sleep when possible Put the Mac computer's hard disk to sleep whenever it's inactive.

(® Wake for network access Users can access your Mac computer's shared resources, such as shared printers or Music playlists, even when your

Mac computer is in sleep mode.

(@ Start up automatically after a power failure Start up your Mac after a power interruption.

(® UPS Options Set the time or battery level at which your Mac shuts down when using a UPS.

NOTE: this only appears when you connect your Mac computer to an uninterruptible power supply (UPS) with a UBS Cable.

Shut down your Mac after using the UPS Battery for:

==
1min 5 min 10 min

Shut down your Mac when the time remaining on UPS battery is:
=

1min 5min 10 min

Shut down your Mac when the UPS battery level is below:

1% 25% 50% 75%

UPS Model Back-UPS NS 1500M2 FW:957.e4 .D USB FW:e4

O

15 min
«©

15 min

[ @)

100%
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Accessibility

Accessibility comes standard in a Mac. Whether you have difficulties with vision, hearing or physical mobility, macOS includes a variety of features to help you
work in alternative ways. To quickly enable or disable Accessibility Options, press Option () - Command (&) - F5, or if your Mac or Magic Keyboard has
Touch ID, quickly press Touch ID three times.

[ N ) < > Accessibility

Q Search Accessibility

Personalize Mac in ways that work best for you with accessibility features
. for vision, hearing, motor, speech, and cognition. Learn more...

= Family

Wi-Fi Vision

8 Bluetooth VoiceOver

Network

Zoom

VPN

u Energy @ Hover Text

{2) General @ Display

® Accessibility @ Motion

Appearance

Read & Speak
(=) Menu Bar

00

2) Apple Intelligence & Siri Audio Descriptions

Desktop & Dock

a Displays Hearing
Spotlight Audio
{22 Wallpaper @ rrr
g Notifications Captions

Sound
Focus

Screen Time 9 Name Recognition

Live Captions

o Lock Screen
Motor

0 Privacy & Security
m Voice Control

Touch ID & Password

e Users & Groups i) Keyboard

Internet Accounts L Pointer Control
() G @i i5) Switch Control
% iCloud

Wallet & Apple Pay Speech

|:2) Keyboard Live Speech

L Mouse a Personal Voice

() cps &DVDs o
Vocal Shortcuts
\zJ Printers & Scanners

General
2 siri

Shortcut




Accessibility - Vision: VoiceOver

< > VoiceOver

VoiceOver

VoiceOver provides spoken and brailled descriptions of items on
the computer screen and provides control of the computer
through the use of the keyboard.

Toggle VoiceOver: %F5

Open VoiceOver Tutorial..  Open VoiceOver Utility...

Accessibility - Vision: Hover Text

< > Hover Text

Hover Text [ ®N6)
Press 3 to display a large-text view of the item under the pointer.

Hover Color [ @6}
Press A to describe the color under the pointer.

Hover Typing [ @N6)

Accessibility - Vision: Display

< > Display
Invert colors
Invert colors mode
Increase contrast
Reduce transparency [ @)
Differentiate without color
Show window title icons [ @)
Show toolbar button shapes [ @)

Display contrast
Normal ‘Maximum

Text

Text size
Set your preferred reading size for supported apps and Custom
system features.

Menu bar size Default @ Large
Some apps or system features may need a log out for
the changes to menu bar font size to take effect
Prefer horizontal text
Pointer
Shake mouse pointer to locate [ @)
Quickly move the mouse pointer back and forth to make it bigger.
Pointer size —

Normal Large
Pointer outline color
Pointer fill color -

Reset Colors
Color Filters
A

Color filters
Filter type Grayscale &

Intensity —
Low High
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Enable VoiceOver Turn VoiceOver on or off.
Open VoiceOver Training Built in tutorial on how to use VoiceOver.
Open VoiceOver Utility Customize VoiceOver settings.

Hover Text View a larger, high-resolution version of the text you're reading and other onscreen
elements, such as app icons.

Hover Color View a magnified, high-resolution version of colors in the text you're reading and
other onscreen items, such as app icons. You can also customize the text color that appears
under the pointer when using Hover Color.

Note: Hover Color shares appearance settings with Hover Text.
Hover Typing Display a larger, editable version of text as you type it.
Click Info (®) to set options for each Hover tool.

Invert colors Invert colors on your display.

Invert colors mode Choose to invert colors everywhere except in photos and images (Smart),
or invert colors everywhere (Classic).

Increase contrast Increase the contrast of items on the screen without changing the contrast of
the screenitself.

Reduce transparency Replace the transparent effect used on some backgrounds in macOS
with a darker background, to improve contrast and readability.

Differentiate without color Use shapes, in addition to or instead of color, to convey status or
information.

Show window title icons Show a window's icon in the window's title bar. The icon can make it
easier to distinguish among open windows.

Show toolbar button shapes Show a subtle border around toolbar buttons to indicate the area
to click when selecting a toolbar button.

Display contrast Drag the slider to increase or decrease the screen contrast.
Text

Text size Set the font size for apps and system features.

Menu bar size Set the font size in the menu bar.

Prefer horizontal text Set horizontal text in languages that prefer vertical text.
Pointer

Shake mouse pointer to locate Quickly move the pointer to temporarily enlarge the pointer so
you can find it.

Pointer size Change the size of the pointer.

Pointer outline color Change the color of the outline for the pointer.
Pointer fill color Change the color of the fill for the pointer.

Reset Colors Resets the pointer fill color back to it's original color.

Color filters Adjust display colors using the selected filter type.

Filter Type Choose a filter type.
Intensity Adjust the intensity of Color Filters.
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Accessibility - Vision: Zoom

< > Zoom

Use keyboard shortcuts to zoom [ @)
Toggle zoom: 38

Zoom in: \3=

Zoom out: X3¢~

Use trackpad gesture to zoom

Double-tap three fingers to toggle zoom

Double-tap three fingers and drag to change zoom

Use scroll gesture with modifier keys to zoom

Modifier key for scroll gesture A Control v
Zoom style Full Screen ¢ Choose Display...

Advanced...” |

Appearance

‘Smooth images.

Flash screen when notificaticn
z00m view

Disable Universal Control whie

Controls

Follow Focus

Follow keyboard focus

Move screen image

Use keyboard shortcuts to adjust zoom window.

banner appears outside

zo0med in

Zoom each display independenty [ =}

Show zoomed image while screen sharing

Never ¢

Move screen image when focus item s Near Screen Edge &

Togale between full screen and

Move cursor to next monitor

Detach zoom view from pointer

Disable panning

pleture-in-picture

Restore shortcuts and modifiers.

el (XD

4

Use keyboard shortcuts to zoom Use the listed shortcuts to zoom in and out.
Use trackpad gesture to zoom Zoom in with listed gestures on your trackpad .

Use scroll gesture with modifier keys to zoom Press and hold the selected modifier key while
scrolling with your trackpad or mouse.

Modifier key for scroll gesture Choose the modifier key to press and hold to zoom while scrolling:
Control, Option, or Command.

Zoom style When you zoom using a keyboard shortcut, trackpad gesture, or scroll gesture with a
modifier key, choose to zoom the entire screen, a custom area of the screen, or just the area where
the pointer is located.

Choose Display When you use full-screen zoom, you can zoom the screen of an available second
display (sometimes called Zoom Display). Click Choose Display, then choose a display.

Advanced When zooming in, you can have the screen move continuous with the pointer, only
when the pointer reaches an edge or the pointer is at or near the center of the zoomed image.

Appearance
- Zoomed image moves Choose how the zoomed image moves with the pointer:
- Continuously with Pointer: Make the screen image move with the pointer.
- When Pointer Reaches Edge: Prevents the screen image from moving until you move the
pointer to an edge of the screen.
- To Keep Pointer Centered: Keep the center point of the screen image near the pointer.
- Restore zoom factor on startup Apply the current zoom factor whenever you turn on zoom or
start up your Mac.
- Smooth images Make zoomed images appear smooth.
- Flash screen when notification banner appears outside zoom view Flash the screen when a
notification arrives if the upper-right corner of the screen isn't shown in the zoom area.
- Disable Universal Control while zoomed in Temporarily disable Universal Control whenever
you zoom in on the screen of your Mac, so it's easier to zoom in along the edge of the screen.
- Zoom each display independently If you're using Full Screen Zoom with multiple displays,
you can zoom in on each one independently without changing the zoom level on the others.
- Keep picture-in-picture window stationary Keep the zoom window fixed in one spot on the
screen.
- Show zoomed image while screen sharing If you zoom in while sharing your screen, others
viewing your screen will see the zoomed-in view as well.

Controls

- Use Keyboard shortcuts to adjust zoom window Change the size and position of the zoom
window while working using the indicated keyboard shortcuts.

« Set range for rapid zooming in and out Set the maximum and minimum levels of magnification.

Follow Focus

- Follow keyboard focus Magnify the area that has the keyboard focus.

- Move screen image when focus item is Move the screen image when the item that has keyboard
focus is off-center or is on or near an edge of the screen.

- Move screen image When the keyboard focus changes to another item, move the screen image
s0 the item is centered, or move the screen image just enough to show the item.

- Movement speed Adjust how quickly the screen moves to follow the keyboard focus.

Shortcuts

- Toggle between full screen and picture-in-picture Press the indicated keyboard shortcuts to
switch between zoom styles.

- Move cursor to next monitor If you're using zoom with more than one display, press the indicated
keyboard shortcut to move the pointer to the next display.

- Use trackpad gesture to move cursor between monitors If you're using zoom with more than one
display, swipe in the direction of the display you want to move the pointer to.

Modifiers for Temporary Actions
« Toggle zoom Temporarily zoom in or out on the screen when you press and hold the modifier
keys shown.

- Detach zoom view from pointer If the screen is zoomed in, making it difficult to see information
displayed under the pointer, press and hold the modifier keys shown to hide the pointer and
move the zoom view without changing the location of the pointer.

- Disable panning If you're using Full Screen zoom with more than one display, press and hold the
indicated modifier keys to keep the zoom window in place while you move the pointer to another
display.

Touch Bar zoom If your Mac has a Touch Bar, display a larger version of it on the screen.



Accessibility - Vision: Motion

< > Motion

Dim flashing lights
Video content that depicts repeated flashing or strobing lights will be
automatically dimmed.

Prefer non-blinking cursor

Reduce motion [ @)

Auto-play animated images [ @)

Accessibility - Vision: Read & Speak

< > Read&Speak

Accessibility Reader [6)
Read or listen to text in the Accessibility Reader app and customize

fonts, layout, and background colors. Press %O to activate

Accessibility Reader.

Speak selection [ @6}
Hear selected text spoken aloud. Select Speech > Start Speaking in
the Quick Actions menu, or use a keyboard shortcut.

Speak item under the pointer [6)
Mac will speak the words under the cursor.

Speak announcements [6)
Mac will speak the text in dialogs and notify you when you need to
perform an action in an app

Speak typing feedback [6)
Mac will speak the keys you press and the characters you type.

System speech language Use System Language ¢

System voice Samantha ¢

Pronunciations

6]
Detect languages [ @)
®

~

Accessibility - Vision: Audio Descriptions

< > Audio Descriptions

Play audio descriptions when available
Audio descriptions provide a spoken description of visual content in media.

macOS Tahoe: A Guide to Your System Settings

Reduce motion Customize how elements move on the screen. For example, when opening
apps, switching between desktops, or showing and hiding Notification Center.

Dim flashing lights For supported media, automatically dim content that contains flashing or
strobe effects. This option is available only on Mac computers with Apple silicon.

Auto-play animated images Turn off to automatically pause fast-moving animated images, like

GIFs, in Messages and Safari.

Prefer non-blinking cursor Stop the vertical cursor from blinking at the insertion point while
you're typing.

Accessibility Reader Read or listen to text with customizable fonts, layouts, and background
colors. To adjust settings, click Info (®) and turn on Autoplay to have Accessibility Reader
automatically read the text aloud.

Speak selection Have your Mac speak selected text when you press the specified keyboard
shortcut. You can customize how content is spoken. Click info (®), then set the different
options that are presented.

Speak item under the pointer Have your Mac identify items under the pointer.

Speak announcements Have your Mac announce and speak dialogs and other
announcements.

System speech language Choose a language to speak in.

System voice Choose a voice to speak text and alerts.

Detect languages Set the speed at which text is spoken.

Pronunciations Set the volume at which text is spoken. This is separate from Sound settings.

Turn Audio Descriptions on to listen to a description of the visual content in movies, TV
programs, and other media, if available.
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Accessibility - Hearing: Audio

< > Audio

Flash the screen when an alert sound occurs

Play stereo audio as mono

Background Sounds

Background sounds

Plays background sounds to mask unwanted environmental noise. These
sounds can minimize distractions, increase sense of focus, and help you
cope with symptoms related to tinnitus.

Background sound Rain  Choose...
Background sounds volume o eem— <)
Equalizer Off ~ Choose...

Personalize your listening experience to minimize
distractions.

Timer Off  Choose...

Turn off background sounds when your Mac is not in use
Turn off background sounds automatically with lock screen and screen
'saver modes.

System volume can be adjusted in Sound settings. Sound Settings.

Headphone Accommodations

Headphone Accommodations

Customize the audio for supported Apple and Beats headphones by
adjusting the settings below or through Custom Audio Setup. These
settings will not affect AirPods Pro with Hearing Assistance enabled
Learn more...

Custom Audio Setup

Tune audio for Balanced Tone ¢
Optimizing for balanced tone will provide boost over a
range of frequencies.

Optimization

Soft sounds will be boosted slightly, ~ Slight Moderate strong

moderately, or strongly.

Play Sample

Apply with Phone Media

Accessibility - Hearing: RTT

S RTT

@ RTT

Send immediately [ @)

Send characters as they are typed. Turn off to complete messages
before sending.

RTT relay number
The phone number to use to start relay
calls with software RTT/TTY.

Enter relay number

Accessibility - Hearing: Captions

< > Captions

Subtitles will look like this.

Transparent Background
Classic

Large Text

Outline Text

ayps

Prefer closed captions and SDH
When available, subtitles for the deaf and hard of hearing (SDH) or closed
captions will be used instead of standard subtitles.

Flash the screen when an alert sound occurs Make your screen flash when you receive an
alert.

Play stereo audio as mono Make your Mac play stereo audio tracks as mono audio in the left
and right speakers or headphones.

Spatial audio follows head movements When you watch or listen to content that supports
Spatial Audio on your Mac, the sound automatically adapts to your head movements. For
example, a sound that initially seems to come from behind you may shift to your side as you
turn your head. This feature is enabled by default. .

AirPods or other compatible headphones
If you have more than one pair of compatible headphones paired to your Mac. Click Info (®)
next to the name to set options.

Background Sounds

Background sounds Play calming background sounds to mask unwanted environmental noise.
Background sound Choose a background sound.

Background sound volume Adjust the volume of the background sound.

Turn off background sounds when your Mac is not in use Automatically turn off background
sounds when your Mac is in sleep, the screen saver is on, or the screenis locked.

Headphone Accommodations
If you have more than one pair of compatible headphones paired to your Mac, click info (®)
next to their name to set options.

Enable RTT Make and receive RTT calls on your Mac without any special equipment. When
this option is on, you can choose to use audio, RTT, or RTT relay each time you place a call.

Send Immediately Send each character as you enter your message. Turn this option off if you
prefer to enter and review your full message before sending.

RTT relay number Specifies the relay service used for RTT relay calls on your Mac. If no
number is entered, your carrier's default relay service will be used.

Styles list Available built-in styles (Transparent Background, Classic, Large Text, Outline Text),
and styles that you added. To edit the settings for a style you added, select the style in the list,
then click Edit.

Add (+)/Remove(-) Create or remove a style. A new style inherits the settings of the style that's
selected when you click Add.

Prefer closed captions and SDH Use closed captions or subtitles for the deaf and hard of
hearing (SDH) instead of standard subtitles for content played on your Mac.



Accessibility - Hearing: Name Recognition

< Name Recognition
Name Recognition [ @)
Teach your Mac to recognize your name
Names
John Appleseed )

Add Name

Accessibility - Motor: Voice Control

< > Voice Control

Voice Control
Voice Control allows you to use your voice to edit text and interact
with your computer even when you are on calls.

Language English (United States) &
Microphone Automatic (iMac Microphone) ¢
Show hints [ @)

Play sound when command is recognized

Overlay Item Numbers &

Fade overlay after inactivity

Voice Control Tutorial Open Tutorial...
Learn and practice Voice Control commands in this
interactive tutorial.

Improve assistive voice features

Help Apple improve assistive voice features by sharing audio recordings
and transcripts of your Vocal Shortcuts and Voice Control interactions.
This information is sent only with your consent and is submitted
anonymously to Apple.

Commands..  Vocabulary.. . v ?

Import Vocabulary...
Export Vocabulary...
Delete All Vocabulary...

Import Custom Commands...

Export Custom Commands...
Delete All Custom Commands...
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Enable Name Recognition Mac can continuously listen for your name and alert you when it
hears it. You can record yourself or someone else, saying your name to help your Mac recognize
it more accurately. Name recognition is available on Mac computers with Apple silicon, and is
only available in English.

Add Name If you go by more than one name, you can set your Mac to recognize all of them. For
example, Your name is John Appleseed, but you prefer to be called Johnny Appleseed or just
Johnny.

Enable Voice Control Enables/disables Voice Control. The first time you turn on Voice Control,
files for the selected language are downloaded to your Mac. When Voice Control is ready to
use, the microphone (&) appears in and fluctuates to indicate the volume level.

Language Choose the language to use when you speak commands to your Mac Choose Add
Language to change the language of the commands, then click OK to start downloading them.
Microphone Choose which input device to use Voice Control.

Show hints Display suggested commands and hints on screen next to the microphone icon.
Play sound when command is recognized Makes an alert sound after the voice command has
finished it's task.

Overlay Continuously show item numbers or a numbered grid on the screen to make it easier
to select items or navigate the screen.

Fade overlay after inactivity When item names, numbers, or a numbered grid are shown, dim
the overlay after the specified period of inactivity by the specified amount.

Voice Control Tutorial Launch the Voice Control Tutorial. Use the tutorial to learn and practice
Voice Control commands.

Improve assistive voice features Enable this to help Apple improve assistive voice features.

Commands

Commands are grouped by action (Basic Navigation, Overlays & Mouse, Dictation, Text
Selection, Text Navigation, Text Editing and Text Deletion). Use the search field to find a
command.

Commands list If you create your own dictation commands, they appear in the Custom section
at the top of the list. A checkmark next to a command indicates it can be used. If you don't want
to use a command, deselect its checkbox. Click a command in the list to show how to say it.

Preview area Click a command in the list to show how to say it. There may be multiple ways to
say a command. For example, to make a selected word bold, you can say “Bold that,” “Bold this,"
or "Bold selection.”

Add (+) /Remove (-) Click the Add (+) to create your own command. To delete a command you
created, select it in the Custom section, then click the Remove (-).

Vocabulary

If Voice Control doesn't recognize a word or phrase you routinely use, you can add the phrase
to ensure it's always entered correctly in your dictation.

Add (+)/Remove (-) Click the Add (+) to add a word or phrase. To delete an item you created,
select it in the list, then click the Remove (-).

Advanced Actions (+**)
Use this menu to import, export, or delete custom commands and vocabulary.
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Accessibility - Motor: Keyboard

< > Keyboard

Full Keyboard Access ®
Full Keyboard Access allows the computer to be controlled with a
keyboard. Use keyboard shortcuts to navigate through all controls
and perform actions.

+ To show help: Tab H

+ To move forward: Tab

« To move backward: < Tab

- To activate: Space

« To move inside groups: 1, ¥, ¢, and >

+ To move to next item: ~ Tab

« To move to previous item: ~ & Tab

Additional keyboard shortcuts can be set in

Keyboard settings. Keyboard Settings...

Sticky Keys @
Sticky Keys allows modifier keys to be set without having to hold the

key down.

Slow Keys [©)
Slow Keys adjusts the amount of time between when a key is pressed

and when it is activated.

Accessibility Keyboard @

The Accessibility Keyboard lets you type and interact with macOS
without using a hardware keyboard

The Panel Editor allows you to customize the panels shown

by Accessibility Keyboard Panel Editor...

Accessibility - Motor: Pointer Control

< > Pointer Control

Mouse & Trackpad
Double-click speed oo Y
Spring-loading O

Spring-loading speed

Mouse Options...

Alternate Control Methods

Mouse Keys @
Allows the pointer to be controlled using the keyboard keys or

number pa

Alternate pointer actions @
Allows a switch or facial expression to be used in place of mouse

buttons or pointer actions like left-click and right-click.

Head pointer @

Allows the pointer to be controlled using the movement of your head
captured by the camera.

Full Keyboard Access Turn on Full Keyboard Access to use the Tab key and other keys to
navigate the screen. Click Info (®) to customize the look of the cursor and set more options.

Keyboard Settings Click here to take you to the Keyboard Settings.

Sticky Keys Turn this on to allow you to press a set of modifier keys one at a time in sequence,
instead of all at once. Click Info (®) to set options such as: Press the Shift key five times to
toggle Sticky Keys, Beep when a modifier key is set and Display pressed keys on screen.

Slow Keys Turn this on to adjust the delay between when you press a key and when it's
activated. Click Info (®) to set options such as: Use click key sounds and Acceptance Delay.

Accessibility Keyboard Display and use the Accessibility Keyboard. Click Info (®) to set
General, Hot Corners, and Dwell options for the Accessibility Keyboard.

Panel Editor Use this to create custom panels that are available from the Accessibility
Keyboard.

Double-click speed Adjust the mouse or trackpad's reaction time when you double-click an
item.

Spring-loading When dragging and dropping, drag an item to a folder and hold to open the
folder.

Spring-loading speed Turn this on to adjust how long after you drag an item to a folder and
hold before the folder opens.

Ignore built-in trackpad when mouse or wireless trackpad is present Disable the built-in
trackpad on your Mac when you use a mouse or wireless trackpad. If you use a non-Apple
mouse, the driver software that came with your mouse may prevent this option from working as
expected.

Trackpad/Mouse Option Set options for these peripherals.

Mouse Keys Turn this on to allow the keyboard to move the Pointer. NOTE: When this is turned
on, the keyboard cannot be used to enter any text. Click Info (®) to set options such as: Press
the Option key five times to toggle Mouse Keys, Ignore built-in trackpad when Mouse Keys is
on, Initial delay and Maximum speed.

Alternate pointer actions Perform a left-click, right-click, double-click, triple-click, or drag-and-
drop action using keyboard shortcuts, assistive switches, or facial expressions. Click Info (®) to
specify keys, switches, and facial expressions, or to see the ones currently specified.

Head pointer Move the pointer using the movement of your face or head as detected by the
camera that's built into or connected to your Mac. Click Info (®) to set options such as:

- Pointer moves: Choose how you want the pointer to follow the movement of your face or
head:

- When facing screen edges: The pointer follows the direction in which you turn your
face away from the center of the screen, similar to how you move a joystick.

- Relative to head: The pointer follows the direction in which you move your head
(regardless of where your face is turned), similar to how you move a mouse.

« Pointer speed: The speed at which the pointer moves when you turn your face or move
your head. The lower the number, the slower the pointer moves.

- Distance to edge: If head pointer is set to “When facing screen edges,” specify how far
your face must be turned away from the center of the screen before the pointer starts
moving.

+ Use a switch or facial expression to pause or resume: To specify a facial expression to use
to pause or resume head pointer.

+ Use a switch or facial expression to recalibrate: To specify a facial expression to use to
recalibrate head pointer.

- Camera Options: To choose the camera to use to detect movement of your face or head,
click Camera Options, then click the Camera pop-up menu.



Accessibility - Motor: Switch Control

< > Sswitch Control

) Switch Control

Switch Control allows the computer to be controlled using one or
more switches. These can be mouse, keyboard, gamepad buttons
or dedicated devices

Appearance © Dark Light
Fade panel after inactivity

Duration of inactivity seconds
Allow platform switching to control your computer

The Panel Editor allows you to customize the panels shown

by Switch Control. Panel Editor...
Typing
Show current text in keyboard panel @)

Insert and remove spaces automatically
Capitalize sentences automatically

Additional typing features, such as automatic
correction and text substitutions, can be enabled in
Keyboard settings.

Keyboard Settings...

Switches

Required

Space Input Select Item
o

Auto scanning
To turn off auto scan, add the ‘Move to Next Item' action first.

Switch Timing...
Navigation
While navigating Do nothing ¢
Restart action position After cursor &
Resume auto scanning after selection
Reverse cursor direction after hitting edge [ @)
Switch Control cursor size Small ¢
Pointer precision ° Low High
Loops 2 ¢

Navigation Timing...

macOS Tahoe: A Guide to Your System Settings

Enable Switch Control Turn on Switch Control to display the Switch Control Home Setting.
Appearance Switch between Dark and Light appearances.
Fade panel after inactivity Hide the Switch Control panel after the specified period of time.

Duration of inactivity Hide the Switch Control menu after the specified period of inactivity, up to
60 seconds.

Allow platform switching to control your computer Use another Apple device, such as iOS
devices or Apple TV, that is already set up to work with your switches to control your Mac, so
you don't have to also set up your Mac with the switches.

Panel Editor Create Settings to add to the list in the Switch Control Custom Panel or to share
with others.

Typing
Show current text in keyboard panel Display a bar across the top of the Keyboard panel to
show text as you're typing it in a document or text field.

Insert and remove spaces automatically Let Switch Control manage spaces when you're
writing text.

Capitalize sentences automatically Let Switch Control manage capitalization when you're
writing text.

Switches

Required switches Switch Control requires the Select Iltem switch. When auto scanning is on,
Switch Control automatically moves to the next item as it steps through a panel, group, or the
user interface.

Optional switches Optional switches to use, regardless of whether auto scanning is on or off.

Auto scanning Have Switch Control automatically step through, or scan, items in a panel, group,
or the user interface. This option is on by default.

Navigation
While navigating Choose what happens when an item is highlighted during a scan: Do nothing,
Speak selection, Play sounds, or Speak & Play sounds.

Restart action position Choose the position from which to start when you rescan an item.

Resume auto scanning after selection Turn on this option to have auto scanning automatically
continue after you select an item.

Reverse cursor direction after hitting edge Have the pointer bounce back when it reaches a
boundary while scanning the user interface.

Switch Control cursor size Choose the thickness of the border of the Switch Control cursor
when scanning the user interface.

Pointer precision Choose the precision with which you control the pointer when selecting an
item on the screen.

Loops The number of times, up to 10, that a panel, group, or window is scanned.
Navigation Timing Set timing options for navigation.
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Accessibility - Speech: Live Speech

P . v speoch Turn Live Speech on to have what you type spoken out loud.

Preferred language Choose the language you type to speak.

Live Speech
(=) U e Sosecnyou can fbeds soeak soud outieoth ol Voice Choose the voice used to speak what you type. You can choose from the provided
orhids Live Speech system voices or use a Personal Voice.
System speech language Use System Language Font size Set the text size for the Live Speech window.
Voice Use System Voice ¢ (3)
Font size 32 $ pt Catergoies
Recent View the list of recently used phrases.
P ) )
ategories Saved View the list of phrases you use often, and add and remove phrases.
@ Recent
[ saved

Add Category...

Accessibility - Speech: Personal Voice

Use Personal Voice settings to create a synthesized voice that sounds like you. This is only

< > Personal Voice . 5 - . . .
available for Mac computers with Apple silicon. It is not available in all languages.

Personal Voice

Can b used it Lve Specch, Read & Spesk, Voiceover, and augmented speech Personal Voice View your list of Personal Voices or record a new one. Click Info (®) next to a
apps Personal Voice to resume recording (if it's in progress), or to rename, export, or delete it.
pobersonalivoicss Share across devices Use your Personal Voices on all devices where you're signed in to the
Create a Personal Voice same Apple Account.

o . Allow applications to use your Personal Voice View a list of apps that you've given permission
\are across devices .
Use Personal Voice on all your devices with iCloud. to use your Personal Voice.

Allow applications to use your Personal Voice
Allow applications to request to use Personal Voice to speak aloud through
your device's speaker or during calls.

No ltems

Accessibility - Speech: Vocal Shortcuts

Use Vocal Shortcuts settings to enable or disable the feature, create new shortcuts, or remove
existing ones.

[ Voo Shorievts | &) Vocal Shortcuts Enable or disable Vocal Shortcuts.

Teach your Mac to recognize a custom phrase that you can say to
quickly perform an action. Audio is processed on Mac.

< > Vocal Shortcuts

List of shortcuts The list of Vocal Shortcuts you've created.

Actions Add Action Add a vocal shortcut by choosing an action for your Mac to perform when you
Zoom In Please! 6) say the shortcut. If you want the action to be a request to Siri, click Siri Request, then enter the
— request. Enter the phrase you'll say when you want your Mac to perform the action, then follow

vt 0 the onscreen instructions to repeat the phrase out loud so your Mac can recognize it.




Accessibility - General: Siri

< > siri

Type to Siri

Enable Type to Siri if you would like to type your Siri requests rather than
speaking them. Siri will still beep and listen for voice input when activated
from a headset

Listen for atypical speech [ @)
Expands the speech patterns Siri will listen for to help improve speech
recognition.

Siri shortcut keys and settings can be adjusted in

Siri settings. Siri Settings...

Accessibility - General: Shortcut

< > Sshortcut

Accessibility features can be toggled on and off by pressing 3F5. Select which
features to toggle on and off

VoiceOver

Zoom

Hover Text

Hover Typing

Invert Display Color
Color Filters
Accessibility Reader
Sticky Keys

Slow Keys

Mouse Keys

Full Keyboard Access
Accessibility Keyboard
Increase Contrast
Reduce Transparency
Head Pointer

Voice Control

Live Captions

Live Speech

(NN NN NN NN N<N<NN<N<N<N<N<N<]

Background Sounds

macOS Tahoe: A Guide to Your System Settings

Type to Siri Enable Type to Siri to type your requests to Siri instead of speaking them. If a
headset with a microphone is connected to your Mac, Siri will speak your typed request. If you
prefer to read responses from Siri in the Siri window instead of having Siri speak them, turn off
voice feedback in Siri settings.

Listen for atypical speech Siri will listen for speech patterns to improve speech recognition.

Accessibility Shortcut List Accessibility features can be toggled on and off by quickly pressing
Touch ID three times or pressing Shift-Command-F5. Here you are offered a list of features to
choose from by toggling them on and off.
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Appearance
The Appearance settings is for customizing the look of the macOS. You can set a custom color or choose a pre-made color for highlighting. You may also
select how your scroll bars behave in Apps or on the Finder.

[ N J < Appearance
Q Search Appearance - ‘
. -0
.0y John Appleseed Auto Light Dark
@& oo nceount
Wi-Fi Theme
Bluetooth
Color Rg@
@e00000000
Network Multicolor
VPN Text highlight color @ Automatic ¢ R4©
|/ Battery
Icon & widget style o o Q :
/] General
o Default Dark  Clear  Tinted
Accessibility
© Appearance Folder color @ Automatic ¢ | (:)
\=) Menu Bar
:‘“ Apple Intelligence & Siri Windows
Desktop & Dock Sidebar icon size Medium ¢ .| (:)
a DBisplays Tint window background with wallpaper color [ @) R4®
Spotlight
Shi Il b:
€ Wallpaper ow scroll bars
° Automatically based on mouse or trackpad .
a Notifications Wbeniserelling
Always
Sound
Click in the scroll bar to
Focus R;@
© Jump to the next page
Screen Time Jump to the spot that's clicked
g Lock Screen P

0 Privacy & Security

(@ Appearance Determines the button, menu and window theme for macOS, enabling you to switch between Light, Dark and Auto. Dark Mode darkens the
color scheme so the content you're working on stands out while windows and controls seem to recede into the background. Setting Appearance to Auto
will allow the Mac to change appearances for you throughout the day.

(@ Color Choose the color to use for buttons, pop-up menus, and other controls.

(® Text highlight color This enables you to change the color of highlighted content such as selected text in documents. Apple provides a list of colors you
can choose from, but you can define your own by selecting Other and using the standard macOS color picker.

@ Icon & widget style This gives you options to choose the color, background, and behavior of icons and widgets.

- Default: ltems are opaque, and the background is either light or colored, depending on the app.
- Dark: ltems are opaque and have a darkened appearance.
- Always: Show items in Dark style.
- Auto: This will switch between Dark and Light, depending on system appearance.
« Clear: ltems are transparent.
- Light: Select for a light appearance
- Dark: Select for a darker appearance
- Auto: Select to switch between Dark and Light, depending on system appearance.
- Tinted: ltems are opaque against a dark background.
® Folder color You can choose the color to use for folder icons in the Finder. (This option appears when Default, Dark, or Clear is selected.)
Icon, widget, and folder color You can choose the color to use for icons and widgets, and for folder icons in the Finder. (This option appears when Tinted
is selected.)

(® Sidebar icon size This gives you options for the size of icons in Finder's sidebar. Medium is the default. Large is good if you find it hard to click the existing
icons, and Small is the best choice if you have a small display. The setting you define here also may affect other apps' sidebar.

@ Tint window background with wallpaper color Allow colors from the desktop picture to subtly tint certain window areas, such as toolbars or status bars.

Show Scroll Bars You can adjust how scroll bars in macOS behave. By default, they are not visible, but show automatically when you move your
pointer over them. You can adjust this so that they only show when scrolling, regardless of the input device or always show when content is too big
for the viewport.

® Click in the scroll bar to This setting changes how macOS jumps to content when you click inside a scroll bar.

- Jump to the next page: When this is selected, content jumps in screen-heights or pages, in the direction of your click.
- Jump to the spot that's clicked: When this is selected, the scroll bar jumps to the point in the document relative to the location clicked on the scroll bar.
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Menu Bar
The Control Center settings show the items that you can choose to appear in Control Center, the Menu Bar or both, with options where applicable. To
show an item in the menu bar, click the pull-down menu and select Show in the Menu Bar.

[ 2N ) < Menu Bar
Q search Automatically hide and show the menu bar  In Full Screen Only ¢ ~—————(1)
£\ John Appleseed Show menu bar background —0
Recent documents, applications, and servers 10 ¢ @
Wi-Fi
Bluetooth Menu Bar Controls
Network System and app controls can be configured to
appear in both Control Center and the menu bar.
VPN Add Controls... @
| Battery
) Clock Clock Options...
2 General
Accessibility ? Siri
@ Appearance Spotlight
- &) Wi-Fi
? Apple Intelligence & Siri .
Desktop & Dock B Bluetooth
@ Displays .
() Battery Battery Options...
Spotlight
@ O Focus i <
() wallpaper (/] . Show When Active
o () screen Mirroring Show When Active &
G Notifications
Sound €3 pisplay Show When Active ¢
Focus
Sound Show When Active ¢
Screen Time
I~ Now Playing Show When Active ¢

g Lock Screen
&) Fast User Switching
0 Privacy & Security

) Touch ID & Password @ Time Machine
8 Users & Groups
VPN
Internet Accounts n Weather
@ Game Center
» iCloud Reset Control Center... >—'1»7©

@ Automatically hide and show the menu bar
Choose when to hide or show the menu bar:
- Always: Always hide and show the menu bar.
- On Desktop Only: Hide and show the menu bar when not using an app in full screen.
« In Full Screen Only: Hide and show the menu bar when using an app in full screen.
- Never: Never hide the menu bar.
Move the pointer to the top of the screen to show the menu bar when it's hidden.

(@ Show menu bar background Choose the color to use for buttons, pop-up menus, and other controls.

(® Recent documents, applications, and servers Choose how many items to show in the Recent ltems menu command. ltems you've used recently are
listed in the Apple menu.

(@ Menu Bar Controls You can choose when they should also be shown in the menu bar. To change the option, click the Menu and choose the following
options: Show in Menu Bar, Show When Active, Don't Show in Menu Bar.

® Allow in the Menu Bar (Not Shown) Enable/disable third party menu bar menus, i.e. Zoom or Dropbox.
Icon, widget, and folder color You can choose the color to use for icons and widgets, and for folder icons in the Finder. (This option appears when Tinted
is selected.)

(® Reset Control Center Click to return the Control Center to its original settings.
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Desktop & Dock

Many of the Dock's settings can be adjusted by Control-clicking the thin line that divides apps and folders. However, the Dock settings in System Settings
are worth exploring because it provides a overview of all your Dock'’s settings. You have the abililty to change the settings for Mission Control, Menu Bar, and
Stage Manager as well as change your Default Web Browser.

< Desktop & Dock
Dock
Size Magnification @
=
Small Large  Off Small Large
Dock position on screen Bottom ¢
Minimized window animation Genie Effect <
Window title bar double-click action Zoom T

Minimize windows into application icon

Automatically hide and show the Dock
Animate opening applications

Show indicators for open applications

OOON

Show suggested and recent apps in Dock

Desktop & Stage Manager

Show Items On Desktop In Stage Manager

Show Desktop Always on Wallpaper Click ¢ @

Click wallpaper to move windows out of
the way, revealing your desktop items and
widgets.

Stage Manager

Stage Manager arranges your recent windows into a single strip for
reduced clutter and quick access. %4@
Show recent apps in Stage Manager [ @)

Show windows from an application AllatOnce ¢

Widgets

Show Widgets On Desktop In Stage Manager

Dim widgets on desktop Automatically ¢

iPhone Widgets [ @)

Default web browser © Safari ¢

Windows

Prefer tabs when opening documents In Full Screen ¢

Ask to keep changes when closing documents :
Close windows when quitting an application [ @)

When enabled, open documents and windows will not be restored when
you re-open an application.

Drag windows to left or right edge of screen to tile

Drag windows to menu bar to fill screen

608

Hold X key while dragging windows to tile
Tiled windows have margins
Mission Control

Mission Control shows an overview of your open windows and thumbnails of full-
screen applications, all arranged in a unified view.

Automatically rearrange Spaces based on most recent use [ @)
When switching to an application, switch to a Space withopen @) % Mission Control
windows for the application 03t Application Windows
0% Deskiop
] - 03 Notifcation Center
Group windows by application
arapoTCaTT ; YR
) Displays have separate Spaces o« uick Note
Keyboard & Mouse Shortcuts 0% Start Screen Saver
Wi a sngle keystrok, view al open windows, windows of the curren . o
Sbplicaion,of ids windows 10 locats an tam an the desktop shat might be Drag windows to top of screen to enter Mission Control [ @) 03 Disable Screen Saver
covered up
5 0% Put Display to Sleep

Mission Control o 5 Lok s
ock Sereen
Shorteuts... Hot Col
Appicaton windows ~s ° -
Show Desktop - % T ,
Start Screen Saver < Quick Note <

For additional choics press Shift, Control, Option, or Command.
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Dock
(@ Size This determines the size of the Dock icons and how much they expand when the cursor is over them.
Magpnification This is best used when you've so many Dock icons that they're not easy to pick out unless zoomed. If you don't like the effect, you can
disable magnification entirely.
(@ Dock position on screen This determines the screen edge the Dock sits on.
Minimized window animation This menu provides two effects for when windows are minimized to the Dock: Genie and Scale. Genie appears to ‘suck’ the
window into position. Scale is a much simpler zoom that's less taxing on older Macs and a lot faster.
Window title bar double-click action Choose what action occurs when you double-click the title bar of an app window.
« Fill: Expand the window to fill the area between the menu bar and the Dock. If the Dock is positioned on the side of the screen, the window adjusts to fill
the space below the menu bar and beside the Dock.
« Minimize: Minimize an app window to the Dock.
- Zoom: Expand a window to fill the space between the Dock and the menu bar. If the Dock is along the side of the screen, the window fills the space
below the menu bar and to the side of the Dock.
- No Action: No action happens when the title bar is clicked.
Minimize windows into application icon Minimize an app window to the app icon in the Dock. If the option is disabled, the window is minimized to an area
in the Dock.
® Automatically hide and show the Dock Hide the Dock when you're not using it. To see the hidden Dock, move the pointer to the edge of the screen where
the Dock is located.
Animate opening applications Makes app icons on the dock bounce while launching.
Show indicators for open applications Places a little black dot beneath the icons of apps that are currently running.
Show suggested and recent apps in Dock Show recently opened apps (if they aren't already included in the Dock) toward one end of the Dock.
Desktop & Stage Manager
@ Show ltems
- On Desktop: Enable this to show files on the Desktop. Disable to hide files on the Desktop.
- In Stage Manager: Enable this to show files in Stage Manager. Disable to hide files in Stage Manager.
Click Wallpaper to reveal desktop Choose an action for when you click on the wallpaper.
- Always on Wallpaper Click: Click the wallpaper to reveal your desktop and widgets.
- Only in Stage Manager on Click: When Stage Manager is on, clicking the wallpaper reveals your desktop and widgets.
Stage Manager
(® Stage Manager Turn on/off Stage Manager. If this option is dimmed, turn on “Displays have separate Spaces” in the Misscn Control section.
Show recent apps in Stage Manager This will keep the more recent apps in Stage Manager.
Show windows from an application:
- All at Once: This will open all the stacked windows of the app all at once.
- One at a time: This will open all the stacked windows one window at a time.
Widgets
(® Show Widgets Choose whether to show widgets.
- On Desktop: Show widgets on the desktop.
- In Stage Manager: Show widgets on the desktop when Stage Manager is turned on.
If this option is turned off, items on the desktop are hidden—click the desktop to show the items when you want to access them.
Dim widgets on desktop Choose a style for widgets.
- Automatically: Automatically switches between monochrome and full-color.
« Always: Always show widgets in monochrome.
- Never: Always show widgets in full-color.
Use iPhone widgets Show iPhone widgets in the widgets browser.
Default web browser Select a web browser used by default when you click on a link from an email or text message.
Windows
@ Prefer tabs when opening documents Choose when you want documents to open in a tab instead of in a new window.
Ask to keep changes when closing documents If you prefer to be asked whether to save changes, turn on this option.

Close windows when quitting an application Close app windows when you quit an app. The windows don't reopen automatically the next time you open
the app.

Drag windows to left or right edge of screen to tile Enable to allow you to drag a window to screen edge to tile the window.
Drag windows to menu bar to fill screen Enable to fill the screen by dragging a window to the menu bar.
Hold "\C (Option) key while dragging windows to tile Enable to allow you to drag a window while holding down the Option key to tile the window.
Tiled windows have margins Enable this to have margins in tiled windows.

Mission Control

Automatically rearrange Spaces based on most recent use If you created multiple workspaces using Spaces, get quicker access to your most recently
used spaces.
When switching to an application, switch to a Space with open windows for the application This option automatically switches you to a space with an
open window for an app when the app itself is switched to.
Group windows by application This options groups windows by application. Turn it on and Mission Control groups app windows alongside the app's icon.
Displays have separate Spaces If you use Spaces and have multiple displays, you can set up separate spaces for each display.
Drag windows to top of screen to enter Mission Control Enter Mission Control by dragging a window to the top of the screen.

(® Hot Corners Choose actions to perform when you move the pointer to screen corners. To use a modifier key with the hot corner, press and hold the
Command, Shift, Option, or Control key, or a combination of these keys, while viewing the pop-up menus.

Shortcuts Choose shortcuts for showing and hiding Mission Control, open windows for the current app, and for showing the desktop. Depending on your
mouse or trackpad, two columns of pop-up menus may be shown in this section.
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Apple Intelligence & Siri
Siriis the digital assistant that is part of Apple's operating systems (iOS, iPadOS, watchOS, macOS, tvOS, audioOS, and visionOS). With Apple Intelligence, Siri
will deliver assistance that's more natural, contextually relevant and personal to users.

@ R
[ ) o < Apple Intelligence & Siri
@ search 2) Apple Intelligence & Siri
\G@&D A personal intelligence system integrated deeply into your Mac, apps, and
D Bluetooth Siri. Learn more...
Network Apple Intelligence [ @ e O)]
VPN
\af Battery Siri Requests
2] General Siri O — (:)
Accessibility Listen for off ¢ ——3)
9) Appearance n 5
GE Keyboard shortcut Press Either Command Key Twice & . C)
(=) Menu Bar Press to type to Siri
. o < > ChatGPT Extension
B Apple Inteliigence & siri Language English (United States) ¢ %4@
Desktop & Dock (G chator .
; ) . Your Mac can use ChatGPT to help you write text, create an image, answer
Voice American (Voice 5) = Select... T (:) =D questions, and more. Openal Terms of Us.
a Displays
g Spotlight Siri history Delete Siri & Dictation History... * (:) ChatGPT Account
\iJ) Wallpaper Siri responses Prefer Silent Responses & % Skl Sign Out...
rpOtycwxpp@privaterelay.appleid.com
B Notifications Voice recordings and transcripts are sent to Apple for improvement purposes. If you're signed in, ChatGPT can keep a record of your requests. About ChatGPT
About Improve Siri and Dictation & Privacy... Exansion & Privacy.
Sound
Advanced Capabilities
Focus Apple Intelligence is built for privacy. Your data is not shared with Apple.
About Apple Intelligence & Privacy... Image Limit Under Limit
Screen Time
Siri " & Privacy... @ Other Requests. Under Limit
) Lock screen 5510 Ch you reach your daily
the basic version for up
(D Privacy & security Extensions
(0)
@) Touch ID & Password ChatGPT {0 Upgrade to ChatGPT Plus
firm Re
33 Users & Groups Your Mac can use ChatGPT to help you write text, create an image, answer fﬁ:ﬂ‘ S_?,:‘:j‘: e sending anything to (=
questions, and more. ChatGPT. Sending a nfirmation.
\_[@) mternet Accounts J

@ Apple Intelligence Enable or disable Apple Intelligence. Apple Intelligence is the personal intelligence system built into macOS Tahoe. It combines the
power of generative models with an understanding of your personal context to deliver intelligence that's useful and relevant.

(@ Siri Enable or disable Siri to do everyday tasks, get quick answers, and more (Siri continues to learn from and make suggestions in apps.) If you ask Siri
something when Siri is disabled, you're prompted to enable Siri. You must be connected to the Internet to use Siri.

® Listen for
- "Siri" or "Hey Siri" (available on some Mac models): Select “Siri" or "Hey Siri" to start using Siri, instead of clicking the Siri icon or using a keyboard
shortcut. If you turn off Ask Siri and then turn it on again later, you may need to set up Hey Siri again.
- "Hey Siri" (available on some Mac models): Select "Hey Siri" to start using Siri, instead of clicking the Siri icon or using a keyboard shortcut. If you turn
off Ask Siri and then turn it on again later, you may need to set up Hey Siri again.
- Off: Disables Siri from listening. You may still use Siri by clicking the Siri icon or using a keyboard shortcut.

(@ Keyboard Shortcut By default, to start using Siri, press either Command key twice. If you want to change the shortcut to open Siri, click the pop-up menu
and select one of the preset keyboard shortcut, i.e., Press Left Command Key Twice. Select Customize to create your own.

(® Language Choose the language and dialect that you want to use to ask Siri; Siri will use the same language and dialect to speak to you. Siri is not available
in all languages or regions.

(® Voice Choose a gender (and sometimes dialect) for Siri. Some languages may not have an alternate gender or dialect.
@ Siri History Delete Siri and Dictation interactions you've performed on this Mac from Siri servers.
Siri Response Change Options for:

- Voice feedback: Turn on to hear spoken responses from Siri. If you turn feedback off, the response from Siri is shown in the Siri window but isn't spoken.
- Always show Siri captions: Turn on to show what Siri says on screen.
- Always show speech: Turn on to show a transcription of your speech on screen.

NOTE: When Apple Intelligence is turned on, the Siri Responses options include “Voice feedback” and "Always show requests.”

(® Siri Suggestions & Privacy Choose the apps for which Siri can make suggestions to you. Siri sends your spoken words to Apple and uses personal
information such as your name, your contacts, and other data to understand you better and recognize what you say.

Extensions List of available app extensions to work with Siri or Apple Intelligence or both.
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Spotlight
Manage your settings for Spotlight.

Q Search
John Appleseed
Apple Account
Wi-Fi
B Bluetooth
Network

VPN
() Battery

@ General
Accessibility
@ Appearance

(=) Menu Bar

? Apple Intelligence & Siri

Desktop & Dock

a Displays

@& spotlight

|3 Wallpaper

3 Notifications
Sound
Focus

a Screen Time

g Lock Screen

0 Privacy & Security

Touch ID & Password

8 Users & Groups

Internet Accounts
@ Game Center
S iCloud

e Wallet & Apple Pay

Q Keyboard
) Trackpad

() Printers & Scanners

< Spotlight

a Spotlight

Spotlight helps you quickly find things on your computer and shows
suggestions from the Internet, Music, App Store, movie showtimes, locations
nearby, and more.

Show Related Content O

Allow content from Apple partners to be shown when searching or when looking up
text or objects and photos. About Search & Privacy...

Reset Quick Keys

Restore Spotlight Quick Keys to their default settings. Reset Quick Keys...

Spotlight Search History Delete Search History... *—

Help Apple Improve Search

{O

Help improve Search by allowing Apple to store your Safari, Siri, Spotlight, Lookup,
and #images search queries. The information collected is stored in a way that does
not identify you and is used to improve search results.

Searches include general knowledge queries and requests to do things like play
music and get directions. About Search & Privacy...

Results from Apps
Allows content from app to appear in Spotlight.

App Store
O Books
B calculator
& Calendar
) Contacts
Dictionary
© Mail
Notes
# Photos
n Podcasts
Reminders
@ safari
. Shortcuts
@ System Settings
) Tips
. Voice Memos

Results from System
Allows items and their content to appear in Spotlight.

Apps

18600 | OOOOOOOOOOOOOOOO'

Documents
Folders
iPhone Apps

Menu Items

Clipboard Search

Allow Spotlight to search and display items you've copied to your
clipboard. Items on your clipboard will be available for eight hours.
Personal and sensitive information may appear in search results.

I Show Related Content Allow content from Apple partners to appear
in search results or when looking up text or objects in photos.

Reset Quick Keys Restore Spotlight quick keys to their
default settings.

| Delete Search History Deletes all history associated with
Spotlight settings.

—— Help Apple Improve Search Help improve Search by allowing Apple
to store your search queries from Safari, Siri, Spotlight, Lookup, and
#images. This information is stored anonymously and used to enhance
search results. Searches may include general knowledge questions or
requests such as playing music or getting directions.

—L Results from Apps Turn on apps to include them and their content in
Spotlight search results.

—— Results from System Turn on an item to include it and its content
in Spotlight search results.

Clipboard Search Turn on if you want to allow the contents of your
Clipboard to appear in Spotlight search resullts.

Privacy
Prevent Spotlight from searching these locations.

& Applications (Parallels)

Search Privacy... ~——2—

Search Privacy Add specif

to exclude locations from Spotlight
searches. You may drag the folder

to the window or click Add

ic folders =

About Search & Privacy...

(+) and

28 Windows Ann

navigate and select the folder.
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Displays
Use Displays settings to adjust resolution, brightness, and display options. The options you see within the Displays setting are reliant on your Mac hardware.
When Night Shift is turned on, the appearance of the display will gradually shift from blue to a subtle yellow, reducing the exposure to blue light.

[ JON ) < Displays
Q Search
John Appleseed :
Apple Account
B wi-Fi g
John's MacBook  John's MacBook John's iPad
Bluetooth B _A'r_ air
Built-in Display LG HDR 4K
Network

@ven . e s
se as ain display ¢ @
OBanery

00 ece
@ General Here's tc e}
troubler anes who
Accessibility Larger Text Default More Space
Appearance
@ Menu Bar Brightness @ @
9 Apple Intelligence & Siri Automatically adjust brightness «©
Desktop & Dock Ttelone)

T Automatically adapt display to make colors appear consistent in different
isplays ambient lighting conditions.
(&) spotiight

- Color profile ColorLCD ¢ ——
(&3 Wallpaper

e Notifications When connected to TV Ask What to Show & .
Choose what to show or use the TV as a
Sound secondary display.
Focus
Advanced... Night Shift... =—2—
Screen Time

n Lock Screen

0 Privacy & Security Arrange... +

Add for streaming (+) Click on
the menu to extend or mirror your
Mac to another device's display
such as an Apple TV connected
toaTVoraniPad.

Show resolutions as list

Link to Mac or iPad

4 \
" Arrange Displays
Allow r pointer and k r move ween an
ow your pointer and keyboard to move between any «© To rearrange displays, drag them to the desired position. To mirrordisplays, hold Option while cragaing
nearby Mac or iPad them on top of each other. To relocate the menu bar, drag it to a different display.

Your pointer and keyboard can be used on any nearby Mac or iPad
signed in to your iCloud account.

Push through the edge of a display to connect a nearby [ @)
Mac or iPad

Allow the pointer to connect to a nearby Mac or iPad by pushing o A
against the edge of a display. ‘

|
Automatically reconnect to any nearby Mac or iPad v

Allow this Mac to automatically reconnect to any nearby Mac or iPad
you've previously connected to.

| 8 &
Advanced Arrange Drag displays to the desired position. To mirror
Show resolution as List displays, hold the Option key while dragging them on
Turn on/off to show the display resolution in list view. top of each other. To relocate the menu bar, drag it to a
different display.

Link to Mac or iPad
Turn on/off features for:
- Allow your pointer and keyboard to move between any
nearby Mac or iPad
- Push through the edge of a display to connect to a
nearby Mac or iPad
- Automatically reconnect to any nearby Mac or iPad
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Connected Displays

(@ This area shows what displays are connected to your Mac. If you have a Mac Notebook or iMac, the built-in display will appear. If you have
Universal Control turned on, other devices will appear here too. Select a display to manage the settings for the display. Click Arrange to arrange
the displays. Please note, “Arrange” will only appear if there is more than one display connected.

Display Role
(@ Use as Click the menu to choose how your selected display is used. You have a choice of main display, extended or mirror.

Resolution
Default for Display will set your display to the default resolution.

Scaled Allows you to select the resolution of your choice. You can choose whether you want ‘Larger Text' or 'More Space' Clicking an option
willimmediately change your display’s resolution.

Optimize for (Not Shown) Choose to optimize for the external display or your desktop.

Display settings
(® Brightness The slider adjusts the display’s brightness setting more rapidly than using your keyboard's media keys (F1and F2).

Automatically adjust brightness or Ambient light compensation Adjust the display brightness automatically based on current ambient
lighting conditions. This option is only available if your Mac has ambient light sensing.

True Tone Automatically adjusts the colors on the display based on current ambient lighting conditions.
Rotation (Not Shown) Rotates the image shown on your display by the chosen amount. Display must be able to support screen rotation.

Preset
(@ Color profile Select a display color preset in the list to use for your system. Detailed information about all of the color profiles installed on your
Mac is provided in ColorSync Utility

Calibrate Display From the menu, select Cutomize. Click Add (+) to open Dlsplay Calibrator Assistant. Create a custom preset that accounts
for your current light conditions, and the position and angle of the display.

(® When connected to TV Choose what to share when connected to a TV or whether to ask each time you connect. This option only appears on
aMac compter with Apple silicon.

Night Shift

® Schedule
Off: Don't schedule a time for Night Shift (if you choose this, you can still turn on Night Shift manually).
Custom: Choose the times when Night Shift turns on and off.
Sunset to Sunrise: Turn on Night Shift from sunset to sunrise.

Turn on until tomorrow Night Shift remains on until the next day or until you turn it off. When activated, you can turn it on or off through this
System Setting or through your Notifications.

Color temperature Adjust the color temperature to your liking.

Night Shift automatically shifts the colors of your display to the warmer
end of the color spectrum after dark. This may help you get a better
night's sleep.

Schedule off ¢
Turn on until tomorrow

Color temperature —

Warmer settings may affect the Less Warm More Warm
appearance of some onscreen

motion.

? =3

Display options when connected to an iPad
These options only appear if you are using an iPad as a second display.

Show Sidebar Choose whether the sidebar on your iPad appears on the left, the right, or not at all.

Show Touch Bar Choose whether the Touch Bar on your iPad appears on the top, the bottom, or not at all. When you use an app that supports
the Touch Bar on your iPad, the Touch Bar is shown in the location you specified. The buttons available in the Touch Bar vary depending on the
current app and task.

Enable double tap on Apple Pencil Select the checkbox if you want to be able to double-tap the lower section of Apple Pencil to switch
drawing tools in some apps.
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Wallpaper
Use this to change and manage the picture or color shown as the background of your Desktop. NOTE: The Wallpaper settings will be different if you are not
using one of these Wallpapers for a screen saver as indicated on the Screen Saver setting.

PR viaiipaper h (@ Current wallpaper This area shows what picture are displayed as
- background for the desktop. If you have multiple displays, you can
— choose a different wallpaper for it by selecting it and then choose a
Tahoe Automatic ¢ — Wa"pape[
-~

Show on all Spaces S

(@ Show on all Spaces Whatever wallpaper you have selected will
appear on all Spaces.

(® Clock Appearance Choose whether to show the large clock and
where it appears:
+ On the Lock Screen only
- On both the Screen Saver and Lock Screen..

Dynamic Wallpapers Show All (34)

—®
—0

U32J59x < Screen Saver... Clock Appearance... R4@
®

—®

(@ Screen Saver Select a screen saver image, set when it starts, and

Tahoe Sequoia acintosh Sonoma choose whether to use automatic or custom settings.
Your Photos (—
® -
Add Photo. -~y
Landscape Show All (79) | @ Start Screen Saver... After 5 minutes ¢
Display will sleep before screen saver starts. You
can manage the timing in Lock Screen Settings.
Use Screen Saver © Automatic Custom
Tahoe Day Sonoma Horizon Goa Beaches
Cityscape Show All (30) m
g ; V)
Dubai Skyline  Los Angeles Overpass  London Evening New Yok Night ® Your Phqto Cllqk Add Photo to seleqt a picture from Photos. Once the
Photos Library is loaded, choose a picture.
o derwater Show All 1) (® Wallpaper Thumbnails Click a thumbnail to set your desktop picture.
: If a you see a picture with a download icon (@), you must click on the
,—‘@ wallpaper to download before using it. Click Show All to see what other
2= e . 18 . wallpapers are availble for the catergory. Thumbnails are shown in
Alaskan Jellies Light ~ California Dolphin Pod ~ California Kelp Forest Tahiti Coast .
categories:
Earth Show All 22) - Dynamic Wallpapers
- Landscape
- Cityscape
: - Underwater
Middle East North Africa Caribbean Antarctica's
Southern Lights - Earth
Shuffle Aerials Show Al (5) -+ Shuffle Aerials
- . . . Cplors
- Pictures

MO @ Colors Choose a color as your wallpaper picture.glick Add (+) to choose
shuffle Al Shuffle Landscepe  Shuffle Cltyscape  Shuffle Underwater a color that is not available to you. Click Rotate (&) to shuffle through the
available colors as your wallpaper.

Pictures Show All (41)
O

Radial Sky Blue Radial Blue Radial Green Radial Purple

Colors Show All (21) R7®

c+ 00000
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Notifications
Use Notifications to customize when you do and don't want to receive notifications. Set options to control how apps show notifications and how notifications
are sorted in Notification Center in the upper-right of your Mac display.

[ JCN < Notifications
Q Search Notifications
Customize when and how notifications appear, if they play a sound, and
- which apps can send them. Learn more...
John Appleseed
Apple Account
Notification Center
a Wi-Fi Notification Center shows your notifications in the top-right corner of your screen.
You can show and hide Notification Center by clicking the clock in the menu bar.
a Bluetooth
Show previews When Unlocked ¢ %4®
Network
Show Notifications: %4®
VPN
D Battery when display is sleeping R4©
when screen is locked [ @) R4@
2] General
Accessibility when mirroring or sharing the display Notifications Off ¢ R4©
Appearance Summarize notifications Off
(=) Menu Bar
3 0 o Application Notifications
? Apple Intelligence & Siri
Desktop & Dock D FaceTime
Desktop
a Displays
Find My
g Spotlight ° Badges, Sounds
(&3 Wallpaper ‘ Game Center
Badges, Sounds, Time Sensitive @
& Notifications
<3 Home

(@ Show previews Show a preview in the notification.
- When Unlocked: Previews are shown only when you're logged in to your user account.
- Always: Previews are always shown (even in the login window).
- Never: Never show previews.

@ Allow notifications when the display is sleeping Pause or allow notifications when the display is in sleep mode.
(® Allow notifications when the screen is locked Pause or allow notifications when the screen is locked.

@ Allow notifications when mirroring or sharing the display Pause or allow notifications when you mirror or share the display. For Example, when you are
doing a presentation in Keynote, pause your notifications from appearing on screen.

(® Allow notifications from iPhone Allows notifications from your iPhone to appear on your Mac. You can enable which app notifications appears on your Mac.
(® Application Notifications Click Options (») to customize each App's notifications.

Alert style Select a style for the app's notifications:

- None: Notifications don't appear on the screen.
. @) - Banners: Notifications appear on the screen and disappear after a while.
Calendar - Alerts: Notifications stay on the screen until you dismiss them.

< Calendar

Show notifications on lock screen When you wake your Mac from sleep, app notifications

E G - you received while it was in sleep are shown in the login window.
. Show in Notification Center Choose how many of the app's recent notifications to list in

Desktop g::{‘ecra“m ek S Notification Center. Notifications older than seven days aren't shown.
Badge application icon Let the app show the number of notifications on its icon in the
Dock.
Alert Style Temporary o Persistent

Play sound for notification Let the app play notification sounds.

Allow time sensitive alerts «© Show previews Show a preview in the notification. When set on default, it uses the settings
Badge application icon «© from above.
R e e o Notification grguping Choose how an app"sf not'ificgtions gre grouped in Notificatign Center:
« Automatic: When more than one notification is received for an app, automatically
Show previews When Unlocked & group them.
- By Application: Group notifications by app; the app with the most recent notification
Notification grouping Automatic ¢ is “Sted ﬁrSt

- Off: Group notifications by application; the application with the most recent
notification is listed first.
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Sound
The Sound Setting is where you define system alert sounds, and settings for audio inputs and outputs. There are three sections: Sound Effects, Output and
Input.

V7 R
(IO < Sound
Sound Effects
Q search
Alert sound Boop ¢ @—4{: )
o.0)) John Appleseed
U Apple Account
Play sound effects through Selected Sound Output Device F‘@
Wi-Fi Alert volume o CE——— 1%7——@
B Bluetooth
Play sound on startup &4@
Network
Play user interface sound effects . 9—4( : )
VPN
() Battery Play feedback when volume is changed %—@
2] General Output & Input
Accessibility
Output Input
Appearance
Name Type
(=) Menu Bar . o
MacBook Air Speakers Built-in C
) Apple Intelligence & Siri Bedroom Home Pod AirPlay
Desktop & Dock Living Room AirPlay
Living Room Home Pod AirPlay
@ Displays B
Master Bedroom AirPlay
Q Spotlight Richard Goon iMac AirPlay
) Wallpaper .
U = Output volume o — o)) @
e Notifications Mute
@) sound Balance — — :)
Left Right
Focus
Screen Time 7
/

Sound Effects
(@ Alert Sound Allows you to select an alert sound. Funk is the default sound for alerts.

(@ Play sound effects through Enables you to define through which output you'd like alerts played. This defaults to your choice of sound output device, but
can be overridden by selecting an alternate option.

® Alert volume Using the slider, volume level can be adjusted.

@ Play sound on startup Turn off to mute the computer startup sound.

® Play user interface sound effects Turns on/off the user interface sounds, for example dragging something to the trash.

(® Play feedback when volume is changed Turns on/off sound when changing the output sound.

Output Tab
@ Choose a sound output device From the list of sound output devices, select the one you want to use. All sound output devices available to your Mac are
listed, including the computer’s internal speakers, devices plugged into your computer's sound port (Audio port icon), USB speakers, and AirPlay devices.

Output volume Using the slider, volume level can be adjusted to suit. Click Mute to silence the output of sound.
(® Balance Using the slider, balance between two speakers can be adjusted to suit.

Input Tab (not shown)
Choose a sound input device From the list of input devices, select the one you want to use. All sound inputs available to your Mac are listed. If your display has
an internal microphone, it's listed as “Display Audio.”

Adjust sound input settings If you're recording sound through your computer’s sound port, you can adjust the input volume to compensate for the sound
source being too loud or quiet.

For example, if you're recording loud music, lower the input volume so the recorded sound isn't too loud or distorted. Or if you are recording someone who is
speaking softly, increase the input volume so your Mac can better capture the person’s voice.

To capture less background noise when using your computer’s built-in microphone, select "Use ambient noise reduction.” (This option does not appear if a
4-channel built-in microphone format is selected in Audio MIDI Setup, on a Mac with Apple silicon, or on Mac models with an Apple T2 chip.)
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Focus
The Focus Setting helps minimize distractions by giving you the ability to pause and/or silence all notifications as well as allowing notifications only from
certain people or apps. Do Not Disturb is found under Focus and the setting to share your Focus Settings across devices is also here.

V- R
eoe < > Focus
Q Search Do Not Disturb ®
.o\ John Appleseed
w Apple Account Reduce Interruptions
Wi-Fi Add Focus... R‘@
Bluetooth
Share across devices [ @) R4©
Network Focus is shared across your devices, and turning one on for this device will
turn it on for all of them.
VPN
() Battery Focus status On H460

When you give an app permission, it can share that you have
notifications silenced when using Focus.

{¥2) General

Accessibility ?

Appearance

|=) Menu Bar

‘:‘ Apple Intelligence & Siri

Desktop & Dock

a Displays

g Spotlight

\&:3 Wallpaper

J

( Focus List List of Focuses you added on your Mac and other devices such as an iPhone or iPad. Do Not Disturb is always on this list. Devices need to be
using the same Apple Account to share Focus Settings across devices.

(@ Add Focus Adds a provided Focus such as Gaming or Reading or create a custom one.

(® Share across devices Turn this on when you want to turn your focus on one device and share across all your devices sharing the
same Apple Account.

(@ Focus Status This lets anyone from your contacts who sends you a message know that you have silenced notifications. If something's important, they can
choose to notify you anyway.

¢ o ; Click on a Focus from the list to edit the settings.
educe Interruptions

Intelligent Breakthrough & Silencing When Intelligent Breakthrough & Silencing is turned
Secuceliteintons on, Apple Intelligence lets important notifications break through while silencing those

deemed less important.
Intelligent Breakthrough & Silencing

When Reduce Interruptions is active, intelligently allow priority Allow Notifications Lists the people and apps whose naotifications are allowed when

notifications to interrupt you and silence other notifications. Any
potiicstiops Sepciical R oad R gee bl e R B S ey the selected Focus is active. Click on People or Apps and then click Add (+). Select your

choices and click Add. To remove the item, select from the list and click Remove (-). Turn off
Repeated calls to only allow the person to call once.

Allow Notifications
Notifications from selected people and apps will be allowed, all others will

be silenced. Set a Schedule Lists the times, locations, or apps used to automatically turn the selected
AR - Focus on or off.

g - - Add Schedule: Click Add Schedule, then choose to schedule the Focus based on Time,
Allowed Apps Location, or App. In the Set a Schedule window, choose a time range and days, search

None allowed

for a location, or select an app, then click Done.
- Temporarily stop using an automation: Select the automation in the list, then turn it off.
Sot 2 Sehoditis To use the automation again, turn it on.
Have this Focus turn on automatically at a set time, location, or while sing a - Delete an automation: Select the automation in the list, then click Delete Schedule.

certain app.
Focus Filters Customize how Calendar, Mail, Messages, or Safari behave when this Focus is
on.
(RIS - Add a Focus filter: Click Add Filter, click the app you want to set up a Focus filter for,
choose the options for that app, then click Add.
Al e e b e e o o - Remove a Focus filter: Click the filter, then click Delete App Filter.

- Temporarily stop using a Focus filter: Click the filter, turn it off, then click Done. To use the
Focus filter again, turn it back on.

No Schedules

No Focus filters

Add Filter.. Delete Focus Removes any custom Focus. A provided Focus can be removed from the list
but can be added back later.

?  Delete Focus...
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Lock Screen is used to protect your Mac from unauthorized access and tampering.

eo0e < Lock Screen
Q Search Turn display off on battery when inactive For 2 minutes ¢ >—4®
<) John Appleseed Turn display off on power adapter when inactive For 10 minutes ¢ g‘@
Require password after screen saver begins or After 5 minutes ¢ %4©
S display is turned off
e Wi-Fi
Bluetooth Show user name and photo D"‘@
Detworc Show password hints %4@
VPN
Show message when locked %4©
|/ Battery
w General When Switching User
Accessibility Login window shows © List of users Name and password»;4®
ApPearance Show the Sleep, Restart, and Shut Down buttons D%
|=) Menu Bar
? Apple Intelligence & Siri Accessibility Options... ?
Desktop & Dock I—4@
g Displays
g Spotlight
\&i) Wallpaper
[ ¢ RO

@ Turn display off on battery when inactive (Mac Laptops Only) Choose how long your Mac can be inactive when running on battery power before the
screen saver starts.

@ Turn display off on power adapter when inactive Choose how long your Mac can be inactive when connected to a power adapter before the screen
saver starts.

(® Require password after screen saver begins or display is turned off Lock your Mac when it's left in an idle state. When the Mac wakes, a user login
password must be entered before the Mac can be used. You can select the amount of time after the screen saver or sleep begins before a password is
required.

@ Show user name and photo enable/disable the ability to show the user name and photo on the lock screen.

(® Show password hints Provide a password hint in the login window when the password is entered incorrectly three times in a row or the user clicks the
question mark (?) in the password field.

(® Show message when locked Display a short message in the login window when your Mac is locked. The message is shown to any users who attempt to
login.

When Switching User
@ Login window shows To let users choose from a list of user names when logging in so that they don't have to remember their user names, select “List of
users." To require users to enter both user name and password when logging in, select “Name and password.”

Show the Sleep, Restart, and Shut Down buttons Shows these buttons in the login window.

(® Accessibility Options Use accessibility options that make it easier to log in to your Mac. Accessibility
VoiceOver

Zoom

Accessibility Keyboard *
Sticky Keys

Slow Keys

Mouse Keys
Turning off a feature disables that feature for all users at the login window but
can be turned back on by the accessibility shortcut menu

* By turning on a feature, your own configurations will be used for all users at
the login window.




Screen Time

Use Screen Time to view and manage each family member’s Screen Time settings, turn Screen Time on or off and set a Screen Time passcode.
The available options vary depending on how you're signed in with your Apple Account and whether you're a parent or guardian of a child in a

Family Sharing group.

@ Family Member (Not Shown) If you are a parent or guardian, you can setup
Screen Time for your children. For example, you can limit their time going on
Safari.

Activity

@ App and Website Activity View charts that show app and website usage.
You can customize the chart to display usage statistics for a specific time
period, app, app category, website, or device.

(® Notifications This shows you which apps are sending you alerts and
notifications so you can adjust some of your notifications to be less
distracting.

(@ Pickups If you're sharing Screen Time information across your Apple
devices, this will show how many times you wake your device to use it and
the first app you use when you pick the device up. You can customize the
chart to display the number of pickups received for a specific time period,
app, website, or device.

Limit Usage

(® Downtime During Downtime, only apps you choose to allow, will work. If you
select Every Day, Downtime is enforced during the same time each day. If
you select Custom, you can adjust the time for each day of the week. You
can also deselect the checkbox next to a day to turn Downtime off for that
day.

® App Limits Allows you to set time limits according to app categories.
For example, you can set Social Networking for 3 hours, everyday, or
Entertainment only on weekends. A message is displayed 5 minutes before
time is up. When the time limit for an app is reached, the app icon is dimmed,
and a message is displayed when the app is opened.

@ Always Allowed You may want specific apps to be allowed with no
restrictions regardless of other set limits. This can include communication
with certain people or apps.

Screen Distance Screen Distance works by measuring the distance
between the screen and your eyes.

Communication
(® Communication Limits Manage contacts and restrict who can be
communicated with during Screen Time and Downtime.

Communication Safety Check for nude photos sent or received on your
child's device in the Messages app (macOS 12.1 or later,iOS 15.2 or later, or
iPadOS 15.2 or later.)

Restrictions

() Content & Privacy Use this to set restrictions on explicit content, purchases, downloading, and privacy. You can choose from four categories: Apps, Stores,
Content and Other, that allows you to set restrictions. For Example, you can allow or limit the user to install from the Store or restrict apps such as Facetime.

() Share across devices Include time spent on other devices where you're signed in to the same Apple Account in the Screen Time reports. You need to turn

on this option on each device you want to include in the Screen Time reports..
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Vs

< > ScreenTime
Activity
@ App & Website Activity

g Notifications

Pickups

Limit Usage
Downtime

4 App Limits

L4 Always Allowed

#  Screen Distance

Communication

&) Communication Limits

m Communication Safety

Restrictions

@ Content & Privacy

Share across devices

You can enable this on any device signed in to iCloud to sync your Screen

Time settings.

Lock Screen Time Settings

Use a passcode to secure Screen Time settings.

App & Website Activity

Turning off App & Website Activity disables real-time reporting, Downtime,

App Limits, and Always Allowed.

LTIl

Il

L1l

|
6

() Lock Sceen Time Settings Require a passcode to prevent unauthorized changes to Screen Time settings, and to grant more time when limits expire.

App & Website Activity Turn on or off Screen Time, including features like real-time reporting, scheduled time away from the screen, and time

limits for apps.

Managing a child (Not Shown)

Screen Time Family Sharing This option is available if you haven't already set it up or when a child in a Family Sharing group is chosen from the Family

Member pop-up menu at the top.

Manage Screen Time Set up a passcode and stay aware of your child's app and website activity.

Requests Respond to requests for more screen time from family members.
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Privacy & Security

The Privacy & Security setting is used to manage the information your Mac makes available to others across the Internet or on a network, and makes your
Mac more secure from malware and tampering.

< Privacy & Security

Privacy

Control which apps can access your data, location, camera, and
microphone, and manage safety protections. Learn more...

Location Services

== Calendars
“ None

Contacts
o
' None

a Files & Folders
None

Full Disk Access
None

(0]

Home Accessories
o
None

Media & Apple Music
None

Of «

Location Services.

@ sii

System Services 7

Location Services

Allow the applications and services below to determine your location.

4 ingicates an application that has used your location within the last 24 hours.

About Location Services & Privacy...

«
[ @)

Details...

a Passkeys Access for Web Browsers
None
Lt
Reminders
None
Accessibility 0
App Management 0 >
@ Automation 0
a Bluetooth 0>
0 Camera 0
Developer Tools 0
Focus 0>
9 Input Monitoring 0
Local Network 0>
Microphone 0
Motion & Fitness 0
@ Remote Desktop 0
@ Screen & System Audio Recording 0
m Speech Recognition 0>
Sensitive Content Warning Ooff > '_—@
@ Blocked Contacts ——@
@ Analytics & Improvements .——(:)
m Apple Advertising — @
Apple Intelligence Report On > -—
Security
Allow applications from App Store & Known Develop <
(&) Filevault ol ()

a Accessories

0 Lockdown Mode

Ask for new accessories >

Advanced...

L

Systom Services Can Access Your Location For
Alerts & Shortcuts Automations
Suggestions & Search 7
Setting time zone 7

System customization 7
Significant locations &routes 7
Find My Mac 7

Home Accessories ¥
Networking and wireless

Mac Analytics 7

0000

@ Detais..

0000

‘Show location icon in Control Center when System Services.

request your location

Specific system services that
use your location

®

Require an administrator password to access system-
wide settings.

Log out automatically after inactivity
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@ Location Services
In Location Services, you can allow apps, system services and websites to gather information based on the current location of your Mac so it can provide
location-based services. To see specific system services that use your location, click the Details button at the bottom of the list on the right.

@ Allow App Access to other Apps
Allow apps to access other apps such as Calendars, Contacts, Files and Folders, etc...i.e., After installing Zoom, you may get a message to allow Zoom
access to Dosument and Desktop Folders.

® Allow App Access to Hardware
Allow apps to access to hardware such as Bluetooth, Microphone, Camera, etc...i.e., After installing Zoom, you may get a message to allow Zoom access
to the Microphone and Camera.

@ Sensitive Content Warning
When you enable Sensitive Content Warning, your Mac uses on-device learning to check for the content that needs to be flagged. In case violence,
shameful content, or graphic imagery is detected, the filter will get blurred or hidden.

® Blocked Contacts
Add/remove blocked contacts from FaceTime, messages and phone calls.

® Analytics & Improvements
Automatically send analytic information to Apple and app developers, which helps them serve customers better and improve the quality of their products.
- Share Mac Analytics: Send diagnostics and usage data to Apple.
- Improve Siri & Dictation: Allow Apple to store and review audio of your Siri and dictation interactions.
- Improve Assistive Voice Features: Allow Apple to use audio recordings from your Adaptive Voice Shortcuts and Voice Control interactions.
- Share iCloud Analytics: Allow Apple to use analytics and data from your iCloud account.
« Share with App Developers: Allow Apple to share data with developers about usage and when an app stops responding.

@ Apple Advertising
To understand why a specific ad was shown to you, click the Ad button on the ad. You can disable Personal Ads to prevent Apple from using your
information for ad targeting. This may not decrease the number of ads you receive, but the ads may be less relevant to you.

Apple Intelligence Report
Generate a report of requests Apple Intelligence has sent to Private Cloud Compute in the last 15 minutes or 7 days.

® Allow applications from
You can protect your Mac from malicious apps by only allowing apps from the App store or identified developers.
- App Store: Allow only apps that have been downloaded from the App Store.
- App Store & Known Developers: Allow apps only from the App Store, and from developers identified by Apple.

FileVault
Turn on FileVault to encrypt all the information currently on the startup disk, and encrypt and decrypt new information as it is read and written to storage. The
initial encryption may take a while, depending on the amount of data that is stored, but you can use your Mac while encryption is taking place. When you turn
on encryption, all users are required to use a login password. When you first turn on FileVault, you choose how you want to unlock your startup disk if you forget
your login password: with the Apple Account you use for iCloud, or with a recovery key that's created for you.
WARNING: Don't lose your recovery key. Store your key in a safe place that you can get access to. This means do not store the recovery
on your computer that you have encrypted with FileVault. Without your passwords or your recovery key, you or Apple will not be able to
get access to your computer.

@ Allow applications from
On a Mac laptop with Apple silicon, you must approve any USB or Thunderbolt devices and SD cards you connect.
- Ask Every Time: Manually approve each device every time you connect it to your Mac.
- Ask for New Accessories: Manually approve each new device you connect to your Mac (default setting).
- Automatically When Unlocked: Automatically approve a device every time you connect it to your unlocked Mac.
- Always: Automatically approve a device every time you connect it to your Mac.

For more information, go to: https://support.apple.com/en-us/102282

® Lockdown Mode
Turn on Lockdown Mode if you believe you may be personally targeted by a highly sophisticated cyberattack.

For more information, go to: https://support.apple.com/en-us/105120
(@ Advanced
Require an administrator password to access system-wide settings Prevent users from changing locked system settings without an administrator's
password.
Log out automatically after inactivity Automatically log out users after the Mac is idle.
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Touch ID & Password
You can easily change your password here. On Macs with Touch ID, you can also set up fingerprints to unlock your Mac and approve actions that require
your password.

[ 2N < > TouchID & Password
Password
Q Search
A login password has been set for this user. Change... %4®
2] General
Accessibility Touch ID
Touch ID lets you use your fingerprint to unlock your Mac and make purchases with
Appearance Apple Pay, iTunes Store, App Store, and Apple Books. About Touch ID & Privacy...
(=) Menu Bar A A
o) 1o — ®
) Apple Intelligence & Siri @ @ *
2 App 9 Finger 1 Finger 2 Add Fingerprint
Desktop & Dock
Use Touch ID to unlock your Mac —{ :)
a Displays Y O
(@) spotiight Use Touch ID for Apple Pay «© ’—4@
\i:) Wallpaper Use Touch ID for purchases in iTunes Store, App Store, [ @) %4@
and Apple Books
3 Notifiations Use Touch ID for autofilling passwords [ @) %4@
Sound
Use Touch ID for fast user switching . - (:)
Focus
Screen Time Apple Watch
Use Apple Watch to unlock your applications and your Mac.
Lock Screen
n Q Richard's Apple Watch '*
0 Privacy & Security
‘ouch ID & Password ?

@ Alogin password has been set for this user Click Change to change the login password and password hint for the current user. NOTE: You can also
change your password in the Users & Groups settings.

(@ Touch ID, Add Fingerprint Click Add Fingerprint (®) to add a fingerprint to the current user account. To rename a fingerprint, click the text below the
fingerprint, then enter a new name. You can add up to three fingerprints per user account.

(® Use Touch ID to unlock your Mac This will allow you to unlock your Mac with any fingerprint added to the current user account.
NOTE: You need to enter your password when you start up or restart your Mac.

(@ Use Touch ID for Apple Pay Use the Touch ID to approve Apple Pay purchases.
(® Use Touch ID for purchases in iTunes Store, App Store, and Apple Books Use the Touch ID to approve purchases from iTunes, App Store or Apple Books.
(® Use Touch ID for autofilling passwords Use the Touch ID to automatically fill in user names, passwords, and credit card information in Safari or other apps.

(@ Use Touch ID for fast user switching Use the Touch ID to switch between Mac user accounts.

Use Apple Watch to unlock your apps and your Mac Use your Apple Watch to unlock apps when they require a password and unlock your Mac when
you wake it from an idle state. This option is available only if your Mac supports Auto Unlock.
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User & Groups
If your Mac needs to have multiple users, you should set up an account for each person so they can personalize settings and options without
affecting other users.

e R
[ N ] < Users & Groups
Users
Q search
@ Appearance =) John Appleseed ®
— Admin
\=) Menu Bar
? Apple Intelligence & Siri 6 HCs @
#9' standard
Desktop & Dock
@ Guest User @
€3 Displays - off
Spotlight
a g Add User... — (:)
{3 Wallpaper
3 Notifications Groups
S (2 Hes Team ® ——0®
Focus
8 Screen Time LGl Cl) R‘@
g Lock Screen Automatically log in as k‘@
Automatic login can't be turned on because FileVault is enabled.
0 Privacy & Security
Network account server Edit... .;4@

@) Touch ID & Password

22 Users & Groups

@ Internet Accounts

@ Game Center

Types of Users
Administrator An administrator can add and manage other users, install apps, and change settings. The new user you create when you first set up your Mac
is an administrator. Your Mac can have multiple administrators. You can create new ones and convert standard users to administrators.

Standard Standard users are set up by an administrator. A standard user can install apps and change settings for his or her own user. Standard users can't
add other users or change other users’ settings.

Sharing Only These users can access shared files remotely but can't log in to or change settings on the Mac computer. To give the user permission to access
your shared files or screen, you may need to change settings in the File Sharing, Screen Sharing, or Remote Management Settings of Sharing settings.

Guest User Enable this account to allow people to use your Mac temporarily. Once the Guest User account has logged out, any data stored will be deleted.

Group A group allows multiple users to have the same access privileges. For example, you can grant a group specific access privileges for a folder or a file,
and all members of the group have access. You can also assign a group specific access privileges for each of your shared folders. You control a group's
access to your shared folders by setting access permissions in the File Sharing section of Sharing settings.

(D Users List of users created on the Mac. Click Info (®) to manage the user account. You can delete a user or promote a user from
Standard to Administrator.

(® Add User Create a new user.

(® Groups List of groups created on the Mac. Click Info (®) to view details and add/remove users from the group.

(@ Add Group Create a new group.

(® Automatically log in as Choose whether to have a specific user logged in automatically. If You have Filevault enabled, Automatic Login is disabled.
(® Network Account Server Connect your Mac to a network account server such as a LDAP server.
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Internet Accounts

Use Internet Accounts settings to quickly set up your Internet accounts from Google, Microsoft Exchange, Yahoo!, and other providers for multiple Mac apps,
such as Mail, Contacts, Calendar, Notes, Reminders, and Messages.

[ N < Internet Accounts
& %‘iﬁfﬁfé "N iCloud
- iCloud Drive, Contacts, Calendars, Safari, Reminders, Messages, Notes,

- News, Wallet, Stocks, Freeform, iCloud Photos, and Siri %—@

\&:3) Wallpaper
E Exchange
e Notifications Mail, Contacts, Calendars, Reminders, and Notes
Sound
Add Account... ’—"‘»4@)

Focus
Screen Time

g Lock Screen
0 Privacy & Security
) Touch ID & Password

e Users & Groups

@ Internet Accounts

@ Game Center
® iCloud

Wallet & Apple Pay

|) Keyboard

L& Trackoad

@ List of Accounts Click an account to view and change the features and settings that are set up on your Mac for that account. Click Account Settings (>) to
turn on the different services such as Contacts or Notes or delete the account from your Mac.

(@ Details Click Details to update the Description and Name associated with the account. This option is available after you click a specific account in the list
of accounts set up on your Mac.

< Exchange Email address jappleseed@rikgoon.com
E I B, I Description Exchange
jappleseed@rikgoon.com Name John Appleseed
) Mmeai " @)
& conscs © ®
< Calendars «
Reminders [ @)
Notes D
Click here to
delete the
account * Delete Account... ?

(® Add Account Add an account from an account provider. If you want to add an account from a provider that isn't listed, such as a mail or calendar account
for your company or school, click Add Other Account, click the type of account you want to add, then enter the requested account settings.
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Game Center
You can play single-player or multiplayer games on your Mac. When you sign in with your Apple Account, a Game Center account is created for you. You can
also subscribe to Apple Arcade to download and play a collection of groundbreaking games, and enjoy unlimited play on all your supported devices.

o0 e < > GameCenter
Profile
Q Ssearch
— jappleseed06 -
jappleseed@icloud.com Show Profile... » ( )
2] General
e Ci ize Profile... 2
Accessibility O
Appearance Friends
) Menu Bar
= All Friends — 0
_‘_" Apple Intelligence & Siri
Friend Requests »—4®
Desktop & Dock
a Displays Invite Friends... R4®
a Spotlight
@ Share Friends List
&J Wallpaper Allow apps access to your list of Game Center friends for an improved %4(:)
gameplay experience.
9 Notifications
Sound Discoverability
Focus Help Friends Find You [ @)
. Allow your Game Center friends to identify you more easily by the email
Screen Time address and phone number associated with your Apple Account. @
a Lock Screen
Game Activity
0 Privacy & Security
Activity Sharing Friends Only ¢
Touch ID & Password Allow other players to see your profile, achievement
progress, leaderboard updates, and recently played .
e Users & Groups games. e
See how your data is managed...
Internet Accounts
@ ame Center Nearby Players &4@
Allow nearby Game Center players in the same game to invite you to a
a iCloud multiplayer game over Wi-Fi or Bluetooth.
Wallet & Apple Pa: .
E e Y Sign Out...

=1 Kevbhoard

(@ Show Profile Launches the Games App to view your Game Center profile.

(@ Customize Profile change your Game Center nickname (it identifies you in games) or your avatar.

Friends
(® All Friends View all your friends you play games together with, compare scores or see what else they are playing.

@ Friend Requests View friends who have invited you to join in their games.
® Invite Friends Invite friends through Messages. Enable "Allow Requests from Contacts Only" to restrict requests to only from friends in your contacts.
(® Share Friends List Allow apps to access your Game Center Friends list to enhance your gameplay experience.

Discoverability
@ Help Friends Find You Turn this on to allow your friends to find you based on the name they have for you in their contacts list in the Contacts app.

Game Activity

Activity Sharing Choose who can see your profile, achievements, leaderboard updates, and recently played games. You can choose:
- Everyone
- Friends Only
- Only You.

(® Nearby players Turn this on to allow nearby players to invite you to a multiplayer games. Nearby players are those on the same Wi-Fi network as you, or
within Bluetooth range.
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iCloud
For management of your iCloud account, including enable/disable features for iCloud.

b R
[ JON ) < > iCloud
Q search ::::’;:; Goon > Indlicates
“orow® — ;
i wanpaper ° iCloud+ subscriber
Storage: 86.1 of 200 GB Used Manage...
e Notifications ® 9 %4{ )
E——
Sound
Focus ® Saved to iCloud See All :
Screen Time % Photos » Drive c Passwords
8,746 Items 331.1MB on
g Lock Screen
Notes (L) Messages D Mail
([ Privacy & security 30 tems 23168 2708
) Touch ID & Password
iCloud+ Features
B Users & Groups - (:)
» Manage Plan & Family @3 Apple Invites
(@ internet Accounts 200 GB Start Sharing Create Events
@ Game Center =, Private Relay = Hide My Email . Custom Email
on 37 Addresses Manage
o iCloud
E Rraletsitoeicay Advanced Data Protection Off %—@
& Keyboard Access iCloud Data on the Web [ @)
Access your mail, contacts, calendar, photos, notes, reminders, files, and @
L Mouse documents on the web at iCloud.com and privacy.apple.com. Learn more...
() cDs & DVDs
P

\ =l Printers & Scanners

(@ Storage Manage your iCloud storage. When you sign up for iCloud, you automatically get 5 GB of free storage. Your iCloud storage is used for documents
stored in iCloud Drive, iCloud Photo Library, iOS device backups, messages and attachments in iCloud Mail and more. If you run out of space, you can
upgrade your storage. You can also remove stored items to make more space available. Click Manage to do the following:

- Buy more storage or change storage plans. If you're in a Family Sharing group and you use the same Apple Account to share family purchases, the
upgrade is billed to the family organizer's account.

- Select an app in the list and see how much storage is being used.

- Remove old backups of iOS or iPadOS. If you don't see any backups, your device(s) is/are not using iCloud backups.

- Turn off Siri and remove Siri related data.

(@ Saved to iCloud Manage how apps and features on the Mac sync with iCloud. Click "See All" to view all of the iCloud services available to you. Some
services have additional settings you can change such as iCloud Mail.

® iCloud+ Features If you subscribe to iCloud+, you can manage other features such as iCloud Private Relay, Hide My Email and HomeKit Secure Video
recordings.

(@ Advanced Data Protection Advanced Data Protection is designed to maintain end-to-end encryption for shared content as long as all participants have
Advanced Data Protection enabled. This level of protection is supported in most iCloud sharing features, including iCloud Shared Photo Library, iCloud
Drive shared folders, and shared Notes.

(® Access iCloud Data on the Web You can access the data that you store in iCloud on the web at iCloud.com. For additional security and to give you more
control over your personal data, you can choose to turn off web access to your iCloud data so that your data is available only on your trusted devices.
When web access is turned off, your iCloud data that's usually available on the web at iCloud.com, such as mail, contacts, calendar, photos, notes,
reminders, files, and documents, can be accessed only on your trusted device.
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Wallet & Apple Pay
If your Mac or Magic Keyboard has Touch ID, use Wallet & Apple Pay settings to add credit cards, debit cards, prepaid cards, store cards, and Apple Card to
Wallet, so you can use them to make payments on websites that support Apple Pay.

[ XN J < > Wallet &Apple Pay
Payment Cards
Q search i
- Apple Card
Default Card
O ereroy - efault Car
® Blue Business Plus Card
2] General «++ 2009
Accessibility m Business Gold Rewards Card
I ++++ 6009
Appearance

Prime Visa
(=) Menu Bar - e+ 5100

? Apple Intelligence & Siri

Add Card... <: )
Desktop & Dock
€3 pisplays AutoFill Cards 16 ——Q2
& spotiight Saved debit and credit card numbers used to autofill information on forms
. and websites,
|z Wallpaper

P Payment Details
B Notifications

Transaction defaults

oy Sound . M
Choose the default payment information you want to use when making a purchase
with Apple Pay. Addresses and payment options can be changed at the time of

Focus transaction.
Screen Time
Default Card Apple Card C%4©
) Lock screen Shipping Address 23 Unite... ¢
Privacy & Securit q a . @
0 Yy Y Email jappleseed.personal@icloud.com ¢
Touch ID & Password
Hide My Email
8 Users & Groups Forwards To: jappleseed.personal@icloud.com %4@
Create a unique, random address that forwards to your personal inbox and can be deleted
Internet Accounts at any time. If you need to reference or manage this email address, you can find it in
iCloud Settings
@ Game Center
Phone <
® iCloud
& Wallet & Apple Pay Add Orders to Wallet [ @)
Orders from participating merchants will be automatically added to Wallet @
on your iPhone.
L) Keyboard
L)) Mouse See how your data is managed... ?
() cps & pVDs

() Add Card add a card using your Mac computer's camera or by typing the card information. NOTE: You must be signed in with your Apple Account.
(@ AutoFill Cards Choose which credit, debit, prepaid, or store cards that are enabled for AutoFill.

(® Default Card Choose the credit, debit, prepaid, or store card that's used by Apple Pay. You can choose a different card when you make a purchase.
(@ Personal information Enter your shipping address, email address and phone number to use with Apple pay.

® Hide My Email Send and receive messages related to purchases without having to share your real email address.A random email address is created for
each website and app, and messages are forwarded to your real email address.

(® Add Orders to Wallet See Apple Pay orders made on your Mac (from participating merchants) on your iPhone.
(@ Compatible Cards (not shown) Enabile this option to check that cards saved in Safari AutoFill work with Apple Pay and to use those cards in Wallet.
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Keyboard

The Keyboard Setting provides control over keyboard input and dictation. You can set options for keyboard and function keys, keyboard backlighting, and

keyboard shortcuts. If your Mac has a Touch Bar, you can customize the settings.

Key repeat rate

< Keyboard

Delay until repeat

Off Slow

Press @ key to

Fast Long Short

Adjust keyboard brightness in low light «
Keyboard brightness /= AN
Turn keyboard backlight off after inactivity Never ¢

Show Emoji & Symbols

Keyboard navigation
Use keyboard navigation to move focus between controls. Press the Tab
key to move focus forward and Shift Tab to move focus backward.

Text Input

Input Sources

Dictation

US. Edit.:

Text Replacements.:

Use Dictation wherever you can type text. To start dictating, use the
k_x_) shortcut or select Start Dictation from the Edit menu.

Languages English (United States)  Edit...
Microphone source Automatic (MacBook Air Microphone) ¢
Shortcut Press & ¢
Auto-punctuation «

About Ask Siri, Dictation & Privacy.

Set Up Keyboard...

Keyboard Shortcuts...

A
>

® @ Key repeat/Delay until repeat

How fast characters repeat when you press and hold
certain keyboard keys, and how long to wait before
repeating them.

®@ For Mac Laptops
Adjust keyboard brightness in low light If your portable
Mac has a backlit keyboard, have it automatically adjust the
level of backlighting in low light conditions.

Keyboard brightness Adjust the backlight on the keyboard.

Turn keyboard backlight off after inactivity If your portable
Mac has a backlit keyboard, have it automatically turn
backlighting off after your Mac is idle for the specified time
period.

® Press fn key to If your Mac has a Touch Bar, choose what

happens when you press the fn key: The choices available
depend on the setting in the “Touch Bar shows" pop-up
menu.

Press @ key to If your Mac has no Touch Bar, choose what
happens when you press the @ key: The choices available

—® are: Change Input Source, Show Emoji & Symbols, Start
Dictation and Do Nothing.
—0@ NOTE: this will appear for any desktop Macs using Apple

Magic Keyboard with Touch ID and Numeric Keypad.

——® (@ Keyboard navigation Use your keyboard like a mouse.

?

Dock

@ Mission Control
Windows

) Keyboard

(&) Input Sources

®) Screenshots
(=) Presenter Overlay
) Sservices

(&) sotiight
Accessibility
App Shortcuts

(@ Function Keys

3 Modifier Keys

To change a shortcut, double click the key combination, and then type the
new keys.

Decrease display brightness F14
Increase display brightness. F15

Restore Defaults =3

(@ Keyboard Shortcuts Choose and customize keyboard
shortcuts.

(® Touch Bar Settings (not shown) Customize the Touch Bar
and Control Strip.

® Text Input

Input Sources Add input sources that allow you to type in
other languages, and change options for specific sources.

@ Text Replacements This shows words and phrases you
want to replace as you type them. For example, as you enter
"omw" is replaced with "on my way."

Dictation

Languages Choose a language. If you don't see the
language you want, choose Add Language or Customize to
download it. You can download multiple languages.

Microphone source Choose a microphone.
Shortcut Choose a shortcut to start Dictation.

Auto-punctuation Automatically insert commas, periods,
and question marks as you dictate. This option is only
available for certain languages.



Trackpad

macOS Tahoe: A Guide to Your System Settings

The Trackpad Setting enables you to define functionality for your notebook's built-in trackpad, or for a Magic Trackpad connected to a desktop machine via
Bluetooth. The Trackpad Setting provides three tabs: Point & Click, Scroll & Zoom and More Gestures.

< Trackpad

Point & Click Scroll & Zoom

Tracking speed

Light

Force Click and haptic feedback

media controls.
Look up & data detectors
Secondary click

Tap to click
Tap with one finger

—
Slow.
Click ——

@ s csss.]

More Gestures

Fast

Medium Firm

«O

Click then press firmly for Quick Look, Look up, and variable speed

Force Click with One Finger <

Click with Two Fingers ¢

Set Up Bluetooth Trackpad... 2

< Trackpad

Natural scrolling
Content tracks finger movement

Zoom in or out
Pinch with two fingers

Smart zoom
Double-tap with two fingers

Rotate
Rotate with two fingers

@ .88 csss.]

Point & Click Scroll & Zoom VLIEIERTIEH

o [oflel

Set Up Bluetooth Trackpad... 2

< Trackpad

Point & Click Scroll & Zoom

Swipe between pages

Swipe between full-screen

More Gestures

Scroll Left or Right with Two Fingers &

Swipe Left or Right with Three... ¢

applications
Notification Center [ @)
Swipe left from the right edge with two fingers
Mission Control Swipe Up with Three Fingers &
App Exposé off ¢
Show Desktop [ @)
Spread with thumb and three fingers

Set Up Bluetooth Trackpad...  ?

Point & Click
Tracking speed Drag the slider to set the tracking speed of the pointer
when you move the pointer across the screen.

Click Set how firmly you must press the trackpad to take action.

Force Click and haptic feedback On a Force Touch trackpad, force click
an item to take action. (To force click, press firmly until you feel a deeper
click.) For example, force click a file in the Finder to show it in a Quick
Look window. With the checkbox selected, you also feel tactile feedback
when aligning objects in some apps, like Preview.

Look up & data detectors Select this option to quickly look up a word or
do quick tasks with certain types of data, such as dates and addresses,
then choose “Force click with one finger,” or “Tap with three fingers.”

Secondary click Select the option, then choose “Click with two
fingers,” “Click in bottom right corner,” or “Click in bottom left corner” to
secondary (or Control) click items on your screen.

Tap to click If you select this option, tapping the trackpad with one finger
is the same as clicking.

Scroll & Zoom
Natural scrolling Select this option to move the contents of a window the
same direction as your fingers.

Zoom in or out Select this option to pinch two fingers closed to zoom in,
or pinch two fingers open to zoom out.

Smart zoom Select this option to double-tap with two fingers to zoom in
orout.

Rotate Select this option to use two fingers to rotate items on your
screen.

More Gestures

Swipe between pages Select this option, then choose “Scroll Left or
Right with Two Fingers,” “Swipe with Three Fingers,” or “"Swipe with Two
or Three Fingers” to move between pages in a document.

Swipe between full-screen applications Select this option, then choose
“"Swipe left or right with three fingers” or “Swipe left or right with four
fingers” to move between apps in full screen.

Notification Center Select this option to swipe left from the right edge of
the trackpad to show Notification Center.

Mission Control Select this option, then choose "Swipe up with three
fingers" or "Swipe up with four fingers” to enter Mission Control.

App Exposé Select this option, then choose “Swipe down with three
fingers” or "Swipe down with four fingers” to use Exposé.

Show Desktop Select this option to spread your thumb and three fingers
to reveal your computer’s desktop.

Note: All these gestures have the option to turn them off.
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Mouse
Set your settings for a mouse connected to your Mac. The Setting's appearance can vary depending on the mouse connected. If you have a Magic Mouse,
you can see how much charge is left on the mouse.

Point & Click < > Mouse
Tracking speed Drag the slider to set the tracking speed of the %%
pointer when you move it across the screen.
Natural scrolling Select this option to move the contents of a ©
window the same direction as your fingers.
Secondary click Choose Click Right Side or Click Left Side to
L CEHTEETTE
secondary (or Control) click items on your screen.
Smart zoom Turn this on to double-tap with two fingers to zoom SULCR More Gestures
inorout. Tracking speed e —
Slow Fast
Natural scrolling [ @)
Content tracks finger movement
Secondary click Click Right Side ¢
Smart zoom
Double-tap with One Finger
Advanced... Set Up Bluetooth Mouse... ?
More Gestures <
Swipe between pages Choose a gesture to move between pages =
in a document.
Swipe between full-screen applications Choose Swipe Left or O
Right with two fingers to move between apps in full screen.
Mission Control Turn this on then you can double-tap with two
fingers to enter Mission Control.
Point & Click
Swipe between pages Scroll Left or Right with One Finger &
Swipe between full-screen applications [ @)
Swipe Left or Right with Two Fingers
Mission Control [ @)
Double-tap with Two Fingers
Advanced... Set Up Bluetooth Mouse... ?
Pointer acceleration D
movements and more precisely for slow mouse movements.
( oore ]

Pointer acceleration When this option is turned on, the pointer
moves more quickly for fast mouse movements and more
precisely for slow mouse movements.
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Printers & Scanners
Use Printers & Scanners settings to manage printers, scanners, and fax machines.

([ JON ] < Printers & Scanners
@ Search Default printer Last Printer Used ¢ %4®
Spotlight
a =l Default paper size US Letter ¢ %4<:)
\&:3) Wallpaper
e Notifications ke
o) d Canon MF270 Series
Soun . e dle
Focus
___ HPENVY 6400 series @
Screen Time == eldle, Last Used
~~_ Local Pool
g Lock Screen Tl e

0 Privacy & Security
Add Printer, Scanner, or Fax....——2——

|

%) Touch ID & Password

B Users & Groups

Internet Accounts
@ Game Center

® iCloud

() Default printer Specifies the printer you want to use as the default printer. By default, the last printer used is selected.

(@ Default paper size Choose the paper size you have loaded in your printer.

(® List of printers, scanners, and fax machines Lists the printer, scanners, and fax machines your Mac is set up to use. Click the printer in the
Printers list to view or change the printer name, location, printer model, or driver version.

(@ Add Printer, Scanner, or Fax Click to add a Printer, Scanner, or Fax. Hold down the Option Key to create a printer pool.

[ ) ® Add Printer

8@ & @

Default P Windows

Qsearch

Name ~  Kind

Canon MF270 Series Bonjour Multifunction
HP ENVY 6400 series [BE8013] Bonjour Multifunction

Name:
Location:

Use:

Printer Pool
If the printers you use are often busy and you want to print a document as quickly as possible, you can create a printer pool. Your document will automatically
print to the first available printer in the pool.

1.When you add a printer, hold down the Option key (\C), Click Create Printer Pool.
2.Enter a name for the printer Pool.

3.Select the printers in the list to be included in the printer pool.

4.When you print, click the printer menu and select the printer pool.
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